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Prologo

El siguiente manual fue escrito para la EETP N°602 de Venado Tuerto Santa Fe Argentina, y brindara a los
alumnos las herramientas necesarias para poder disefiar , simular y proyectar proyectos con circuitos
electronicos simples y complejos. Se obto por elegir este sowfware dada la versatilidad que ofrese al poder
disefiar el circuito y posteriomente simularlo tanto en forma esquematica como en PCB ahorrando tiempo y
costos en el disefio. Este manual ofece tambien una vinculacion directa con Ingles Técnico ya que este
programa ofrese en el libro de ayuda mucha informacion sobre el uso del programa en ingles, para facilitar el
uso del programa se ofrese al final de cada tema una referencia al anexo en donde se explicara el mismo
tema en su version en ingles del libro de ayuda el programa.

El autor

El profesor Jose Emanuel Palacios es Tecnico en Electrénica recibido en el EETP N°602 ademas de poseer
el Profesorado de Educacion Tecnica en Concurrencia con el Titulo de Base que otrorga la Provincia de Santa
Fe. Docente titular del Taller de electronica de 5to afio Seccidn Instrumentacion y Control.
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INTRODUCCION

Circuit Wizard es un entorno integrado disefiado para la realizacion completa de proyectos de construccion
de equipos electrénicos en todas sus etapas: disefio, simulacion, depuracion y construccion.

La aplicacién Circuit Wizard esta compuesta basicamente por dos programas principales: Livewire, que se
utiliza para el disefio del esquema electrénico, y PCB wizard, que sirve para el disefio de la placa de circuito
impreso a partir del esquema electronico realizado anteriormente. De cada uno de ellos hablaremos con
detenimiento mas adelante.

Sin la utilizacién de la suite Circuit Wizaed , el proceso para construir un equipo electrénico se componia de
las siguientes etapas:

Disefo del circuito electrénico

Construccion del prototipo fisico real en protoboard

Disefio del circuito impreso

Construccion del prototipo fisico real en PCB

Pruebas de funcionamiento

El depurado de errores podia ser una labor ardua en tiempo y recursos, lo que conlleva un alto costo
econdémico.

Sin embargo con la herramienta Circuit Wizard, tal y como se indica en la Figura siguiente.

El proceso queda definido con las siguientes etapas:
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L a jz Disefio del circuito electrénico

g T ®
W

Simulacién de circuito

Disefio del circuito impreso

Simulacién del PCB

Construccion del PCB y pruebas de funcionamiento

Las ventajas saltan a la vista. Con Circuit Wizard las fases de prueba no suponen la necesidad de volver a
construir nuevos prototipos, lo que conlleva el ahorro de costos y tiempo.
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COMPONENTES DEL Circuit Wizard 1.15

A lo largo de este apartado se van a describir en detalle los cuatro elementos principales, mencionados
anteriormente, por los que esta formado. Estos elementos estan perfectamente integrados entre si y son los
siguientes:

Livewire: Es la herramienta para la elaboracién avanzada de esquemas electrénicos, que incorpora una
libreria de dispositivos digitales y analdgicos.

PCB wizard: Es la herramienta para la elaboracion de placas de circuito impreso con posicionador automatico
de elementos y generacidén automatica de pistas,

Puesto que el presente trabajo trata sobre el disefio de placas de circuito impreso, mas adelante se hara
especial hincapié en los entornos PCB wizard y Livewire que ya vienen integrados.

EL ENTORNO INTEGRADO
Circuit wizard es una Unica aplicacion que contiene muchos moddulos que ofrecen las diferentes
funcionalidades disponibles en la aplicacion (disefio del esquema electrénico, disefio de la placa de circuito
impreso, lista de materiales, etc.). Esta filosofia posibilita que toda la informacion del proyecto se encuentre en
una base de datos que es compartida en tiempo real por todos los médulos.
Un médulo, por tanto, es una parte de la aplicacion de Circuit wizard que se encarga de proporcionar una
determinada funcionalidad y que se ejecuta dentro de una pestafia situada al mas alto nivel dentro del entorno
integrado.
Los diferentes médulos disponibles son los siguientes:

e P4gina de inicio (Home Page).

e Esquema electronico (Schematic Capture).

e Disefio PCB (PCB Layout).

e Visor del PCB de diferentes formas para simular e imprimir.

e Lista de materiales (Bill of Materials).

e Explorador del disefio.

Ver Figura 1 del apéndice de ejercitaciéon de inglés.
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Empezando a usar el Circuit Wizard

Si desea aprender completamente a utilizar el programa, dirijase a la columna HELP de la barra del menda.

El mejor modo de comenzar a trabajar con este tipo de programas es explorando algunos de los archivos
ejemplos provistos con el software. Hay muchos archivos habilitados que muestran cada paso del proceso del
circuito disefiado, desde el diagrama del circuito hasta como finalizar el circuito impreso.

Seran almacenados por ejemplo en la carpeta: C:/program filesinew wave concepts/PCB Wizard 3/
Examples.

En cada archivo ejemplo, presione styles del lado izquierdo de la barra de herramientas para cambiar el modo
en el cual aparece cada circuito. Presione sobre el botén Real World, por ejemplo, y vera el circuito como
apareceria cuando sea profesionalmente manufacturado.

Para explicar los diferentes “botones” del menu de cada programa podriamos realizar un listado de cada boton
con su explicacion, pero esto no seria didactico. Es preferible que usted comience a utilizar el programa de
inmediato para que pueda aprender sobre la marcha.

Por lo tanto vamos a armar y probar un circuito de demostracion muy sencillo, utilizando muy pocos mandos
(botones).

¥ Gl wizard - [Lights.ome] | (O] =i
Barra o e s oy alaix]
de DS E@ - o = o m b E0 % A 0] e Barra de
menu £ herramientas
¥ ¢ - -
E 1 1 = = 2 = 3
i { T T Galeria
=. ;r.... * * + ./ + —
. i o o " s
i ! L) w0 a0 ] all i
Barra de i ] 0 ) ] T i
estilos -f L_:_ e "‘J u'.:::._"_] it I.""‘J J.':I."‘:J wwn "‘J T -l"' Cirmiat Symbiol E
= ! 1 t | > -
!_ o [ = = | £ e @
f A S B S5 . — A%
P & - - P Sockr, Tominad Bk
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estado
i P i o e (1100 o) owhe fongmrd D90, oM G 0Am K3 100%  [Raedy
general

En la figura anterior se observa la pantalla del PCB Wizard con la descripcién de sus partes fundamentales.
Los elementos principales de este laboratorio virtual son:
e Barra de menu: La barra de menu es utilizada para acceder al rango de herramientas y rasgos en
PCB Wizard. Muchas de las opciones del menu pueden accederse haciendo clic en los botones de la
barra de herramientas o presionando la tecla shortcuts.

Ei File Edit View Project Window Help

e Barra de herramienta: Las barras de herramientas proporcionan maneras rapidas de realizar las
tareas en el PCB Wizard. La mayoria de los botones corresponde a un orden del menu. Usted puede
averiguar lo que cada botén hace deslizando su cursor encima del mismo: en un recuadro aparece
desplegando el nombre del botén.

g e Cui LAL=u) F[UJ:LL WV l_lclp

Dl S O O ok EYQOH A bt

e Hoja de diseiio: La hoja de disefio es donde se ponen los objetos y se editan. Las barras deslizantes
le permiten moverse alrededor del disefio. Posee un rango de encuadre.
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S Greu Disgram  PCB Layout { BAToF Wiatari | « | jﬂ

e Barra de estilos: Se encuentran alli las opciones de vistas del circuito que podemos obtener, flujo de
corriente, solo componentes, disefio clasico.

N

Fil

]Nnrmal Real World  Current Flow  Logic Levels  Artwork  Unpopulated | More «

e Galeria: La galeria proporciona el acceso rapido a los componentes. Usted puede arrastrar el objeto

inicialmente de la galeria hacia su disefio. Al irinciiio la ﬁaleria estard escondida.

=] x|
12 2 |[@]

- X

I Ia Power Supplies d @

Power Supplies g

I g

L -

La

w Battery ﬁ

T [=]

)

T

=2

i == gl

e Barra de estado: es una barra pequefia que describe el orden actualmente seleccionado (es la parte
inferior de la figura).

1., < » | Circuit Diagram [ PCB Layout /| Bill of Materials [ |4
1 Press F1 for help ]

’Eﬂ J J » PICKit

e Barra de estado general: nos informa el estado del disefio que estamos realizando, normalmente

indica “Pres F1 for help”.

el p.
rel.

di..,

\altage [']
@

las..

rel..

< 1,61 | Press F1 for help |E

e Barra de graficos: en esta barra nos muestra los graficos de tension y corriente que estemos
analizando con las puntas de prueba.
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Ver Figura 2 del apéndice de ejercitaéion’de inglés.

-]

Profesor Palacios José Emanuel Pagina 11



Manual de Circuit Wizard 1.5 |

Aprendiendo a través de la practica
A modo de ejemplo, crearemos un circuito para encender unos leds mediante una tecla.
Mientras disefiamos dicho circuito aprenderemos a:

e Agregar componentes de la galeria.

e Cablear componentes (interconectarlos).

e Cambiar los valores de los componentes y modelos.

—0 * * - -
SWi

| + R R2 R3 R4 RE I:I

D1 D2 D3 D&
o o W] R

Para hacer este circuito se necesita:

e Un switch.

e Cinco LEDS verde

e Cinco resistor de 1kQ - (4 bandas) marrdn, negro, rojo y doradas, (5 bandas) marrén, negro, negro,
marrén y dorada.

e Una bateria 9V.

Tenga en cuenta que puede disefiar su circuito en el programa y le permitiran visualizar la simulacion del
mismo a través de mediciones con el osciloscopio o multimetro y ver su funcionamiento. Podra también pedir
que le haga el impreso y simular el circuito impreso PCB con los componentes externos.

Creando un nuevo diseno

Debemos crear un nuevo documento en el cual dibujara su circuito. Para crear un nuevo documento, haga clic
en el boton “nuevo” o elija “nuevo” del menu de archivo.

]Q File Edit View Project Window Help

g Mew... Ctrl+M

= Open.. Ctrl+0

3
92| fm Close
=
B save Ctrl+5

Ver Figura 3 del apéndice de ejercitacion de inglés.

Create a new document based on
an existing template, (Ctrl+M)

Agregar un componente nuevo

Sobre el nuevo documento aprenderemos a usar la galeria para agregar componentes a su circuito. Si la
galeria no esta actualmente abierta, presione sobre el botén Gallery (galeria) en la barra de herramientas
para abrirlo. Seleccione la opcién simbolos de circuito.

En la ventana de la galeria de simbolos de circuito, usted podra ver todos los componentes que se encuentran
disponibles dentro del programa.
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=3 Switches j
3 Switches

B Sensors

[_1 Passive Components
[Z] Resistors

Galeria [ Capacitors
[_] Inducters

[Z Discrete Semiconductors
[Z7] Diodes
[Z Transistors

[ Logic Gates

[Z Integrated Circuits

Los componentes dentro de la galeria estan agrupados de acuerdo a su funcién. En la parte superior de la
ventana hay una lista que le permite seleccionar qué grupo sera exhibido. Para hacer el circuito, del grupo
“fuentes de alimentacion”, agregue el componente “bateria” al documento de trabajo, para hacer esto coloque
la flecha del mouse sobre el simbolo bateria, presione y mantenga el boton izquierdo del mouse, con el botdn
aun sostenido, arrastre el simbolo a su circuito. Finalmente, suelte el botén del mouse cuando el simbolo del
circuito esté en la posicion requerida dentro del documento de trabajo.

Ahora necesitaremos agregar el resto de los componentes para lo cual procederemos de forma analoga a lo
recién explicado.

>

| fsjen @ wesssy §

Otra manera de buscar los componentes:

Cabe recordar que en la galeria no aparecen la totalidad de componentes que existen el Circuit Wizard 1.15,
la otra forma de buscar componentes es ir en la barra de menu | Project y alli tendremos unas de las
opciones que nos dice:

e PCB Componentes: componentes dl PCB.
e OFF-BOARD: componentes fuera de la plaqueta.
e Test Equipment: equipamiento de tested.

Adentro de cada una podremos buscar el comﬁonente ﬂue necesitemos.

|£) File Edit View | Project Windew Help

£ ok | g

..... . 5w g . ¢ o oW - ‘ﬁ
Simulation 3
© i

PCB Components

Automatic Routing B

4 el

" | # Off-Board U OwlityCheck.. B T
Test Eq it
LT f e *L, Track F2
# AddProbe  F5 | @ Pad F2
: FI Wi F4 i
Folder ) = e Getting 5
M Circuit Board
Draw Welcome to
M Copper Area
Author 3 Getupand
Aa Copper Label the topics b
to navigat:
Options. T . 0 navigate
Power Supplies » ;)
Connectors 3 D
AA Battery with Holder (1.5V)
Input Compenents 3
2 x AA Battery with Holder (3V)
Passive Compaonents 3 AR th Holder (4.5V)
Discrete Semiconductors 4"M ;ﬁe“’““th H°I;' i [
Integrated Circuits 3 * o eleer
AAA Battery with Holder (1.5V)
Output Components » \
2 x AAA Battery with Holder (3V) P
3 PP3 Battery with Helder (9V)

CR2032 Coin Cell (3V: Horizontal)
CR2032 Coin Cell (3V: Vertical)

CR1216 Coin Cell with Holder (3V; 0.45 in, 12 mm)
CR1616 Coin Cell with Holder (3V: 0.65 in, 16 mm)

. CR2032 Coin Cell with Holder (3V; 0.8 in, 20 mm)
----- CR2430 Coin Cell with Holder (3V: 0.9 in, 24 mm)

= “l "l“ Dual CR1216 Coin Cell with Holder (6Y: 0.45 in, 12 mm)
C T 7" "7l Dual CR2032 Coin Cell with Holder (6V; 0.8 in, 20 mm)
Dual CR2430 Coin Cell with Holder (6Y: 0.9 in, 24 mm)

Circuit Diagram ), PCB Layout {_Bill of Materials
Press F1 for help

Voltage Regulators »

Ver Figura 4 del apéndice de ejercitacion de inglés.
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A ? e
Agregue cinco resistores del grupo de componentes pasivos, agreguen un switch del grupo componentes de

entrada y finalmente cinco LED del grupo de componentes de salida.
Debemos posicionar los componentes cuidadosamente sobre el documento de trabajo antes de comenzar a

disefar el circuito.
Tenga en cuenta que se pueden mover los componentes si nos fijamos con el mouse sobre ellos, haciendo un

clic y manteniendo apretado el boton mientras movemos el componente sobre la posicion requerida.

Para esto, desde la barra de herramientas, deberemos seleccionar el cursor como un sefalador estandar.
Help

N [y & Q¥

*

En la figura siguiente podemos ver como quedaran los componentes una vez arrastrados sobre el documento

de trabajo.
Tenga en cuenta que es conveniente pensar en la posicién que deberan tener los componentes antes de

colocarlos sobre el documento de trabajo.

D1 Dz D2 4 05
s Ry e T e

Posicionando los componentes

La posicién de los componentes al comienzo puede ayudar a producir un diagrama de circuito mas claro.

Para alinear los pins del resistor R1 con el anodo de leds D1, necesitara rotar los componentes, para ello
seleccione el resistor R1 haciendo un clic con el mouse y entonces presione sobre el botén rotar hacia a la
izquierda o a la derecha de la barra de herramientas.

= = f{:#] [h

& Cut Ctrl+X

—— Copy Ctrl+C

w ¥ Delete  Del
Symbel 3

T -
%! Properties & Pull onto Grid Ctrl+T + |
ESf' Brop A = ¢ [ﬂ f—h .‘r:.. .r_-ll. ﬁ

b < 3, Bring to Front Fé&
w By @Y Send to Back  Shift+F6

M Rotate Left Ctrl+L 4% Rotate Left

“k Rotate Right Ctrl+R )
Rotate the selected objects
syout / Bill of Materials [ anti-clockwise, (Ctrl+L)
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Ya con el componente rotado:

Bi —
)

D1 D2 D3 14 D5
Py Py T e T

» ' Circuit Diaaram [ PCB Lavout £ Bill of Materials / [41

Ver Figura 5 del apéndice de ejercitacion de inglés.

Conectando los componentes

Una vez gue los componentes han sido ubicados, usted puede comenzar a unirlos. Para hacer esto usted
debe primero presionar sobre el boton “seleccionar” de la barra de herramientas.

P

b L3 QU X A il = [~

3 Select Tool

Enable the chject selection tocl.

Luego, mueva el mouse sobre el pin superior de la bateria. Mientras sostiene el mouse sobre el pin se dara
cuenta que aparecera un recuadro describiendo ese pin en particular.

R1
1K

I e —
SV

Bi \\
U
Battery
(Circuit Symbal)

Pin = 1 of 2: Positive

T

Presione y mantenga con el boton izquierdo del mouse, sin soltarlo mueva el mouse hasta el punto donde
desea hacer la union.

SPST Switch
(Circuit Symboel)
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Usted puede dibujar curvas, deslizando el boton del mouse sobre el mismo o presionando sBbré! un@& parte
vacia del circuito.

SW1

Como vamos a conectar el extremo de la bateria con R1, para completar la unién, deslice el botén del mouse
sobre la parte superior de R1 sin dejar de presionar el botén izquierdo del mouse. Y de modo analogo para los

demas componentes.

S

B1 =-r

=

o1 Dz o3 4 D5
o o W o x

Para unir dos pistas, simplemente deslice el botdn del mouse sobre una pista existente. Se dara cuenta que,
cuando haga esto, se agrega automaticamente una union en el punto de conexion.

Puede unir el resto del circuito utilizando el diagrama como guia.

Si se equivoca, en cualquier momento puede presionar el boton “deshacer” para corregir cualquier error.

SV

D1 D2 D3 rd D&
o ot | e o

Ver Figura 6 del apéndice de ejercitacion de inglés.
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Como cambiar valores de componentes y modelos

Con el diagrama de circuito de la figura, puede comenzar a ajustar el valor de los componentes.

En su circuito, el resistor R1 serd utilizado para limitar la corriente que pase a través del LED. Es bueno incluir
resistores cuando utiliza leds, sin ellos, los leds se pueden quemar.

Para una tension de 9 volt, el valor del resistor debe cambiar a unos 800 Ohm para limitar la corriente a unos
10mA, cuando el led esta encendido.

Nosotros usaremos un resistor de 680Q porque éste es un valor comercial que tenemos en el taller.

Para cambiar el valor, haga doble clic sobre el resistor R1 con lo cual se exhibirdn las caracteristicas del
mismo.

1 Mumber: = 0K, I
Caption; Cancel |

value: = IK jl 0 Llpl

Model: I 114w ;I

D1

El campo VALUE para el resistor se muestra en la parte inferior de la ventana y consiste de un valor y un
multiplicador. Ingrese 680 en el primer recuadro de valor (es el valor del resistor), y luego presione una vez
sobre la flecha de la derecha del segundo recuadro para cambiar el multiplicador de K (x1000) a x1.

5w
Mumber: N Rz
_ Bl T b
Caption: oy |
Value: |E|8CI|
D1 NS D2
Model: |1,f-1w __\H -

La mayoria de los componentes dentro de Circuit Wizard, proveen modelos diferentes. Los leds por ejemplo,
estan disponibles en una gama de diferentes colores. Pruebe ahora, presione el boton derecho del mouse
sobre el LED y seleccione el color que desee de la lista de modelos habilitados.

Ver Figura 7 del apéndice de ejercitaciéon de inglés.
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Simulacion del Circuito Esquematico

En la figura se ve el circuito completo. Usted puede ver cémo trabaja sin necesidad de armarlo fisicamente.
Para “simular el funcionamiento” presione el boton “Run” de la parte superior de la barra de herramientas

para simular su circuito.

9 File Edit VYiew Project Window Help

D& HE & © nom [ A A il =

spra]abeyjop  jeuuop

spna 6o Aol AL

~alop | plepuels

Puede chequear que su circuito esta funcionando haciendo clic en el switch. Esto dejara pasar o ho corriente
por el circuito.

oo o z z
W1 201
Ri Rz Ri1 RZ
R 5 1+ 880 ﬁ 1K ﬁ R3 ’J" R4 RE
1K 1K

K 1 K B1 -I-
| SPST Switch

Click to toggle the switch state,

D oz D3 v D&
D1 D2 D3 4 D5
“ “ e Y S # + #
* * ) * o o T T

Ver Figura 8 del apéndice de ejercitacion de inglés.

@m
iLodl

LELP
o
]
=

]
i
o
=
Eel

n
+

Investigue qué sucede con el LED cuando cambia el valor de la resistencia.

Haga clic con el mouse sobre el LED, aparecera un recuadro que exhibe las lecturas de la corriente (A para

ampere) y la potencia desarrollada por el elemento (W para watt), tal como lo especifica en la siguiente figura.
R5

LED

(Circuit Symbol)

Current = 7,01mé&A (arnps)
Power = 3, 78mW (watts)

1
Nota:

Pruebe esto con el LED encendido y apagado y note los valores para cada momento. Vera que la corriente del
LED encendido es de 7,01lmAYy que el LED esta apagado cuando no hay corriente.
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Luego, posicione el mouse sobre uno de los cables de su circuito, aparecera un recuadro de fe indica el
voltaje y la corriente de esa union en particular (la tension especificada se toma con respecto al terminal

especificado como masa).
Si la corriente fluye a través del conductor, vera que aparecera una flecha junto al cursor, la cual le indicara la
direccion del flujo de corriente actual.

(|

Yoltage = 9,00V (volts)
Current = 37,72mA (amps)

Ver Figura 9 del apéndice de ejercitaciéon de inglés.

Guardando nuestro diseno

No debe olvidar guardar su documento para ello puedo usar el icono guardar de la barra de herramientas.
IQ File Edit View Project Window |

K'I't"!|

DeES&E =R

=

% H Save

s Save the active document.
< (Ctrl+5)

[=]

La otra manera para salvar un proyecto es hacerlo manualmente para lo cual debera ir al menu “File” y luego
seleccionar la opcion “Save” (guardar documento) o “Save As” (guardar documento con otro nombre o
destino).

N €3/ File Edit View Project Window Help

O New... Ctrl+ M Q
& Open... Ctrl+ QO

£ Close

1=

& Save Ctrl+5
Page Setup...
& Print 2

CAD/CAM 3

»

=
g
3
B
<
e
=
w
(]
2
2
o

Guardar en: I | 2d trimestre j - EF B~
Mombre ‘ Fecha de medifica.. Tipe Tamaric 2
R1 Q C_1_fabre esteban 19/06/2017 0%:17 ...  Archivo CWZ 12KB
680 9 C_1_kevin castillo 19/06/2017 0&:10...  Archive CWZ 13 KB
£ C_1_thiago poncey maximo dellosa 28/06/2017 05:01 a...  Archivo CWZ 13KB
,Q C_1_YAMIERI Y SARRIA 19/06/2017 0%10...  Archivo CWZ 13 KB
Q C_2_castille, yanieri,orozco 29/06/2017 06218 ... Archive CWZ 17KB
" £ C2_SARRIA MAXI THIAGO 24/07/201705:53 ...  Archivo CWZ 12KB w
MNombre: Icircu'rto Guardar I
Tipo: IGrcu'rt Wizard Document (*.cwz) LI Cancelar |

Ver Figura 10 del apéndice de ejercitaciéon de inglés.
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¢Como Visualizar la Animacion del Circuito?

Una vez disefiado su circuito podremos visualizar la animacion del mismo.

Uno de los principales beneficios de la simulacidon de circuitos, es que le permite ver en pantalla las
representaciones y conceptos normalmente ocultos como voltajes, corrientes y cargas, tal como hemos
comenzado a explicar. Del lado izquierdo de la ventana principal encontrard la barra de estilos. Esta barra
muestras los diferentes modos en que puede lucir su circuito.

Con la simulacion en funcionamiento, presione el boton “voltage levels” (niveles de voltaje).

plepuels sj@sa] 01Bo7 Mo Juannn  spaaabeyop

oW

Su circuito lucira como el exhibido en la figura, con diferentes barras que muestran los diferentes niveles de
voltajes y flechas que indican la direccién del flujo de corriente actual.

Como prueba haga clic sobre el switch. Vera que el voltaje y la corriente dentro de su circuito cambian.

Luego presione el botén Current Flow (flujo de corriente). En este estilo la corriente es graficamente animada
utilizando los puntos que se mueven alrededor del circuito.

LL

Ademas, los colores representan los niveles de voltajes. Si el nivel del voltaje es de 5V 0 mas, la unién se
exhibira en color rojo, si esta por debajo de 5V, serd azul y cuando sea de 0V estara en color verde.

Nota: si tiene alguna duda de que muestra cada vista del circuito posiciGnese con el cursor sobre el estilo que
quiere ver y se abrirda un cuadro de dialogo con una breve explicacion en ingles claro, como se ve en la
imagen siguiente.

ird ..

MO{UBLNT s,

< Current Flow
|

= Shows the flow of electrical
current in the circuit.

reui. ) T 1

0 s

Ver Figura 11 del apéndice de ejercitaciéon de inglés.
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Opciones de simulacion

El circuit wizard trae diferentes opciones de simulacion, para activarlas deberemos ir a "Projet" nos abrira un
menu desplegable, elegiremos la opcién "Simulation" y por Gltimo nos apareceran diferentes opciones como
se puede ver en la siguiente imagen.

aw | Project Window Help

J ) Run F9 ,_'__[%.grpqx_ ;

T Ve oM
| £F Circuit Symbols  » m
I PCBC s Faults
| : Bounce
Q Test Equipment  » Slow Motion
v Back EMF
#° Add Probe F5 i
Folder
Draw
Author

Ri R
Options... 1" ¢] 1

. :

Qﬂ, Power Supply...
»

Timing Control... —

Las opciones como son:

Mute: activa los efectos de sonido.
Explosions: activa las explosiones por exceder los rangos maximos de trabajo.
Faults: habilita o deshabilita la simulacién de componentes defectuosos.
Bounce: habilita el efecto rebote en los interruptores mecanicos.
Slow Motion: activa la simulaciéon en camara lenta.
Back EMF: habilita las corrientes inversa que se producen al activas y desactivas bobinas.
Add PCB Ground: agrega la conexién de una Groun (masa o tierra en la PCB), en el circuito
esquematico esta desabilitada esta opcion.
Power supply: habilita la conexién de una fuente de alimentacién para circuitos integrados de 5v
Timing Control: define la velocidad de simulacion.
Ver Figura 12 del apéndice de ejercitaciéon de inglés.
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Habilitando una falla especifica en un componente

Ya vimos cémo armar los esquemas circuitales, y cémo probar si funcionan, entonces ahora podemos simular
fallas en algin componente para analizar el como se comporta el circuito ante una determinada falla.
Primeramente debemos habilitar la simulacién de componentes defectuosos en la ventana de “opciones de
simulacion” (como vimos en el tema anterior). Luego debemos seleccionar el componente al que le vamos a
provocar la falla haciendo clic derecho sobre el componente elegiremos la opcion Symboll Add Fault.. Como
se observa en la siguiente figura.

¥
|€3 File Edit View | Project Window Help w8t crx
DEd & P e B QXL gy copy ctrieC

. Delete Del

Mute  Ctrl+M Symbol 3 Explode

=
5
’;
=
% 1F Circuit Symbols  » Explosions Arrange g Convert As...
=1 PCB Components -
5 r1t PCB Components + [ I B Properties | AddFaut. |
a # Off-Board 3 Bounce
= £ Test Equipment  » Slow Motion |T MNumber ‘D4’
I} v Back EMF ! '
£ A AddProbe  F5 |—— e
O _— Add PCR G i
T Fold r L
g_ Do er Q% Power Supply... Lock Labels
raw Timing Control... A Font..
- Author
%= - Restore Labels
— Options...
2
Il

Se nos abrira la siguiente ventana.

Faults can be added to one or more component
pins. Select the type of component fault below:

[ ;eakage: IIDD—iII I_j 0

1 (Anode)
[ 2 (Cathode)

En donde tendremos las siguientes opciones:

None: no tendré ninguna falla.

Open: elegiremos los pins que estaran abiertos.

Short: elegiremos al menos dos pins que estaran en corto.

Leakage: elegiremos los pins que tendran una fuga simulando tener una determinada resistencia la
cual nos dejara calibrar.

Y en la casilla de abajo nos mostrara los pines que tiene el componente para que podamos seleccionarlos y
crear la falla.
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Componente con falla abierto

- =

A continuacion seleccionamos la opcién “Open” en el anodo del led y cuando lo simulamos vemos que no

circula corriente ya que el anodo esta abierto.

Component Faults

Faults can be added to one or more component
pins. Select the type of component fault below:

Fault
i
RE (+ SWi

(" Shert R1

; " Leakage: 100 j l_j p 10

Select which pin(s) the fault applies to:
v| 1 (Anode)

2 (Cathode) A| >°_
| -

Ok | Cancel | Help |

_
Componente con falla en corto

(S

R2 R3
1K 1K

A continuacién seleccionamos la opcion “Short” en el anodo del led y cuando lo simulamos vemos que circula
corriente ya que el anodo y el catodo estan en corto pero el led no se ilumina. Tener en cuenta que nos pide

seleccionar al menos dos pines para que estén en corto.

Component Faults
Faults can be added to one or more component
pins. Select the type of component fault below:

Fault
" MNone
(A= Circuit Wizard
{+ Short
" Leakage:

! Setting a short fault requires at least 2 pins to be selected

Select which pin(s
v| 1 (Anode)

Component Faults

Faults can be added to one or more component
@ pins. Select the type of component fault below:
Fault
" MNone
i Open
% Short

™ Leakage: ’_cc—j l_j

Select which pin(s) the fault applies to:

v| 1 (Anode)
v

oK I Cancel

T - e T e S Er T

SWi1

R1 R2 R3
10 1K 1K

D2

R4
1K
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Componente con falla de fuga a s f
A continuacion seleccionamos la opcién “Leakage” en el &nodo y catodo del led, cuando lo simulamos vemos
que circula corriente ya que hay una fuga de entre el anodo y el catodo de 100o0hm pero el leds no se ilumina.
Tener en cuenta que nos pide seleccionar al menos dos pines para que estén en fuga.

Component Faults

Circuit Wizard

Faults can be added to one or more component
pins. Select the type of component fault below:

Fault

Faults
@ pins. ! Setting a leakage fault requires exactly 2 pins to be selected
Fault

" Mone (" MNone
{~ Open " Open
" Shart {~ Short

{+ Leakage: 100 i j o]

Select which pin(z) the fault applies to:
v| 1 (Anode)

« iesksged  [100 = o
Select which pin{s) the fault applies to:

v| 1 {Anode)
w| 2 (Cathode)

=]

_.......—H—.....!...........!............_.......!
SwWi

R1 R2 R3 R4
10 1K 1K 1K

Wire

Voltage = OV (volts)
Current = 8,09mA (amps)
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Componente explotado
A continuacion si hacemos clic derecho sobre el componente y vamos a la opcion Symboll/ Explode.

Ng

& Cut Ctrl+X
Copy Ctr+C
¥ Delete Del

Arrange 3
Convert As...

Properties Add Fault...

v Number 'D3
Model 'Red"

Lock Labels
A Font..

Restore Labels

A continuacién vemos que al simular el circuito se quema el led que esta conectado con una resistencia de 10
ohm como es logico , pero también se quema el ultimo led que esta conectado con una resistencia de 1k ohm
y no se tendria que haber guemado sino que nosotros lo hicimos explotar.

|||||||—H—|||||?||||||||||’||||||||||_‘ ----- - y I
SWi1

R1 R2 R3
10 1K 1K

=

s

% D2 D3 4
W N

Ver Figura 12 A del apéndice de ejercitacion de inglés.
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Habilitando conexidon de fuente de alimentacion para
tecnologia digital

Primeramente debemos ir a la ventana de “opciones de simulacion” y seleccionar la opcion Power Supply.

s Circuit
Q File Edit Wiew Project Window Help
O™ & 4 »k Fo b QX A Mg 4 2|6

Mute Ctrl+M

{F Circuit Symbols  »|| v Explosions
v Faults
Bounce
Q Test Equipment  » Slow Mation

sjase abejjop,  (ewop

o v Back EMF
= 4 Add Probe F5
i Fold
i older »
%_' Draw 3 Qﬂ,
Timing Control...
— Author »
{=]
=
2
o

g ll
Options...

Nos aparecera la siguiente ventana que nos mostrara seleccionado un casillero donde indica que se incluirdn
las fuentes de alimentacién para circuitos integrados de forma oculta (evitando asi la necesidad de incluir las
conexiones de alimentacion en el circuito esquemaético) facilitando el disefio. Y la opcion “Power supply
voltaje” en donde podremos elegir el voltaje de dicha fuente.

Power Supply

v Automatically indude hidden digital power supply; oK |
Power supply voltage: 5 :II volts cancel

Help

Si simulamos un circuito que utilice un integrado y no le habilitamos la fuente de alimentacién oculta, veremos
que el circuito no funciona al simularlo y cuando hagamos el PCB en modo Automético no apareceran las
conexiones de alimentacion de los integrados.

B » b

IR | S e HI L

Power Supply

[~ Automatically indude hidden digital power supply: oK |
E =]
- =] Cancel
Help
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Si simulamos un circuito que utilice un integrado y le habilitamos la fuente de alimentacion oculta, veremos
que el circuito funciona al simularlo y cuando hagamos el PCB en modo Automatico apareceran las
conexiones de alimentacion de los integrados.

Power Supply

[v Automatically indude hidden digital power supply: oK
Power supply voltage: 5 j volts Cancel
Help

ENTRADA BINARIA

Ver Figura 12 B del apéndice de ejercitacion de inglés.
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Habilitando las destruccion de los componentes pofekceso
de sus rangos maximos (voltaje, amperaje, potencia,
etc.).

Ya vimos como armar los esquemas circuitales, y cémo probar si funcionan, entonces ahora que sabemos que
el proyecto anda perfectamente: ¢ podemos crear la placa de circuito impreso?

La respuesta a esta pregunta es “aun no podemos” ya que hemos simulado el circuito utilizando componentes
ideales o si pudimos encontrar el componente real por ejemplo diodo rectificador 1N4001, pero para simular el
circuito acercandonos mas a la realidad necesitamos cumplir con los siguientes pasos:

a) Tener el circuito esquematico completo

b) Tener seleccionados los componentes a utilizar con sus valores de potencia, encapsulados, etc.
¢) Habilitar en el simulador la destruccion por exceder los rangos maximos del componente.

d) Simular el circuito teniendo todo lo anteriormente mencionado.

Tener el circuito esquematico completo.

oo

ER

GED

m
k-4l
L

1
29

D1 Dz D3 4 Ds
P P T e o

Tener seleccionados los componentes a utilizar con sus valores de potencia, encapsulados,
etc.

Seleccionamos las caracteristicas de la bateria a usar o fuente de alimentacion, resistor, etc. como ya
vimos anteriormente.

. Mumber: ]B_ ll_ﬂ] _J oK, | -
Caption: | Cancel
Value: 9 ﬁ ]—ﬁ Y Help ]

=]

MNumber:

Caption:

]Ideal

Model:

Value:

Model:

Habilitar en el simulador la destrucciéon por exceder los rangos maximos del componente.
Para ello deberemos ir a "Projet" nos abrira un menu desplegable, elegiremos la opcion "Simulation”
y por ultimo la opcién "Explosions" y con esto ya hemos habilitado esa opcion y podemos simular con
la mayoria de los parametros habilitados como se puede ver en la siguiente imagen.
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a | Project Window Help
H*f"‘”” P ek @A X,
|| Pause +F
| m Stop Ctrl+F8
sl PCBC onents b Faults
Off- d 3 Bounce
Q Test Equipment  » Slow Motion
« Back EMF
# Add Probe F5 |7
Fold Add PCE Ground
»
olEt Qﬂ, Power Supply...
Draw ..
Timing Contral.., — e
Author &
‘fﬁﬂ\’\fgt/’j
R1 r.
Opticns... 1K ¢] 1 &

Simular el circuito teniendo todo lo anteriormente mencionado.

Simulacién _sin _habilitar las “EXPLOSIONS”: NoOtese que en la siguiente imagen tenemos la

simulacién de un circuito en el cual el diodo led “D1” esta en serie a una resistencia R1 de 10 OHM vy
no se quema lo cual sabemos que es ilégico.

o0 ] ] ]
W1
s s Ri RZ R3 R4 RE
B1 T 10 1K 1K 1K 1K
o
o1 Dz D3 D5
P o Sl o

Simulacién _habilitando las “EXPLOSIONS”: Noétese que en la siguiente imagen tenemos la
simulacién de un circuito en el cual el diodo led “D1” esté en serie a una resistencia R1 de 10 OHM vy
el led “D1” se quema lo cual sabemos que es lo que sucederia si montaramos ese circuito realmente.

o L o a o
SW1
LR Ri Rz R3 R4 RE |:|
Bl T 10 1K 1K 1K 1K
W
‘% D2 D2 D5 "
o L e 4
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Notese que si nos posicionamos sobre el componente que se destruyo nos habrira un cud@ro de dialogo,
como se ve en la imagen siguiente, que nos indicara porque se destruyo dicho componente lo cual nos
facilitara la correccion y del circuito.

SWW

W

This component has been
destroyed.

Forward current of 44,60ma
exceeded maximum rating of
30mA.

Ver Figura 13 del apéndice de ejercitacion de inglés.

Control de sincronizacion

Para ello deberemos ir a "Projet" nos abrird un menua desplegable, elegiremos la opcién "Simulation" y por
Gltimo la opcién "Timing Control" como se puede ver en la siguiente imagen.

£} File Edit View Project Window Help
= = b Run F2 [z & QX
=
g
3
= Simulation Mute Ctrl+ M
=
= {E Circuit Symbols Explosions
= Faults
E Bounce
B £ Test Equipment  » Slow Maotion
0 Back EMF
5 # Add Probe F3
5
= Fald b
=3 SIeet I% Power Supply...
Z Draw 3 .
Timing Centrol...
o Author 3
=
i Options...
2
o

Con esto se nos abrira una ventada para que configuremos la velocidad de simulacién y sincronizacion como
vemos en la siguiente imagen.
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Mode: {* Speed

Time Base: j‘ |s

[v Show simulation time base warnings

[terations: 25 ﬁ per step

i Accuracy

En la cual tendremos las siguientes opciones de simulacion:

e Time base: base de tiempo de la simulacion.

e Show simulation time based warnings: Mostrar advertencias basadas en el tiempo de simulacion.
e Mode: aqui podremos seleccionar la opcion de simular con speed (velocidad) o accuracy (exactitud)

e [terations per step: interacciones por paso.

También podemos modificar la base de tiempo de simulacién yendo a la barra de estado abajo a la derecha
en el casillero que dice Time, como figura en la siguiente imagen.

~Dw 740/ 15
Hex 500 ms e,
200 ms
«V 740
Hex 100 ms o)
50 ms
:]:)_ 740 20 ms
Qs 10 ms
740 5 ms
Quz 2ms
(Op
1 ms
741 500 ps
Tripl 2000 ps 3
100 ps
a0
Trgl  20ps
10 ps
> 741 ks
Hesx 2pus
-
1 s J
Time: | 15,915 s

Ver Figura 13 A del apéndice de ejercitacion de inglés.
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a P a
Usando los Instrumentos en la Simulacion de Circuitos
Ver Figura 14 del apéndice de ejercitaciéon de inglés.

Simulando un circuito con el osciloscopio

Utilizaremos el circuito visto anteriormente y lo analizaremos con él osciloscopio.

Para poder buscar los instrumentos que disponemos en el programa, vamos a la galeria y hacemos un clic.
Inmediatamente aparece la galeria. Dentro de ella, en la parte Virtual Instruments se encuentran los
instrumentos de medicion.

=)

=]
;N #
1 |ﬁ Virtual Instruments j »
a

Measuring = §

_— a

i

El

o

Ammeter ﬁ

Q

o

a

2

"
Voltmeter

7 Test Point

Virtual Instruments

9 w
Y +- | Analogue Multimeter

Digital Multimeter

[::]+{ 4| Wattmeter
04“"DSCD =
-
1]
- | L :l 1 |

1 Graphic Foreground [Fi520in #0,1in Q, 100% Ready

Sacamos el osciloscopio, de la misma manera que sacdbamos los componentes hacia la mesa de trabajo.
Una vez que sacamos el osciloscopio, podemos cerrar la ventana de la galeria para tener mas campo de
vision en nuestra pantalla.

El osciloscopio graba niveles de voltajes sobre un determinado periodo de tiempo.

Veremos que contiene los dos canales (CH1 y CH2). Cada canal tiene una terminal positiva y una negativa.

X501

"ﬁ\_f Chi Ch2
+ —_—
NN

Normalmente, el lado positivo es unido a la sefial a medir y el lado negativo a 0 volts.

El voltaje que se lee es calculado como la diferencia de potencial entre las terminales positivas y negativas.
Comenzamos entonces conectando la terminal negativa del canal 1 a 0 volts. Y luego la terminal positiva del
mismo canal a la salida del leds D1, donde deberiamos obtener una sefial de menos de 9v cuando activemos
el interruptor y de Ov cuando lo desactivemos.
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X3C1

+ - o+ -

Debemos luego, hacer un clic sobre el osciloscopio con el botdn derecho del mouse y nos aparecera la opcion
para agregar el grafico (Add Graph).

N

& Cut Ctrl+X
Copy Ctr+C
Q 7. Delete Del

Add Graph
[1]addGraph |

_ Symbol 3
Arrange 3
R Rz
1" 1" Properties

Inmediatamente después, debe hacer un clic con el botén izquierdo del mouse y sin soltarlo arrastrar hasta
formar un recuadro, suelte el botén cuando el tamafio del grafico sea de su agrado, tal como se muestra en la
figura.
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X¥8C1

™ | oha ohe
+ - +-
[ 12 -

Graph of X3C1

altage [W]
oh
1

Time [5]

Para visualizar la animacion presionamos sobre Run en la barra de herramientas y encendemos el circuito a
través de la llave de encendido, para ver como el osciloscopio ya nos muestra la sefial de salida.

ko * o Graph of X3C1

=
o
g
1 +— E
3 -
e R1 R4 RS
g1 K K 0
5\. - T T 1
T 0 2 4 [
Time [=]
03 4 D&

Ver Figura 15 del apéndice de ejercitacion de inglés.

Podemos observar que el voltaje que le llega al led “D1” esta comprendido entre 0 y es menor a 3voltios.
Haciendo doble clic sobre el grafico podremos ver las propiedades de nuestro gréfico, las cuales podran ser
modificadas segun nuestra necesidad. Como podemos observar, es posible ajustar la tensibn méaxima y
minima de medicion, la base de tiempo y el color del trazo para cada canal.
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Ver Figura 16 del apéndice de ejercitaciéon de inglés.

Como nuestro circuito funciona con 9 volts, cambiamos las tensiones minimas y maximas para dicho voltaje.

X501

Chil Ch2
+ -+ -

Graph of X5CA1
I g -
= 61
[
o E 3
swi
R1 RZ R3 R4 RE
1K I:] 1K I:I 1K 1K K ) ! ! |
0 2 4
Time [5]
D1 Dz D3 D&
o i S i e
Pero vamos a modificar ahora la base de tiempos.
Graph of X5C1
g9 -
=, 61
1]
=}
=
= 3
D T T T T 1
0 5 10 15 20 25
Time [s]
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(|

Ahora damos “Stop” en la simulacion para conectar el otro canal del osciloscopio en otra péite @el @rcuito
(R1), y ver cémo aparecen las dos formas de onda de ambos canales.
Cuando continuamos con la simulacion vemos la diferencia entre el canal 1y el canal 2.

XEC1
RN Chi Ch2
+ - + -
Graph of XSC1
2]
s 6
o
on
=
2 3
i R2 R4 RE
Bt T 1K 1 1
oo 0
—— T T T T 1
0 5 10 15 20 25
Time [g]
D32 D5
! o P

Damos ahora doble clic sobre el grafico para luego cambiar de color el trazo del canal 2, que al ser de color
azul se confunde con las marcas del osciloscopio. Vemos que haciendo doble clic sobre el color azul en el
canal 2 del osciloscopio aparece una paleta de colores que seran la opcién para el color del trazo de cada

canal del osciloscopio. Elegimos en este caso el verde.
Graph of X5C1

Graph Propertie

Colores basicos:

Colores personalizados:

Caption: IGraph of X5C1 . I_ I_ . I_ - I_ I_
Colours: ch. 1 -l ch.2: I- . I_ I_ I_ - . .
_ N R ENNEENEN
wemm: S ZVimEEEEEEN
vma: [ EEEEEEEN
: s EEEEETE

Time: IE jl j z
HEE
EEE

Definir colores personalizados =

Aceptar Cancelar |

Vemos que el trazo del canal 2 del osciloscopio se ha cambiado a verde.
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Graph of X5C1
10
8 -
=
[ik] 6 7
n
5
o 4
=
2
O T T T T 1
0 5 10 15 20 25
Time [s]

Si queremos ahora hacer algunas mediciones con otro instrumento, debemos primero dar “Stop” a la
simulacion, luego seleccionar el osciloscopio y el grafico para asi deletearlos.

Simulando un circuito con el Multimetro digital
Midiendo voltaje
Accione nuevamente la galeria en la parte Virtual Instruments y seleccione el multimetro digital como muestra

la figura, de la misma manera que procedimos con el osciloscopio.
Recuerde que para medir voltaje debemos conectarlo en paralelo al componente que deseemos medir.

KA
- W} F -
Il
SWi1
+ R1 R2 R3 R4 R5
B1 = 1K 1K 1K 1K 1K

oV

Lo conectamos como muestra la figura, el negativo a 0 volts y el positivo del multimetro Al anodo del led D1,
para ver la tension de salida. i

SWi1
ks R1 R2 R3 R4 R5
B1 T 1K 1K 1K 1K 1K

WV

D1 D2 D3 4 D5
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Damos comienzo a la simulacion apretando Run y cerrando la llave de encendido. Vemosfue? el @ircuito @
oscila, si esta el led alimentado 1,98voltios, y cuando no esta alimentado la tensién en la salida es de casi
Ovolts.

XMM1
TR
= plt .

, |
- "o > . » o
SWi1
_1+* R1 R2 R3 R4 R5 []
B1 = 1K 1K 1K 1K 1K
Vo=

D1 D2 D3 4 D5
o o W e o

Midiendo amperaje

Accione nuevamente la galeria en la parte Virtual Instruments y seleccione el multimetro digital como muestra
la figura, de la misma manera que procedimos con el osciloscopio.

Recuerde que para medir amperaje debemos conectarlo en serie al componente que deseemos medir.

KMMA

R

+ R1 R2 R3 R4 RS |y
B1 = 10 1K 1K 1K 1K -
9V — H
M

D1 D2 D3 4 D5

N I\ e

[

Ahora notemos que aun esta en funcién voltimetro, para seleccionar la funcién amperimetro debemos hacer
clic derecho sobre este y alli seleccionaremos la opcion “Instrument” y alli seleccionaremos la opcion
“Current” y ademas tendremos la opcion de elegir si mediremos corriente continua “DC” o alterna “AC”".
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Ex

=

# Cut Ctrl+X
Copy Ctrl+C
¥ Delete Del
e [2
Symbol 3 Current
Arrange 3 Ohm
[ Broperties AC F
B1 = v DC 1

oV i

D1 D2
ot

Damos comienzo a la simulacion apretando Run y cerrando la llave de encendido. Vemos que el circuito

oscila, dando si esta teniendo una “Current= 27,64 m A (amps)”.

XM

g2
= mé |y

N

Digital Multimeter
(Circuit Symbol)
Current = 27,64mA (amps)
+ Rt RZ R3 R4 RS
BT 10 K K 1K K

o

Midiendo resistencia

Accione nuevamente la galeria en la parte Virtual Instruments y seleccione el multimetro digital como muestra

la figura, de la misma manera que procedimos con el osciloscopio.

Recuerde que para medir resistencia debemos conectarlo en paralelo al componente que deseemos medir y

debera estar sin alimentacion el circuito.

+
Ammeh

3 Cut Ctrl+X
Copy Ctrl+C s Veltme!
oltme
¥ Delete Dl
oo .

+ Rt R2 R R4 RE Symbol 3 Current
g1 T 10 1 1 1 1
Ei Properties
o oz [o5] 4 D5
B B W T
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] Ll ottt k)

Ahora notemos que aun esta en funcién voltimetro, para seleccionar la funcion éhmetro debénos ha@er clic
derecho sobre este y alli seleccionaremos la opcion “Instrument” y alli seleccionaremos la opcién “Ohm” y
ademas tendremos la opcién de elegir si mediremos corriente continua “DC” o alterna “AC”.

N

-@-

Digital Multimeter
(Circuit Symbol)

oo

Resistance = 1,00K

(ohms)

R v

Virtual In:

10

0\ .

|

Ver Figura 17 del apéndice de ejercitacién de inglés.

Simulando un circuito con el Multimetro analdgico

Las conexiones son las mismas que las que usamos al medir con el multimetro digital solo que me
representara analdgicamente los valores medidos y tendremos que elegir la escala a medir igual que lo
hariamos en un multimetro analdgico real, pero no podremos medir resistencia.

i

'HM‘H.

Cut Ctrl+X
Copy Ctrl+C

&
et Del

. Delete

Symbaol 3
Arrange 3

Properties

R2
1K

|

R3
1K

L

[ %Il

.—

e |

Current

1mV
10mV
100mY
500mV
i

B

v 10V

N

Ver Figura 18 del apéndice de ejercitaciéon de inglés.
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Simulando un circuito con el Watimetro

Las conexiones son las mismas gue las que usamos al medir con el watimetro real, es decir dos puntas para
medir el voltaje aplicado al componente (conectar en paralelo a este) y dos puntas para medir el amperaje que
circula a través de este (conectar en serie) como se observa en la siguiente imagen.

ECUEY

o L L) L L
= oi3se| .,
o+ R Rz R3 R4 RS L e
g1 ] K 1K 1K
L
L
D2 D2 4 o5
S Sl

Ver Figura 19 del apéndice de ejercitacion de inglés.

Simulando un circuito con puntas de prueba

Podremos agregar unas puntas de prueba que mediran voltaje respeto a masa (0v), se pueden insertar tantas
puntas de pruebas como queramos, en la imagen siguiente usaremos tres para analizar la ultima rama del
circuito.

piepuels  saa] :Bo Mol 3
&

A XA g

< BIORY

b\, Gircuit Diagram | PCB Layout /i PCE Layout 2 /| PCB Layout 3 /| PCE |4 |

12 4

9

“oltage [%]
=
!

(7]
1

#

Podremos ver en la imagen anterior la conexiéon de las puntas de prueba en el circuito y su grafica
correspondiente debajo con un color diferente para cada punta de prueba. Esta grafica se puede modificar
para tener una escala mas adecuada de la misma manera que modificamos el gréafico para utilizar el
osciloscopio.

(=1

10 12 14
Til

[=]
a
o
&3]
=]

Ver Figura 20 del apéndice de ejercitaciéon de inglés.
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Simulando un circuito con el Analizador ldgico

Podremos agregar un instrumento que mide el estado l6gico del punto en el circuito al que lo conectemos, es
decir nos mostrara graficamente un estado bajo 0 digital (0 voltios) y un estado alto 1 digital (mas de 2,5
voltios) este instrumento se utilizara en electrénica digital. En la imagen siguiente veremos un ejemplo de
conexion.

o

Para poder visualizar las mediciones debemos agregar un la Add Graph (barra de gréficos) en la cual

veremos el estado l6gico de cada salida en funcién del tiempo. Para modificar los parametros del grafico
procederemos de la misma manera que al modificar el grafico del osciloscopio.

EH

D M G W T S

IO M IeE = R P

-
Y
Ll

XLAT

) 0 0

1 1

R — = |= I 2

3 3

4 4

5 5

& B

7 7

] 8

a 9

—A

R 10— —B

7 —c

——JEH ;.1 IC1 _E

i 40178 =
L
E
T
Ed
9

Graph of XLA1

3 Cut Ctrl+X

- Copy Ctrl+C Ch.0
| ¥ Delete Del Ch.A1
Ch.2
"T]| Add Graph
Ch.3
i‘fmbﬂ' 3 Ch.4
Arrange 3 Ch5
Properties Ché
T T 1

dale [ | 3

4
Ver Figura 21 del apéndice de ejercitaciéon de inglés.
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Simulando un circuito con el Generador de funciones *

- |

Podremos agregar este instrumento que entrega diferentes tipos de voltajes y tipo de corrientes. Es decir que
es capaz de entregar una corriente alterna senoidal de 220 voltios con una frecuencia de 60 Hertz como las
corriente alterna que nos entrega la empresa que nos provee la energia eléctrica en nuestras casa; también
podemos generar una onda cuadrada, triangular, etc. Si hacemos doble clic sobre este instrumentos
podremos elegir el tipo de sefial (senoidal, cuadrada, triangular, etc.) asi como otros parametros como el

voltaje, frecuencia, etc.

Mumber:  [xFG :“ | oK |
Caption: I Cancel |

[~ | v | —=

Voltage: |5 %I

Frequency: |1

Offset: |n

Phase:

Ver Figura 22 y 23 del apéndice de ejercitacion de inglés.

Simulando un circuito con el Generador de funciones

digitales

Podremos agregar este instrumento que entrega valores digitales en su salida que nosotros podemos enviar

secuencialmente.
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WG
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1

2

3 —_—
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s
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== 220
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D— .} b C

E — —d < 1

Fi— — 1= d 1
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] 0
B onorr 5 ° —
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——= IC1

Mumber: I}:WG |1

Caption: I

From:  [000 To: [o08 j
Data: |umm Hexl

# | Hex | Binary ~
Qoo 0001 0000000000000001
001 0010 00002000000 10000
002 0011 00000000000 10001
003 0000 0000000000000000
Qo4 Qo000 Q000000000000000
Qo5 oooo 0000200000000000
0os 0000 0000000000000000

anT  annn ANANANNNNNNNNNNN

Frequency: IU.l

Donde nos aparecerdn las siguientes opciones para modificar:

¢ Number: para modificar el cédigo y numero del instrumento.

e Caption: por si queremos agregarle alguna informacién adicional.

e From: desde donde empezara a enviar los datos en este casa desde el dato 000.

e To: hasta que dato terminara de enviar en este caso el dato 008.

e Data: aqui cargaremos el valor digital que queramos enviar, previamente deberemos seleccionar el
namero de dato y en que formato lo cargare (en este caso esta seleccionado el dato 003 en formato
Hex o Hexadecimal).

e Frecuency: la frecuencia con la que se enviaran los datos.
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A P a [
A continuacion vemos como envia en valor digital a un decodificador de binario a display de 7 segmentos,
primeramente envia un valor binario que se interpreta como un “0” en el display y después un valor que se
interpreta como un “1” en el display.

* Run

H
=
@

nulate the active circuit. (F4)

cacaca_

D51

]

] _
£3C3C363 | £3C3CICD | €ICICI—
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|

MmO W e 0 Ton R R D

IIIIIIIIIIIIJ

MmO T o o R D
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|
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Ver Figura 24 y 25 del apéndice de ejercitaciéon de inglés.
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Como Crear Circuitos Impresos

Ya vimos como armar los esquemas circuitales, y como probar si funcionan, entonces ahora que sabemos que
el proyecto anda perfectamente, podemos crear la placa de circuito impreso. Para los cual tenemos dos
opciones: “disefar el pcb nosotros mismos” o “utilizar la opcion de autorruteo del pcb”.

Ver Figura 26 del apéndice de ejercitacion de inglés.

Elegir la unidad de medida a usar

Por defecto la unidad de medida es el in (inches o pulgadas), para modificar esto tenemos dos opciones:
e La primera es ir al menu Viewl/Coordinates y elegir la opcion Milimetres (milimetros) como se
observa en la siguiente imagen:
%
| €3 File Edit |View Project Window Help

D& M| (O Noms vl e B QX |

[ﬁ Page Layout Preview

GoTo 3
Toolbars 3

€@ Gallery Ctrl+F2

i Graph Ctrl+F3
Display 3
Animation 3

<F Style 3

Co-ordinates
# Grid/Snap

Centimetres
Metres
|—:- Inches
Points
Mil (0.001 inch)

Zoom

22

puels sjEra 6ol wmoj4Juanny  sEaaabeljos  jewop

n? ni n&

e La segunda es ir a la Barra de estado en la esquina inferior derecha y hacer clic derecho sobre el
cuadrado que indica las coordenadas como se observa en la siguiente imagen:

<3 Origin » balep
n |v Millimetres
Centimetres b LED
o Metres
ce - Inches
' I _"I;I E Points LI
: : Mil (0.007 inch)
| Graphic Foreground |' 240,5, 166,5 mm : — ) Ready

08:24 a.m.
03/04/2018

A partir de ahora todas la medidas estaran expresadas en milimetros lo que facilitara nuestra interpretacion.

« [ W E[mE il

Profesor Palacios José Emanuel Pagina 46



Manual de Circuit Wizard 1.5 r Ei.i.i.“‘“‘hhh‘:
N 2 R

Método autorruteo
Tenemos dos opciones para activar el autorruteo la primera en “PROJECT” deslizamos el mouse hasta

“Circuit Symbols” y luego hacemos clic en “Convert to PCB Iaiout..” ver fiiura siguiente.

t View | Project Window Help

(& | »Run P lulal[k ™A X7l
B 1 Pause Shift+F9
[ m Stop Ctrl+F9
Simulation 3

E@ Convert to PCB Layout...

=1l PCB Components »
Label
# Off-Board b A Labe
&0 Test Equipment  » Power Supplies 3
i cti 3
A AddProbe  F3 ennecior
Input Components 3
Folder 2 Passive Components 3
Draw 3 Discrete Semiconductors » |
Author 2 Logic Gates 3
. Integrated Circuits 2
Options...
Output Components 3

La segunda es ir al icono de autorruteo y darle clic.

VX | A g o 6

QI Convert to PCB Layout

Convert a circuit diagrarn into a
printed circuit board (PCE) layout.

Vera que una ventana aparecerd para conducirlo a través del proceso de conversion.

Circuit Wizard enables you to convert your drcuit
designs automatically into printed drcuit board (PCB)
layouts ready for manufacture.

This wizard leads you through the conversion process,
allowing you to choose exactly how your design wil be
converted. At the end of this process, Circuit Wizard wil
generate your printed dreuit board layout.

Click Next to continue.

Ver Figura 27 del apéndice de ejercitacion de inglés.

La ventana contiene una serie de paginas que le permitiran decidir como sera convertido su circuito impreso.
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Paso 1 Tipo de trazo de pistas, cantidad de capas, etc.

Choose how you wish to convert your design into a PCB
layout and then dick Mext to continue.

73 Single-Sided; Thick Tracks
& Single-Sided; Normal Tracks
& Single-Sided; Thin Tracks
¢4 Double-Sided; Thin Tracks

om b
@ Creates and places components without
automatic routing.

Apareceran las siguientes opciones:

Single sided; Thick tracks: crea un PCB con pistas de un solo lado y las mismas son gruesas.

Single sided; Normal tracks: crea un PCB con pistas de un solo lado y las mismas son normales.
Single sided; Thin tracks: crea un PCB con pistas de un solo lado y las mismas son delgadas.
Double sided; Thin tracks: crea un PCB con pistas en dos caras “doble faz” y las mismas son
delgadas.

Placement Only; no Routing: Solo coloca los componentes en la PCB con una disposicion como la
que tenia el dibujo esquematico, sin enrutamiento de pistas es decir que no crea las pistas solo pero
nos mostrara una linea verde fina las interconexiones que tienen que tener los componentes entre si
para facilitarnos el trabajo.

Rats Nest; No Placement or Routing: nos deja un “Nido de ratas” es decir que deja los componentes
sueltos “FUERA” del area del PCB sin una disposicidon especifica ni trazado de pistas, pero nos
mostrara una linea verde fina las interconexiones que tienen que tener los componentes entre si para
facilitarnos el trabajo.

Nota: sobre la opcién que seleccionemos no aparecerd una descripcion mas detallada en el cuadro de
“comments”, como se ve en la imagen anterior.

Ademas tendremos un casillero en el que podremos tildar y dice: “Allow me to customize the pcb layout
conversion” que: que me permitira personalizar la conversion de disefio en las siguientes ventanas y en el
PCB luego de que me termine la conversion, es decir que me permitira mover los componentes mientras se
autorrutean las pistas.

Ver Figura 28 del apéndice de ejercitacion de inglés.
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Paso 2 Tamaio y la forma del impreso.

The size and shape of the printed circuit board to be
generated can be spedified below.

Shape: IRecIanguIar ¥ I
Rectangular
[ IwishtospeCirowlar  Hrcuitboard
Width: |2,3 in

Height: |2,3 in
Size: I_ J—

1 i |
Smaller Larger

Click Next to continue.

< Back I Next > I Cancel | Help |

Tendremos las siguientes opciones:
e Shape: nos permitira elegir si la plaqueta sera rectangular o circular.
e Debajo de Shape tendremos la posibilidad de tildar el casillero que nos permitira definir las
dimensiones de la PCB nosotros mismos en las opciones Width (anchura) y Height (altura).
e Size: nos permitird definir si la PCB sera Smaller (pequefia) o Larger (grande).

Notemos que las medidas estan en 2,3 In (inches o pulgadas) para modificar esto tendremos que antes de

empezar con el autorruteo seleccionar la unidad de medida en milimetros.
Ver Figura 29 del apéndice de ejercitacién de inglés.

Paso 3 Componentes que llevara la PCB

The following components were found in your circuit:

Component | D | Package

10 Resistor R1 Resistor (0.4in, 1...
1K Resistor R2 Resistor (0.4in, 1...
1K Resistor R3 Resistor (0.4in, 1...
1K Resistor R4 Resistor (0.4in, 1...
1K Resistor RS Resistor (0.4in, 1...

[w] v Battery Bl  TerminalBlodk(2... ™
£ >

El Double-dick on & component name to change the
way in which it will be be converted.

Click Mext to continue.

< Back I Mext = I Cancel | Help

Podemos tildar o destildar el componente segln queramos usarlo o no.
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Package:
Resistor (0.4in, 10.2 mm)

Preview

Size = 0,08 (W) x 0,25 (H) in

Package:

Resistor (0.4in, 10.2 mm)

(Mone)

Resistor (0.1in, 2.5 mm)
Resistor (0.3 in, 7.6 mm
Resistor (0.4 in, 10.2 mm)
Resistor (0.5in, 12.7 mm)
Resistor (0.6 in, 15.2 mm)
Resistor (1.0in, 25.4 mm)

The package specified above will be used when

this component is converted into a PCB.

Help

[ o 1|

The package spedfied above will be used when
this component is converted into a PCE.

Cancel

| Help

Si hacemos doble clic sobre alguno de los componentes de la lista nos aparecerd otro cuadro de dialogo que
nos dard una vista previa del componente con sus medidas aproximadas. También nos dard la opcion de
elegir otro tipo de componente con caracteristicas similares pero diferentes “Package” es decir las

dimensiones.

Paso 4 Tipo de pads

Ver Figura 30 del apéndice de ejercitacion de inglés.

The size of the component pads can be customized by
editing the settings below.

¥ Use customized PCE component pads:

€ small
€ Standard
€ Large
&

Edi... I

Click Mext to continue,

< Badk I MNext = I

Cancel | Help |

Tendremos que tildar el casillero y para poder usar los Pads predefinidos como: Small (chico), Standard
(normal), Large (grande), IC (para integrados y microcontroladores).
Si seleccionamos uno por ejemplo Small y damos clic en el botén “Edit..”, nos aparecera una nueva ventana
con el titulo “Edit Profile” en el cual podremos modificar pardmetros tales como:

e Shape: aqui elegiremos la forma del pads, tendremos tres posibilidades Square (cuadrado), Round

(redondo) y Squashed (aplastado).

e Width: aqui elegiremos el ancho externo del pads.

e Height: aqui elegiremos la altura externa del pads.

e Layer: aqui elegiremos la capa sobre la cual se aplicara el pads.
e Hole: aqui elegiremos el tamafio del agujero del pads.

e Gap: aqui elegiremos la separacion de pads respecto de la capa de copper area que es el area de

cobre que dejamos para masa.
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Small

Fad used for small or tighty
packed component pins.

Pad used for small or tightly
packed component pins.

Shape: Round ;I

%ﬁ__ﬁﬁi----#
Squashed
Layer: |- Both Sides ;I

Haole: IO,UEZ in Gap: ID,U4 in
oK I

shape: 2

Width: ID,UG in Height: 0,06 in

Layer: I- Both Sides hd

0,032in Gap: |0,04 in
Ok I Cancel | Help |

Cancel |

Ver Figura 31 del apéndice de ejercitacién de inglés.

Paso 5 Colocacion automatica de pines de fuente de 5v

Donde tendremos el primer casillero que nos permitird agregar las conexiones de fuentes de alimentacion de
componentes e integrados digitales que no aparecen en el cirquito esquematico. Por ejemplo la siguiente
compuerta no tiene para conectar los pines de alimentacién en el circuito esquematico, pero si los tendra en el
disefio PCB, a continuacién vemos la compuerta es simbolo esquematico y la compuerta en PCB con su
correspondiente encapsulado y disposicidén de pines, también podemos observar que se agregaron los pines
+V (alimentacion positiva) y 0V (que es el pin donde conectamos los o voltios de la fuente de alimentacion).

IC1a
4081B
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[¥ My circuit contains a hidden digital power supply.

For the drcuit to work correctly, these hidden
connections need to be joined to a real power supply.

Connect the hidden power supply as follows:

Power: IEl LI on IPin 1: Positive ;I
Ground: (EERINIM ~| on [Pin 2: Negative |

To indude an explicit digital supply on your dreuit,
add terminals connected to nets named VCC and
GMD (for TTL) or VDD and Y55 (for CMOS).

Click Mext to continue.,

< Back | MNext = I Cancel | Help |

En la imagen anterior tendremos las opciones de conexion para elegir que fuente de alimentacién elegiremos,
las opciones que tenemos para elegir son:
e Power: en este casillero por defecto aparece B1 (es decir la bateria 1) On Pin 1 Positive (el pin 1 de
la bateria es el positivo).
e Ground: en este casillero por defecto aparece B1 (es decir la bateria 1) On Pin 2 Positive (el pin 2 de
la bateria es el negativo).

Deberiamos que seleccionar que bateria utilizariamos para el componente digital que tenemos en nuestro
circuito.
Nota: esta opcion solo aparecera si en las opciones de simulaciones que vimos anterior mente, tenemos
habilitada la inclusion de fuente de alimentacion digital y si tenemos algin componente que requiera de dicha
fuente de alimentacion.

Ver Figura 31A del apéndice de ejercitacién de inglés.

Paso 6 Colocacién automatica de componentes en el PCB

Donde tendremos casilleros para seleccionar los parametros para la ubicacion de los componentes en la PCB
y ademds nos dice el Minimun spacing (minimo espacio entre componentes) que en este caso es de
2,54mm.
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The companents can be automatically placed on the
printed drcuit board.

|¥ Automatically place components on the board:

[+ Animate component placement

v Allow components to be rotated

W Automatically fit placement to board
[v Take into account symbel positions

Minimum spacding: |2.5—1mm

Click Mext to continue.

< Back | Mext = I Cancel | Help |

Los casilleros son:

e Automatically place components on the board: hard que se coloquen automaticamente los
componentes en el pcb.

e Animate component placement. nos permitird ver la animacién de como se irdn ubicando los
componentes.

e Allow component to be rotated: si la seleccionamos permitira al programa rotar los componentes de
ser necesario.

e Automatically fit placement to board: permitira ajustar automaticamente la ubicacién de la plaqueta.

e Take into account symbol positions: tomara en cuenta la posicion de los simbolos tal cual los

ubicamos en el circuito esquematico.
Ver Figura 32 del apéndice de ejercitacién de inglés.
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Paso 7 Trazado automatico de las pistas del PCB
Donde tendremos casilleros para seleccionar los parametros para el trazado de las pistas.

THe f et cra=ctinuss o e o3 1ol 3 Al The dreuit connections can be routed automatically.
Itis during the automatic routing process that Circuit
Wizard will work out a suitable path for each connection
and then convert these into copper tracks and wires.

It is during the automatic routing process that Circuit
Wizard will work out a suitable path for each connection
and then convert these into copper tracks and wires.

¥ Automatically route connections in your drcuit
¥ Allow fracks to be placed diagonally
v Allow wire links to be added when necessary
[~ Allow routing on both sides of the board

¥ Automatically route connections in your drcuit
v Allow fracks to be placed diagonally
[ allow wire links to be added when necessary;

[~ Allow routing on both sides of the board

Grid: [0, 100" grid with 0.040" tracks |

0. 100" grid with 0.060" tracks
0. 100" arid with 0.040" tracks
Click Next t{0+050" grid with 0.020" tracks
10.025" grid with 0.010" tracks

< Back | Mext = I Cancel | Help |

Grid: [0, 100" grid with 0.040" tracks |

Click Mext to continue.

< Back I Mext = I Cancel |

Los casilleros son:

e Automatically route connections in you circuit: hard que se enruten automaticamente las
conexiones entre los componentes.

e Allow wire links to be added when necessary: permite que se agreguen enlaces o puentes cuando
sea necesario.

e Allow routing on both sides of the board: permitir que se unruten automaticamente las conexiones
en ambos lados de la plaqueta.

e Grid: nos deja definir la cuadricula que utilizaremos en el pcb, el primer dato serd: 0.100grid with
(tamafio de la rejilla) y el segundo 0,060 tracks (separacion entre las pistas). Al hacer clic sobre estas

se nos desplegara una lista con cuatro posibles opciones.
Ver Figura 33 del apéndice de ejercitacion de inglés.

Paso 8 Agregar el area de cobre solido
Agregar el area de cobre solido que utilizamos en electrénica para generar la masa o bien para reducir el area
gue deberd comer el percloruro férrico.

Areas of solid copper can be added automatically to the
printed circuit board.

Adding copper areas helps reduce the cost of production
by minimizing the amount of etching that is required.

|v Automatically add copper area(s) to the board;

You can specify the isolation gap in the field below.
This is the distance between a copper area and the
electrical parts in your drcuit.

Track isolation gap: Il,DZ mm
Click Mext to continue.

< Back | Mext = I Cancel | Help |

Si tildamos el casillero que dice “automatically add cooper area(s) to the board” se agregara
automaticamente Area de cobre a la plaqueta y se nos habilitara el siguiente casillero:
e Track isolation gap: que nos permitira elegir la separacion entre el area de cobre y las pistas, en este
caso esta en 1.02mm, pero la podremos modificar segin nuestro requerimiento.
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Paso 9 Ultima pantalla antes del proceso de conversién
Donde s6lo debemos hacer clic en Convert.

Circuit Wizard is ready to generate your dircuit. This
process may take a few moments to complete.

Click Convert to continue.

De tener un dibujo PCBLayout existente, nos pregunta si queremos sobrescribirlo o abrir otra pestafia
PCBLayout.

Circuit Wizard is ready to generate your drcuit. This
process may take a few moments to complete.

| SR
< Back I Convert I Cancel | Help | @) :

Inmediatamente después vemos que los componentes aparecen moviéndose hacia adentro de lo que sera el
circuito impreso.
Ver Figura 35 del apéndice de ejercitacion de inglés.
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Disenar el PCB nosotros mismos

Ya vimos como armar el PCB con el método autorruteo, ahora veremos cOmo armar nosotros mismos el pcb.

Agregar un componente nuevo

Sobre el nuevo documento aprenderemos a usar la galeria para agregar componentes a su circuito. Si la
galeria no estd actualmente abierta, presione sobre el boton Gallery (galeria) en la barra de herramientas
para abrirlo. Seleccione la opcién simbolos de circuito.

En la ventana de la galeria de simbolos de circuito, usted podra ver todos los componentes que se encuentran
disponibles dentro del programa.

yla Alcodoy Orozco.cwz *] — O
_|=| x|
L=
- |
_‘la Switches j @
3 Switches ~
i
[_1 Passive Components %
[Z Resistors 2
Galeria [C Capacitors &
27 Inductors =
[Z1 Discrete Semicenductors %
_ [Z] Dicdes 2
[Z Transistors
([ Logic Gates
[Z1 Integrated Circuits

Los componentes dentro de la galeria estan agrupados de acuerdo a su funcién. En la parte superior de la
ventana hay una lista que le permite seleccionar qué grupo sera exhibido. Para hacer el circuito, del grupo
“fuentes de alimentacion”, agregue el componente “bateria” al documento de trabajo, para hacer esto coloque
la flecha del mouse sobre el simbolo bateria, presione y mantenga el botén izquierdo del mouse, con el boton
aun sostenido, arrastre el simbolo a su circuito. Finalmente, suelte el botdn del mouse cuando el simbolo del
circuito esté en la posicién requerida dentro del documento de trabajo.

Ahora necesitaremos agregar el resto de los componentes para lo cual procederemos de forma andloga a lo
recién explicado.

Otra manera de buscar los componentes:

Cabe recordar que en la galeria no aparecen la totalidad de componentes que existen el Circuit Wizard 1.15,
la otra forma de buscar componentes es ir en la barra de ment | Project y alli tendremos unas de las
opciones que nos dice:

e PCB Componentes: componentes dl PCB.

e OFF-BOARD: componentes fuera de la plaqueta.

e Test Equipment: equipamiento de tested.

Adentro de cada una podremos buscar el componente que necesitemos.
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| €3 File Edit View | Project Window Help
D= d|a|

0w OQ X AL e~ m WA

== || Pause  Shift+F2
= Stop Fa

: [ Stor =g
L Simulation » 7 G SR N RN S EEY

= e . U e s -

g . | £ Circuit Symbols  » 1]} A

= [Tl Automatic Routing b | I S

= # Off-Board »| 2% Quality Check... --*f
g\ . & TestEquipment  » _].7_%“ o I IR e 2
2 # AddProbe  F5 | @ Pad F2

F - [ — Flying Wi F4 Getti

] Folder o (N Getting §

W Circuit Board

= Draw Viclcome to
5 M Copper Area

= Author 3 Getupand
= Aa Copper Label the topics b
% Options... T ; to navigate
> Power Supplies Terminal Block (2 pin; 0.2 in, 5 mm: +/-)

g Connectors 3

H AA Battery with Holder (1.5V)

B Input Compenents 3

2x AA Battery with Holder (3V)

= B S e A Bty i Holdes (451}

z Discrete Semiconductors »| %0 * M [
=S Integrated Circuits v SR

2 AAA Battery with Holder (1.5V)

g Output Components » \
= 2 x AAA Battery with Holder (3V) P
z % PP2 Battery with Helder (3V)

= CR2032 Coin Cell (3V: Horizontal)

CR2032 Coin Cell (3V;: Vertical)
CR1216 Coin Cell with Holder (3V; 0.45 in, 12 mm)
CR1616 Coin Cell with Holder (3V: 0.65 in, 16 mm)
CR2032 Coin Cell with Holder (3V; 0.8 in, 20 mm)
CR243D Coin Cell with Holder (3V: 0.8 in, 24 mm)
Dusl CR1216 Coin Cell with Holder (6%: 0.45 in, 12 mm)
i i o T - Dual CR2032 Coin Cell with Holder (6V; 0.8 in, 20 mm)
Circuit Diagram f, PCB Layout ; Bill of Materials Dual CR2430 Coin Cell with Holder (6V: 0.9 in, 24 mm)
Press F1 for help

Voltage Regulators v

Wil
Agregue cinco resistores del grupo de componentes pasivos, agreguen un switch (notar que no existe el

switch para pcb asi que pondremos un Terminal Block) del grupo componentes de entrada y finalmente cinco
LED del grupo de componentes de salida.

Debemos posicionar los componentes cuidadosamente sobre el documento de trabajo antes de comenzar a
disefar el circuito.

Tenga en cuenta que se pueden mover los componentes si nos fijamos con el mouse sobre ellos, haciendo un
clic y manteniendo apretado el botén mientras movemos el componente sobre la posicion requerida.

Para esto, desde la barra de herramientas, deberemos seleccionar el cursor como un sefalador estandar.
Help

| » ul al[k & x|

Notese que ahora los componentes tienen ademas una clasificacion segun su tamafio y si estan dentro o
fuera de la PCB asi como la conflguracmn de cada pin del componente

|1 Uutput Components
+ + + (23 Audio 3
: o C ([ Optoelectronic —
23 3mm LEDs (Miniature)
|_3 8mm LEDs (Large)
[_1 10mm LEDs (Extra Large)
(L] LED Displays
Ea Electromagnetic
. . . . . (22 Relays
S S L+ | Otf-Board Co S
) t ) t T [_ Power Supplies
|21 Input Components

4l

(2 Switches
(27 Sensors
|Z1 Passive Components
|21 Discrete Semiconductors
(2 Output Components v

Flashing LEDs

Red LED

(PCB Component)
Pin = 2 of 2: Cathode
Component = D6

.
Red Flashing LED
Q:‘ 0.2in, 5 mm

+ + + *’6‘ Yellow Flashing LED
T k. 02in, 5 mm

— Qﬁ Green Flashing LED
k. 0.2in, 5 mm

Ver Figura 36 del apéndice de ejercitacién de inglés.
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a7 =
En la figura siguiente podemos ver cdmo quedaran los componentes una vez arrastrados sobre el documento

de trabajo.
Tenga en cuenta que es conveniente pensar en la posicion que deberan tener los componentes antes de

colocarlos sobre el documento de trabajo.

+
.
.
:

-
+
+
+
+‘-'-I

Definir la cuadricula a usar

Antes de seguir con el disefio deberemos definir la cuadricula o rejilla a usar. Para ello tendremos dos
opciones:
La primera es ir a la barra de menu en View/ Grid/Snap como muestra la siguiente imagen:

ile Edit | View Project Window Help
& W | ¢ E Normal you el [FEAX ][ AL~ W e H
_l@ Page Layout Preview
R — R R
Toolbars L
Cll@meelery  cmsR2 [0 L
Display 3
... Animation >_....+..+....+...+...+..
.Y Style 3 PP - [ S . e
— ey 43
- Co-ordinates » . B . {1; 1 e 1} . ! . i .
- 3 CTEE  HideGid Cirl+D W T C oA
oo }'ESnaptoani Shift+Ctrl+D | ; ' J_ru_ -
| v Snap to Objects L L . o
L 0,025in . :
+ + 0,05 in & s &
L 0.2in .
S D'Smm .
S+ + 1 mm + + +
. N '
----- Custem... Ctrl+Alt+D
BT e e e e e e e

La segunda es ir a la Barra de estado en la esquina inferior derecha y hacer clic derecho sobre el cuadrado
gue indica la cuadricula o rejilla como se observa en la siguiente imagen:

11
Sources [ show Grid Ctrl+D
i Snap to Grid  Shift+ Ctrl+D
- v Snap to Objects
0,025 in
0,05 in
[v o1in
10V / 1Hz 0,2in
0.5 mm
1 mm
» ’L,, 2 mm
| Graphic Foreground 233,68, 157,48 mm Lrspme e

09:36 a.m.
03/04/2018

% il
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Donde tendremos las siguientes opciones:
e Hide grid: esconder la rejilla o cuadricula.
e Snap to grid: encajar la cuadricula.
e Snap to objects: ajustar a los objetos.
e Custom: para personalizar la grilla si hacemos clic alli se abrira la siguiente ventana.

Grid spacing: |1ir1 ~| = OK I || Grid spacing: Ilin -] -|
C s - | 1i
Sub-divisions: Ilﬂ le -l Cancel | || Sub-divisions: -l Cancel |

[ Displaygrid ¥ Snap to gric Help | M F oispayqrid ¥ Snap to grid Help |

Donde podremos definir :
¢ Grid spacing: el espaciado de la cuadricula y su color correspondiente . pudiendo seleccionar lin
(inches o pulgadas) o 10mm.
¢ Sub divisions: las subdivisiones y su color correspondiente.
¢ Display grid: ver la o no la grilla.
¢ Snap to grid: encajar la cuadricula o rejilla.
Acontinuacion vemos en la imagen el espaciado de la cuadriculo en color rosa y las subdivisiones en color
negro.

Agregando la PCB

La posicién de los componentes al comienzo puede ayudar a producir un diagrama de circuito mas claro, pero
aun debemos definir los limites de la plagueta adonde vamos a colocar los componentes. Para agregar el
Circuit Board debemos seleccionarla en la barra de herramientas como se muestra en la figura siguiente:

EmMQX| /Lo ]

W de 2]~

d

B Circuit Board 3
Insert a printed circuit board.
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También podemos ir al menu Proiect /IPCB Comionents como vemos en la sir';uiente imagen®™ ? @&

‘ile Edit View | Project Window Help
j;m‘gﬂg p Run Fg
Shift+Fg
Ctri+Fg

n| m|l[k QX[ A i

11 Pause
I_. Stop

Simulation

#E Circuit Symbols
Automatic Routing »

A Off-Board b |2} Quality Check...
Test Equipment  »
§1i= o =, Track F2
# Add Probe F3 | & Pad F3
7~ Flying Wire F4
Folder B
5 B Circuit Board
3
o B Copper Area
Author
Aa Copper Label
Opticns...
o Breadboard Modules »
Power Supplies »
Connectors 3
Input Components »
Passive Components »
Discrete Semiconductors »
Integrated Circuits »
Output Components »
Luego arrastrar en la hoja de trabajo
= e
+ E+- Fooe w
o T T S
AU PR D . A -
s LR N R | 8 oL e e Ry
' S + S ey . ¥ + + e ey
¢ . 7T e . ....W‘..H.._f“..hr..

Ver Figura 37 del apéndice de ejercitacion de inglés.
Podremos ademas editar la forma del circuit board, si hacemos clic derecho se nos desplegara una ventana
y si elegimos la opcion Shape, nos daré la opcion de elegir si la plaqueta es rectangular, poligono o circulo,
etc. Como se observa en la siguiente imagen.
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__________ -|
i:i::::i::::::::::::i:
1,‘,11:11:::13 ,'!1:!::1 I
T - T o |
e e |
8 Cut  Chrl+X

CE B Copy  CtrlsC
¥ Delete Del

Routing L
Arrange » Peolygon

.......... " ;ircle

Ver Flgura 38 del apendlce de ejercitacion de inglés.

Posicionando los componentes

La posicién de los componentes al comienzo puede ayudar a producir un diagrama de circuito mas claro.

Para alinear los pins del resistor R1 con el 4nodo de leds D1, necesitara rotar los componentes, para ello
seleccione el resistor R1 haciendo un clic con el mouse y entonces presione sobre el botdn rotar hacia a la
izquierda o a la derecha de la barra de herramientas.

Ctrl+X
opy Ctrl+C
elete Del

Cut
Co

c’ié
EE]
XD

Pads...

Routing
Symbol

18 toc Crlek [
Properties g“_ Pull onto Grid ~ Ctrl+T |
o i F& : 2 [ﬂ ﬁl}l e | Sh ﬁ

T}, Bring to Front
By Sendto Back  Shift+F6

A% Rotate Left Ctrl+L

+,
BN rooeigrt_—Cui-5_| 42 Rotate Left

Rotate the selected objects
anti-clockwise. (Ctrl+L)

Ya con el componente rotado y la pcb reducida en tamafio:
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Conectando los componentes

Una vez que los componentes han sido ubicados, usted puede comenzar a unirlos. Para hacer esto usted
debe primero presionar sobre el botdén “Track” de la barra de herramientas.

X /Lo~ mm - =
\.. I

Insert a copper track. (F2)

Presione y mantenga con el boton izquierdo del mouse, sin soltarlo mueva el mouse hasta el punto donde
desea hacer la unién y para cortar la pista luego debe hacer clic derecho

Usted puede dibujar curvas, deslizando el cursor del mouse sobre el mismo o presionando sobre una parte del
circuito con clic derecho.
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Si hacemos doble clic sobre la pista que trazamos nos abrira la siguiente ventana que nos perfitird madificar
los parametros de esta:

Width: Gap: [1,27mm oK |
Layer: |- Solder Side ﬂ Cancel
Help

Las opciones de modificacién que nos da son:
e Width: ancho de la pista.
e Gap: aqui elegiremos la separacién de pads respecto de la capa de copper area que es el area de
cobre que dejamos para masa.
e Layer: aqui elegiremos la capa sobre la cual aplicaremos la pista.

width:  [L,02mm  Gap: [1,27mm oK |

Layer: |- Solder Side j

[ Component Side
Both Sides

Tendremos tres opciones para elegir
e Solder side: lado de las soldaduras.
e Component side: lado de los componentes.
e Both side: ambos lados.

Si se equivoca, en cualquier momento puede presionar el botén “deshacer” para corregir cualquier error.
Aqui el circuito ya terminad

Ver Figura 39 del apéndice de ejercitaciéon de inglés.
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Como cambiar valores de componentes y modelos

Con el diagrama de circuito de la figura, puede comenzar a ajustar el valor de los componentes.

En su circuito, el resistor R1 sera utilizado para limitar la corriente que pase a través del LED. Es bueno incluir
resistores cuando utiliza leds, sin ellos, los leds se pueden quemar.

Para una tension de 9 volt, el valor del resistor debe cambiar a unos 800 Ohm para limitar la corriente a unos
10mA, cuando el led esta encendido.

Nosotros usaremos un resistor de 680Q porque éste es un valor comercial que tenemos en el taller.

Para cambiar el valor, haga doble clic sobre el resistor R1 con lo cual se exhibirdn las caracteristicas del
mismo.

Number:

Caption:

Value:

El campo VALUE para el resistor se muestra en la parte inferior de la ventana y consiste de un valor y un
multiplicador. Ingrese 680 en el primer recuadro de valor (es el valor del resistor), y luego presione una vez
sobre la flecha de la derecha 9', i ipli r de K (x1000) a x1.

Number: oK |
Caption: Cancel
Model: Help

La mayoria de los componentes dentro de , proveen modelos diferentes. Los diodos
rectificadores por ejemplo, estan disponibles en una gama de diferentes modelos segin su amperaje y
tensiones de trabajo “1N4007”, etc. Pruebe ahora, presione el boton derecho del mouse sobre el un diodo
rectificador y seleccione de la lista de modelos habilitados.
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Como agregar el Copper Area (area de cobre)

Con el circuito PCB ya disefiado ahora podemos entre otras cosas agregarle el area de cobre que utilizamos
para insertar masa o simplemente para reducir costos de produccién al reducir la cantidad de cobre que
tendra que quitarse de la PCB.

A continuacién vemos la pcb sin el Copper area en vista normal:

Ahora para agregarle el Copper area debemos ir al icono que esté en la barra de herramientas que es un
rectangulo rojo, seleccionarlo y crear el &rea como se muestra en la siguiente imagen:

'Lﬁrw’-q\fm‘élv -

SR Copper Area

2000 ] Insert a copper area, |1l

Luegoarrastrarenlahojadetrabajrdm S

Podremos ademés editar la forma del copper area, si hacemos clic derecho se nos desplegara una ventana y
si elegimos la opcién Shape, nos dara la opcién de elegir si la plaqueta es rectangular, poligono o circulo, etc.
Como se observa en la siguiente imagen.

Profesor Palacios José Emanuel Pagina 66



Manual de Circuit Wizard 1.5

c'ﬁ'; Cut Ctrl+ ¥
2 Copy Ctrl+C
'}( Delete Del

= Layer Polygon
Arrange 3 Circle

| DR

Add Node

Ver Figura 39 A del apén'd.ié'é' deejercnacwn de inglés.

En su circuito, el resistor R1 sera utilizado para limitar la corriente que pase a través del LED. Es bueno incluir
resistores

Podra
Vista normal.

jlominy s oibol  mopdjueunDy  plog jeey |ELLI.ION[

Vista Real World.

g, [y | | ey

<! Real World

Shows the board as it will appear
when professionally
manufactured,

ey
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Vista Artwork

Jew

saE 2BoT  mop{ JuBlInD PO [EEY

oMY

pY
< Artwork

Previews the copper artwork for
single-sided boards.

Tambien pueden encontrar mas opciones de visualizacién en la pestafia de la esquina inferior izquierda que dice
More.

pajeindodun  syomgyy

Components + Current Flow
Components + Logic Levels

PRI

Components + Artwork

v Solder Side (Bottom) Artwork
Component Side (Top) Artwork
Silk Screen (Outling) Artwork
Board Prototype
PCE Designer Classic

Save Style...
K Delete Style... PCB Layout 2 /| PC

Press F1 for help

Ver Figura 40 del apéndice de ejercitaciéon de inglés.
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Agregando componentes externos al PCB

Ahora tendremos q ue agregar los componentes externos (bateria, teclas, sensores,etc) al pcb para asi poder
empezar a simular el circuito PCB.para agregarlos deberemos utilizar cualquiera de los metodos que ya

conocemos: ir a la galeria de componentes en la cual nos aparecera la opcion de Off-Board Components o ir
por el menu Project/Off-Board comose muestra en la figura:

[ES

£ Diodes
[_] Audio -
[Z Optoelectronic
(23 3mm LEDs (Miniature)
(21 5mm LEDs (Standard)
2 8mm LEDs (Large)
(23 10mm LEDs (Extra Large)
[Z LED Displays
[Z1 Electromagnetic
[_1 Relays
# Off-Board Components
(L1 Power Supplies - -
[ Input Components & Circuit Symbols

. File Edit View | Project Window Help

|2

» Run F9
1}

|—..'.'.:

Simulation

e[k OQX |/ W0~ mma -

| faeo g wemssy @

(2 Switches

(2 Sensors
(L Passive Components
(21 Discrete Semiconductors
[ZJ Output Components

21 Audio

1l PCB Compoenents

& Test Equipment

A" Add Probe F5

Input Components
Passive Components
Discrete Semiconductors

AA Battery (1.5V)
AAA Battery (1.5V)

2 x AA Battery with Clip (3V)

3 x AA Battery with Clip (4.5V)
Folder

Draw
Author

[Z3 Optoelectronic Output Components

23 Mumination

[Z3 3mm LEDs (Miniature)

(23 5mm LEDs (Standard)

2 8mm LEDs (Large)

(23 10mm LEDs (Extra Large) W
[+ ]

PP3 Battery with Clip (3V)

Options...

Agregaremos la bateria de 9v z la tecla on/off.

|£3 File Edit View Project Window Help

i (=]
DE@ & @ o]y oo [EOQAX| AL e~ mmaad- e
[~ - ¥
_||a Switches = @
Push Switches = E
—_— 2
- 3
i Push to Make Switch j
Red o
£
-

Push to Break Switch
Black

Latching Switches

4 SPST Toagqle Switch
Lﬁ SPOT Toagle Switch
{ SPOT Toaale Suitch
u Cenre-Off
Lﬂ DPDT Togdle Switch

« ¥ |, Circuit Diagram }, PCB Layout  PCB Layout2 /, PCB Layout 3 /, PCB Layout4 /| PCB Layout 5  Bill of Mai| « | |
Press F1 for help

o

-1 177,57 mm

DPDT Toqale Switch
o a—_|

|E7A Graphic Foreground - m [ 150% | Ready

04:47 p.m.
03/04/2018

Luego seleccionaremos uno de los pines de la bateria y lo arrastraremos hasta el terminal block que esta en la
PCB, lo mismo aremos con la tecla.
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Ya con los componentes conectados,
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Simulando el PCB

Ya con la PCB terminada y los componentes externos conectados podemos proceder a la simulacion.
En la figura se ve el circuito completo. Usted puede ver cédmo trabaja sin necesidad de armarlo fisicamente.
Para “simular el funcionamiento” presione el botén “Run” de la parte superior de la barra de herramientas

para simular su circuito.

&3 File Edit View Project Window Help

e E & @ N EAX Al Lo B M e - @

* Run
Simulate the active circuit. (F3)

spra]1B0] MOLJ BN plIoRd (2 | ey

2oy pajgndodun  jlomay

Puede chequear que su circuito esta funcionando haciendo clic en el switch. Esto dejara pasar o no corriente
por el circuito.

Ver I'f'i'g'ura 42 y 43 del apéndice de ejercitacion de inglés.

Investigue qué sucede con el LED cuando cambia el valor de la resistencia.
Haga clic con el mouse sobre el LED, aparecera un recuadro que exhibe las lecturas de la corriente (A para
ampere) y la potencia desarrollada por el elemento (W para watt), tal como lo especifica en la siguiente figura.
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| Red LED
(PCE Component)

Current = 8,26m#A (amps)
Power = 6,85mW (watts)

Nota:

Pruebe esto con el LED encendido y apagado y note los valores para cada momento. Vera que la corriente del
LED encendido es de 8,26mAYy que el LED esta apagado cuando no hay corriente.

Luego, posicione el mouse sobre una de las pistas de su circuito, aparecerd un recuadro que le indica el
voltaje y la corriente de esa union en particular (la tensién especificada se toma con respecto al terminal
especificado como masa).

Podre ver el circuito simulado con las diferentes vistas o estilos.

|£) File Edit View Project Window Help == x|
D@ tea]oc, v a[Foax]| sl e~ mmaui-|&ale]

S S S S S S S S :;I k|
= Ia Switches j &
3 :

Push Switches =l g
< Normal - i
Displays the circuit using the . )
P g pemese @
[»]
3 :
| :
o |
2 Push to Break Switch
Black
—
5
=
A
z Latching Switches
@ ot
: { o
2 SPST Toadle Switch
S
= |8
E]
=1
2 | (
s SPOT Toggle Switch
i (-
E IR TRt N . B BNt - FHESISI BSOS  FISSPIOIEN  SHSIOIIN SRS I RIS S IR! PSR SRS
SO R el R R e T TR T ST T
e ( SPOT Toqgle Switch
......... | l ==
""""" ( DPDT Toagle Switch
e 4 DPDT Toggle Switch
_>l_I v El

Time: [ 87,5385 |3 300%

< W ) o

| Ready
05:18 p.m.

03/04/2018
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IQ File Edit View Project Window Help

Ded|@ % BmRo],

s
x

I T L Lt

i 2 e

=z [&as |

& witches =

3 L J

S =1}

Push Switches |2

g _— a

g &

= =

£ ¥

= Push to Make Switch &
. P Red o

o o

5| RealWorld : z

@

7 | Shows the board as it will appear

when professicnally
manufactured.

Push to Break Switch
Black

e

Latching Switches

SPST Toaale Switch

SPOT Togale Switch

= auop | pejeindodupy ompy  spsal abo] mo

SPOT Toggle Switch
Centre-Off

DPDT Toggle Switch

DPDT Toggle Switch
Fa——r-3 LI
Select this style of display Time: [94521s [} 300% | Ready

|3 File Edit View Project Window Help == x|
Ded& s ma o) 1 aEOQX /i[Lo~mmaus5

= R Bl - E|
: _IIE Switches j @

Push Switches = g

—_— o

‘ 5

i Push to Make Switch -]

Red o

[

Push to Break Switch

e

Latching Switches

SPST Toaale Switch

SPOT Togale Switch

T | pazeindodun spoaqy  sjaa] B0 ol IuBLng | PUOAL [EEY  [BULLION

SPOT Toggle Switch
Centre-Off

DPDT Toggle Switch

Circuit Diagram }, PCB Layout { PCE Layout 2 / PCB Layout 3 /| PCB Layout4 /| PCE Layout 5 / Bill of Mal | 4 3

DPDT Toggle Switch
Fa——r-3 LI
ess F1 for help Voltage: -5 s (0 meseesssn| <5 Time:[106,749s (3 300% | Ready

< @0 T %l

Ver Figura 44 del apéndice de ejercitaciéon de inglés.

Si la corriente fluye a través del conductor, vera que aparecera una flecha junto al cursor, la cual le indicara la
direccion del flujo de corriente actual.
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| Copper Track
‘| Voltage = 8,80V [volts) :
‘| Current = 35,66mA (amps) |

Configurando las opciones de simulacion

La configuracion se realiza de la misma manera que la realizamos para el circuito esquematico, solo que:
e Tendremos los componentes externos y los componentes ya en sus encapsulados.
e Tendremos habilitada la opcién Add PCB Ground que nos permitird agregarle una conexion a tierra o
masa a la plaqueta.
e Tendremos deshabilitada la opcion Power Supply ya que la fuente de alimentacion ya esta en la PCB.
&

£) File Edit View | Project Window Help

DeHE & » Run P A X

v Explosions
| m1 pee Components » Faults
| # Off-Board »| v Bounce

| €3 Test Equipment  » Slow Motion
: v Back EMF

| 7 AddProbe  F5

Add PCB Ground E
Folder 3 |

D 3 j
rew Timing Centrol... r
Author [ S— :

spral nBo  mopdIuelUnD  pUopL [ERY (BLLIOp

Options... ‘

Por esta razon solo explicaremos las opciones nuevas y algunas de las que se diferencian mucho a su
version en circuito esquematico.

Habilitando las destruccion de los componentes por exceso
de sus rangos maximos (voltaje, amperaje, potencia,

etc.).

Ya vimos como armar los esquemas circuitales, y como probar si funcionan, entonces ahora que sabemos que
el proyecto anda perfectamente: ¢ podemos crear la placa de circuito impreso?

La respuesta a esta pregunta es “aun no podemos” ya que hemos simulado el circuito utilizando componentes
ideales o si pudimos encontrar el componente real por ejemplo diodo rectificador 1N4001, pero para simular el
circuito acercandonos mas a la realidad necesitamos cumplir con los siguientes pasos:
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e) Tener el circuito PCB completo. a ? =
f) Tener seleccionados los componentes a utilizar con sus valores de potencia, encapsulados, etc.

g) Habilitar en el simulador la destruccion por exceder los rangos maximos del componente.
h) Simular el circuito teniendo todo lo anteriormente mencionado.

Tener el circuito PCB completo.

Tener seleccionados los componentes a utilizar con sus valores de potencia, encapsulados,
etc.

Seleccionamos las caracteristicas de la bateria a usar o fuente de alimentacion, resistor, etc. como ya
vimos anteriormente.

Number: B 1 J oK i
- | ‘ = il Mumber:
27Tl Caption: Cancel

Help

| Caption:

value:

Habilitar en el simulador la destruccion por exceder los rangos maximos del componente.
Para ello deberemos ir a "Projet" nos abrira un menu desplegable, elegiremos la opcion "Simulation"
y por ultimo la opcién "Explosions" y con esto ya hemos habilitado esa opcion y podemos simular con
la mayoria de los parametros habilitados como se puede ver en la siguiente imagen.
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w "Project Window Help
[

e

|4 vRan BNy [ gl

max|,

11l PCB Components » Faults

# Off-Board » Bounce
Q Test Equipment  » Slow Motion
| v Back EMF

# AddProbe F5 |

Folder »
Q%. Power Supply...
Draw 3 _
Timing Contraol... —
Author
Ri R
Options... 1® ¢ 1

" Ver Figura 45 del apéndice de ejercitacion de inglés.

Simular el circuito teniendo todo lo anteriormente mencionado.

Simulacién _sin _habilitar las “EXPLOSIONS”: NoOtese que en la siguiente imagen tenemos la
simulacién de un circuito en el cual el diodo led “D1” esté en serie a una resistencia R1 de 10 OHM vy
no se quema lo cual sabemos que es ilogico.

i

Simulacién habilitando las “EXPLOSIONS”: NOtese que en la siguiente imagen tenemos la
simulacion de un circuito en el cual el diodo led “D1” esta en serie a una resistencia R1 de 10 OHM vy
el led “D1” se quema lo cual sabemos que es lo que sucederia si montaramos ese circuito realmente.
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. o . . P

Notese que si nos posicionamos sobre el componente que se destruyo nos habrira un cuado de di#logo’,
como se ve en la imagen siguiente, que nos indicara porque se destruyo dicho componente lo cual nos
facilitara la correccion y del circuito.

:| Red LED
.| (PCE Component)
—f| This compaonent has been
A destroyed.
Forward current of 44, 21mA

Ver Figura 46 del apéndice de ejercitacion de inglés.

Agregando al PCB un Ground

Si seleccionamos esta opcidn nos entregara el icono de tierra 0 masa para que lo insertemos en la pcb y de
esta manera agregarle esta opciéon que como todos sabemos, muchas veces usamos para eliminar corrientes
parasitas en el Cooper area (area de cobre), interferencias en telecomunicaciones, etc.

File Edit View | Project Window Help

IS P lal[h@a x|/

e CuleM
Do v Explosions
oo nl PCE Components Faults
i # Off-Board b ||+ Bounce
U BT Test Equipment  » Slow Motion

EREERE Back EMF
D 7 AddProbe  F5 |0

Add PCB Ground -
Folder 3 ¥

Drraw
Author

- 5 §
Options... ‘ ‘

Timing Centrol...
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Ver Figura 47 del apéndice de ejercitacion de inglés.

Usando los Instrumentos en la Simulacion de Circuitos

Utilizaremos el PCB hecho anteriormente y lo analizaremos con los distintos instrumentos que nos provee el
programa en su version PCB.

Simulando un PCB con el osciloscopio digital

Utilizaremos el PCB visto anteriormente y lo analizaremos con él osciloscopio.
Para poder buscar los instrumentos que disponemos en el programa, vamos a la galeria y hacemos un clic.

Inmediatamente aparece la galeria. Dentro de ella, en la parte Virtual Instruments se encuentran los
instrumentos de medicion.

L. i
|a Yirtual Instrurments j ‘
Virtual Instruments J g
=
— &
% Digital Multimeter =
8]
o
T
o
P i .
S Dsdlloscope
? .h.i'_. Function Generator

DC Power Supply

Sacamos el osciloscopio, de la misma manera que sacdbamos los componentes hacia la mesa de trabajo.

Una vez que sacamos el osciloscopio, podemos cerrar la ventana de la galeria para tener mas campo de
vision en nuestra pantalla.

El osciloscopio graba niveles de voltajes sobre un determinado periodo de tiempo.
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Veremos que contiene todos las funciones y botones de un osciloscopio genérico y si nos posiélondmosisobre 1 i
alguno de estos botones nos aparecera un cuadro de dialogo que nos dara una breve descripcion.

Normalmente, el lado positivo es unido a la sefial a medir y el lado negativo a 0 volts.

El voltaje que se lee es calculado como la diferencia de potencial entre las terminales positivas y negativas.
Comenzamos entonces conectando la terminal negativa del canal 1 a 0 volts. Y luego la terminal positiva del
mismo canal a la salida del leds D1, donde deberiamos obtener una sefial de menos de 9v cuando activemos

el interruptor y de Ov cuando lo desactivemos.
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Debemos luego, hacer un clic sobre el osciloscopio con el boton derecho del mouse y nos apar@ceré la®pcion i
para resetear el instrumento (Reset Instrument).

gﬁ
ofs

% Cut Ctrl+X
Copy Ctrl+C
W Delete Del

g Beset Instrument

1 Arrange 3 .
Para visualizar la animacion presionamos sobre Run en la barra de herramientas, encendemos el circuito a

través de la llave de encendido y encendemos el osciloscopio, para ver cdmo el osciloscopio ya nos muestra

la sefial de salida.
|""2- "‘-.f""\"-l.f'gll-l'-'1 TN W caax T h I.ll:...ﬂll.“'-'l

1S/Division
horizontal

5V/Division
vertical

ChA: 5V/Div
ChB: 5V/Div Time: 15/Div

Dual Channel Oscilloscope O5C-101

Ver Figura 48 del apéndice de ejercitacion de inglés.

Podemos observar que en la esquina inferior izquierda nos indica que el CANAL A:
e CHA: 5VIDiv que nos indica que la escala seria de 5voltios por division vertical.
¢ Time: 1 SIDiv que nos indica que la escala de tiempo es 1 segundo por divisién horizontal.
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Observar que la pantalla del osciloscopio esta dividida en una cuadricula &t & 40
Vemos que el voltaje que le llega al led “D6” estd comprendido entre 0 y es menor a 5voltios.
Pero podemos ver con exactitud en el osciloscopio qué valor tiene ya que la escala de voltaje no me permite
apreciarlo. Para solucionar esto debemos ir a la zona de configuracion del canal A donde nos permitira ajustar
parametros como:

e Tipo de corriente que estoy midiendo.

e Configuracion de voltaje por division.

e Desplazamiento vertical del canal A respecto al punto medio.

Como vemos en la siguiente imagen:

LT

Channel A: 3V/Div
Drag to change the setting.

Channel A Mode
Drag to change the setting.

L =y By B e e e n

También podemos modificar la base de tiempo como se ve en la siguiente imggen:
|l

I VIrtual inswrur

Como podemos observar, es posible ajustar la tension maxima y minima de medicién, la base de tiempo y el
para cada canal. Con esto tenemos la posibilidad de realizar una mejor medicion.

Vemos en la siguiente imagen que configuramos la division de voltaje vertical en 1VIDiv , esto nos permite
apreciar que la tension del led “D6” es de aproximadamente 2 divisiones, es decir 2 voltios.

Virtual Instrum

=

=
mEs o
Time: 15/Div

- F
Drag to change the setting. =

L]

ER=1{

oee
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i 2 | @]

QX | A0 W m el

ChA: 1W/Div
ChB: 5VIDiv Time: 13/Div

Channel A: 1V/Div
Drag te change the setting.

| Dual Channel Cscilloscope QsC-101

Mas funciones de los botones del osciloscopio
Vemos en la siguiente imagen los botones y conectores que trae el osciloscopio.
Dual Channel Oscilloscope 0sC-10

| 1
|

Veremos a continuaciéon que funcion cumplen cada uno de ellos:

e POWER: enciende 0 apaga el osciloscopio.

¢ DISP: muestra en la pantalla que estaca tenemos de voltaje/division del canal Ay el B, ademas del
tiempo/division.

e XY: cuando se presionan los interruptores del uso de CH A como el eje Xy CH B como el eje Y. TIME /
DIV se ignora en este modo.

¢ TRG: cuando se presiona habilita las funciones de disparo que le permiten sincronizar la pantalla de
traza con una forma de onda de entrada.

e POS: determina la posicién horizontal de la traza de salida.
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e LEV: determina la posicién del nivel de activacién donde O representa la tension de actifacién minima,
1 la tension de activaciéon maxima y 0,5 el punto medio (predeterminado) entre los dos.

e +/-: controla la pendiente del gatillo. Cuando se presiona, se dispara en el borde descendente de la
entrada del disparador en lugar del borde ascendente.

e CH A/ CH Bl EXT (trigger Mode): determina qué entrada se usa como la sefial de disparo. Cuando se
selecciona EXT, el terminal EXT TRIG se usa para la seial de disparo.

e CH Al CH B/ DUAL (vertical Mode): determina qué trazas de salida se muestran, ya sea solo CH A,
solo CH B o ambas trazas juntas.

e VIDIV: controla el nimero de voltios por division vertical de la pantalla para la entrada CH Ao CH B.

e AC/ GNDI DC (Mode): determina el acoplamiento de sefial para CH A o CH B. DC pasa la sefial
intacta; AC usa un filtro para pasar solo la sefial de CA; GND desconecta por completo la entrada.

e POS: ajuste vertical para el canal CH Ao CH B.

e CH A: CH Aterminal de entrada. Se convierte en la coordenada Y cuando esta en modo XY.

e CH B: CH B terminal de entrada. Se convierte en la coordenada Y cuando estd en modo XY.

e GND: terminal de tierra comun.

e TIMEIDIV: proporciona la configuracion del barrido de trazas, que controla el nimero de divisiones
horizontales trazadas durante el periodo de tiempo establecido.

e EX TRIG: entrada de disparador externa utilizada cuando el modo de disparo esta configurado en EXT.

Ver Figura 49 del apéndice de ejercitacién de inglés.

Simulando un circuito con el Multimetro digital

Como vemos en la imagen tiene las mismas funciones, disposicion de selector de escala y de terminales de
conexion; que tiene un multimetro convencional y para usarlo se debe proceder de la misma manera.
f= | == == ™ |

DMM-101

VmACQ COM 10ADC

Profesor Palacios José Emanuel Pagina 83



_ ! 1
. . . e, Ko
Manual de Circuit Wizard 1.5 f S SIe .
Midiendo voltaje a P & &
Accione nuevamente la galeria en la parte Virtual Instruments y seleccione el multimetro digital como muestra

la figura, de la misma manera que procedimos con el osciloscopio.
Recuerde que para medir voltaje debemos conectarlo en paralelo al componente que deseemos medir.

DMM-101

VmAQ COM 10ADC

Lo conectamos como muestra la figura, el negativo a 0 volts y el positivo del multimetro Al &nodo del led D1,
para ver la tension de salida.

Configuramos la llave selectora para el voltaje que deseemos medir.

Damos comienzo a la simulacion apretando Run y cerrando la llave de encendido. Vemos que el circuito
oscila, si esta el led alimentado 1,96voltios, y cuando no esta alimentado la tension en la salida es de casi

Ovolts.

DMM-101

VmAQ COM 10ADC
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Midiendo amperaje A & o

Accione nuevamente la galeria en la parte Virtual Instruments y seleccione el multimetro digital como muestra
la figura, de la misma manera que procedimos con el osciloscopio.

Configuramos la llave selectora para el amperaje que deseemos medir.

Recuerde que para medir amperaje debemos conectarlo en serie al componente que deseemos medir.

rrent Flow

the flow of electrical
tin the circuit,

VmAQ COM 10ADC

Damos comienzo a la simulacion apretando Run y cerrando la llave de encendido. Vemos que el circuito
oscila, dando si esta teniendo una “Current= 27,5 m A (amps)”.

Midiendo resistencia

Accione nuevamente la galeria en la parte Virtual Instruments y seleccione el multimetro digital como muestra
la figura, de la misma manera que procedimos con el osciloscopio.

Recuerde que para medir resistencia debemos conectarlo en paralelo al componente que deseemos medir y
deberé estar sin alimentacion el circuito.

DMM-101

VmAQ COM 10ADC

Ver Figura 50 del apéndice de ejercitacion de inglés.
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A a
Simulando un circuito con la fuente de alimentacion de
laboratorio

Sacamos la fuente de alimentacion, de la misma manera que sacdbamos los componentes hacia la mesa de
trabajo.

Una vez que sacamos la fuente de alimentacion, podemos cerrar la ventana de la galeria para tener mas
campo de vision en nuestra pantalla.

Veremos que contiene todos las funciones y botones de un que una fuente de alimentaciéon de laboratorio
genérica y si nos posicionamos sobre alguno de estos botones nos aparecera un cuadro de dialogo que nos
dara una breve descripcion.

— VOLTAGE —— DISPLAY —
5V “lvoLTs @

AMPS @

Click to change the setting, Hold
down Shift for direct control.

POWER + -

Comenzamos entonces conectando la terminal negativa de la fuente a la bornera de PCB la negativa. Y luego
la terminal positiva de la fuente a la bornera de la PCB positiva.

E— L]

r— VOLTAGE —1— DISPLAY —

5V . ol voLts @ il
12v N Anps @

& R — | Hino

POWER

L

® on

|
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Luego seleccionamos en el cuadro VOLTAGE que tiene un botén deslizable con 3 opciones:
e 5V: entrega 5v de corriente continua.
e 12v: entrega 12 v de corriente continua.
¢ VAR: entrega una tensién variable de 0 a 30v de corriente continua y se calibra con la perilla que esta
a su derecha.
Calibramos la fuente para que entregue 9 voltios como se ve a continuacion.

— VOLTAGE —1r— DISPLAY —

5V . = voLts #
12v AMPs @
SfAR | HILO

Ahora ya podemos simular y encender la fuente de alimentacion apretando el boton POWER.
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I

r— VOLTAGE —1r— DISPLAY —

BV X Ba vOoLTS @
v MIPS P
myrR — W Hio tB2 :
POWER + -
L.
o @&

Power

Click to turn this instrument on or
off.

Ya tenemos el circuito alimentado adecuadamente. Podemos a continuacion seleccionar en el cuadro.
e DISPLAY: que tiene un boton deslizable con 2 opciones:
e VOLTS: para visualizar en el display el voltaje que envia la fuente de alimentacion.
e AMPS: para visualizar el amperaje que esta entregando la fuente de alimentacién.
e HI/ILO: este boton se usa cuando estamos visualizando el amperaje que entrega la fuente de
alimentacion y lo que hace es correr la coma de lugar para mostrar mas numeros después de la coma

y asi visualizar con mayor exactitud el amperaje que entrega la fuente.
A continuacién vemos la visualizacién en el display el voltaje que entrega la fuente de alimentacion.

T

— VOLTAGE —1r— DISPLAY —
5V ol VOLTS &
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A continuacién vemos la visualizacion en el display el amperaje con mayor o menor precision fyue entiega la
fuente de alimentacién. Podemos observar que con menor precision la fuente nos muestra en el display que
entrega 0.03 Ay von mayor precisiébn nos muestra que entrega 0,028 A.

r— VOLTAGE —1r— DISPLAY —

-]
1

By N | voLTs - — VOLTAGE —1r— DISPLAY :
12 & pgmes @ 5V . | voLTs
SR — - W Hio |12V Y opmiaes @
AR — A HILo
POWER + _
L POWER + _
|
2
—— ———
| |

Ver Figura 51 del apéndice de ejercitacién de inglés.

Simulando un circuito con puntas de prueba

Podremos agregar unas puntas de prueba que mediran voltaje respeto a masa (0v), se pueden insertar tantas
puntas de pruebas como queramos, en la imagen siguiente usaremos tres para analizar la dltima rama del
circuito.

s[@AR 21007 moj{uaung | PHOAY [EEY  |EW
Fragune™ E b

A X | Al g

pajendodup  losmgy

«

Volttage []
= w @ W

'ress F1 for help

Podremos ver en la imagen anterior la conexiéon de las puntas de prueba en el circuito y su grafica
correspondiente debajo con un color diferente para cada punta de prueba. Esta grafica se puede modificar
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para tener una escala mas adecuada de la misma manera que modificamos el grafico Para® utifizar el
osciloscopio.

(|

Ver Figura 52 del apéndice de ejercitaciéon de inglés.

Simulando un circuito con el Generador de funciones

Podremos agregar este instrumento que entrega diferentes tipos de voltajes y tipo de corrientes. Es decir que
es capaz de entregar una corriente alterna senoidal de 10 voltios con una frecuencia de 60 Hertz; también

podemos generar una onda cuadrada, triangular, etc.

.
1M 100k 10k 1k 100 10 1
ol e e e e e
20dB ADJ Ny e JL cMos
ol _| | ol

POWER GND FREQ AMPL OFFS DUTY LEVEL-— LOGICJ
—

#® oN . . \-/ \./ \./ \./ st @
| ] | ]

Comenzamos entonces conectando la terminal GND de la fuente a la bornera de PCB la negativa. Y luego la
terminal OUT de la fuente a la bornera de la PCB positiva.

M 10K & k10 10 1

ol e e e e

2008 AR T e T Comos

ol el W ] el _IJ 3

FOWER ouT GND FREQ AMPL OFFS DUTY LEVEL - LOGIC :-
e + + +
* o W OUY v @ I—J

Si vamos a la perilla FREQ: podremos calibrar la frecuencia de salida entre 0,3y 3 HZ.
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1 10K 1 1k 100 10 1
ol bl b A e el
-200S ADJ Sy M L cwos

S _IJ

FOWER ©OUT GND FREQ s Tomms o' e - e

I__ + + +

* on o DU W@

] I
Frequency

0.3 3

T

Para completar la seleccién de la frecuencia tendremos complementariamente los botones 1M, 100K, 10K,
1K,100, 10, 1. Por defecto arranca seleccionado el boton “1” que nos indica que la frecuencia que nos
entregara el generador de funciones sera la que elegimos con la perilla FREQ que va a estar multiplicada por
1M, es decir:

Frecuencia= 0,3x1000000
Frecuencia=300000 Hz

O como nos muestra el instrumento en la siguiente figura 300,00 KHz
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' ook 10k 1k 100 10 1
- N N N NN
-20dB ADJ Ny e L emos

ol el oL JJ

POWER OUT GND FREQ AMPL OFFS DUTY LEVEL — LOGIC
o /I UVY U@
||

Si vamos a la perilla AMP: podremos calibrar la amplitud de salida entre 0,1y 10 v.

1
1M 10k 1k 1 100 13 1
-y yryry
2008 a0 T\ N L cmecs
el el W O el 4}
FOWER  OUT GND FREQ A loFFs DUTY

I

LEVEL — LOGIC
e + - -
. o o WO W@
| | | |

Amplitude

Profesor Palacios José Emanuel Pagina 92



Manual de Circuit Wizard 1.5 |

También tendremos tres botones con la forma de onda senoidal, triangular y cuadrada quefhos?pefitiran @
seleccionar entre estas ondas de salida como vemos en la siguiente imagen:
Onda senoidal:

M ok 1k fk 100 10 1
ol e e e e
2008 ADY N A TL cmos

ol b W oA JJ =
FOWER  OUT  GND FREQ apL 'oFFs DUTY A LEVEL - LoGIC L
C ] .
e R W 0 N R W I
F— Click to active this function. | .
¢ o
!
ny
-
» ' Circuit Diagram }, PCB Layout | PCE Layout 2 /| PCB Layout3 /| PCB | 4| | v
8
% AN
0
4J \/ \/
Bl 1 1 1 1 1 1 1 1 1 1
0 2 4 6 2 10 12 14 16 18 20
Time [z]
for help Voltage: -5 I 0 .
Onda triangular:
™otox 1 o 10 1@ 1
ol S e e e e .
2048 ADJ P M T ocwos
S JJ = |
FOWER  OUT  GND FREQ aveL orrs ooty LEREL o
o
& ON

ooooo

Triangle Wave
Click to active this function. | -

b\, Circuit Diagram }, PCB Layout | PCB Layout 2 /; PCB Layout 3 /| PCB [ 4 | |

8
: :*\ /\ A
0
. J \/ \/ \
-& 1 1 1 1
0 2 4 ] 8 10 12 14 16 18 20
Time [s]

I
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Onda cuadrada:
10 1k k100 10 1
2008 ADY T N 1 cmos
ol

N J“| a

POWER OUT GND FREQ AMPL OFFS DUTY LEVEL -[\OGIC

Click to active this functior

;\ Circuit Diagram ;\ PCB I.aycut,r{ PCB Layout 2 /{l PCB Layout EA PCB i

B q
4 4
0
-4 4
-8 1 1 1 1 1 1 1 1 1 1

0 s 4 1 8 10 12 14 16 18 20

Time [s]

fooLoio L — £ n

Tendremos el boton CMOS: Determina la salida del terminal LOGIC. Cuando se presiona, LOGIC
proporcionara una salida CMOS, de lo contrario sera una salida TTL (fija de 5 voltios). En el modo CMOS, la
salida de voltaje esta determinada por la perilla LEVEL, tal cual se ve en la imagen.

i 10k 1k 1k 100 10 1
ol e e e e e
2088 A N N 1 cmos
Sefial TTL _| =N N 1
fija de POWER GMD FREQ AMIEL .;;:.--'L DUTY LEVEL — LOGIC I '-I | (
5voltios 4 o o TTL/CMOS Logic Mode
Click to active this function.
{ea 1| t
{ P o
Sefial \ e—— | i;v |
CMOS fija
de 9 voltios ?
e e e
« + '\, Circuit Diagram }, PCB Layout { PCB Layout2 /i PCB Layout3 /| PCB | « | LH
10 X 4
5
I:I T T T T T T T T T T
0 2 4 [+ & 10 12 14 18 13 20 22

Time =]
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El bot6n -20dB: reduce la salida de voltaje en 20db se usa junto al boton ADJ.

POWER: ouT GHND FREQ L LEVEL — _C-S:J
L -
* ox -20dB Attenuation
F— Click to actrve this function,
I n
i 10k 1k 1k 100 10 1
ol bl e ] e e
2008 ADJ T M 1 cmos
[ N | ol I ol
POWER ouT GND FREQ AMPL OFFS DUTY LEVEL — _OS:J
W OWww W@
|
Senal sin

Senal

atenuar atenuada \
-20db

| Circuit Diagram ), PCB Layout [ PCB Layout 2\,{ PCE Layout 3 / PCE |4 |

. v

4 }

u (/‘L
. J
Eil 1 i i i 1 1 1 1 i

0 2 4 6 8 10 12 14 16 1
Time [g]
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El boton ADJ: Permite el ajuste de la forma de onda usando el control OFFS y DUTY. Cuandofo Se piesiona
ADJ, se ignoran los botones OFF y DUTY y se produce una forma de onda normal.

-]

El boton OFFS: cuando ADJ presiona determina el desplazamiento de la forma de onda relativa a la terminal
GND.

| =~ |
FOWER OUT GND FREQ Al OFFS DUTY _5\;5___6:_3J H
L .
~ e e . & oN Net = N e @ u
Sefial inicial
I I
~ Offset
Sefial con \ - po
corrimiento de Ty
Offset \ . ?
O —r =
-1.0. .LD
7,8 :‘ v
Circuit Diagram }, PCB Layout /| PCB Layout 2 | PCB Layout3 /, PCBM | I

Senal inicial POWER

e

Sefial con \ Ny
corrimiento de
Duty Cycle \{__/ —
20 80
Pr20 =%
Circuit Diafram }, PCB Layout /{ PCB Layout 2 /| PCE Layout 3 /| pcw 1 |

I
e e
B

Ver Figura 53 del apéndice de ejercitacion de inglés.
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Dibujando circuitos sin PCB y en Protoboard motorés, efc.

Podremos agregar componentes externos a la PCB y asi realizar conexiones externas al PCB, también
podremos utilizar la protoboard y de esta manera simular las conexiones externas de la plaqueta.
A continuacién veremos algunas imagenes con conexiones fuera de la PCB y protoboard.

abcde
1 EWEREEW
LA B A g
TFEETW
LA B a3
EWWWWW
WEEE W

WEEEW
WEEEW
VTV TW
FEEEw
FEEEw
WEEEW
WEEEW
IFWWWWW
WEEEW
WEEEW
WEEEw
WEEEw
VW ETVW
WEEEW
WEEEW

L e A i

=

fghil]j
WEW AW
W
WEWE L
W LEE W
rrarrs

| TEHYY W

WEEWEW
WEEWEW
WWWWWI0
FEEEW
FEEEw
WEEEW
WEEEW
WWWWWI5
WEEEW
WEEEW
WEEEw
WEEEw
V¥V
WEEEW
WEEWEW
WEEEw

i
i
§
i
o

L5V

2 x AA Battery with Clip
3y

3 x AA Battery with Clip
4,5V

PP 3 Battery with Clip
E

Ia Power Supplies j
Power Su ppﬁe.s _I
AA Battery
1.5V
AAA Battery

| fees @ wesesy §
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Podremos agregar también componentes electromecanicos como motores, relays, etc y si hacémo$ dolle clic ?
sobre el componente podremos definir sus propiedades de trabajo.
= £l
Ia Electrormagnetic j »

] w Bevel Gear
L Connected to DC Mator;
ol Side View

o1 —
' Worm Gear
'__l #m Connected 1o DC Maoton
Side View
T —

| faes g wesssy §

Mumber: Wheel
Connected to CC Motor;
Plan View

Caption:

Model:
. 2 Blade Propeller
: 3 e M Connected to DC Motor;
Speed: - Plan View

Gearbox:

3 Blade Propeller
‘Connected to DC Maotor;
Plan Wiew

d A
\}-_-#' -
: Simple Gear Train
Connected to DC Motor;
Plan Wiew

Mechanism:

Compound Gear Train
Connected to CC Motor;
Plan View

Ver Figura 54 y 55 del apéndice de ejercitacion de inglés.
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Mas opciones al Dibujar PCB

Podremos configurar mas opciones al dibujar manualmente la pcb para ello tenemos dos opciones para
editarlas:
Yendo al icono de autorruteo como vemos en la siguiente imagen.

Help
NN SR BT reersN s
I'Eil Route All Mets E
Foute Selected Mets (
Selected 3
E |T Interactive Routing
L] Setfings...
_i ings. L
Unroute Mets
JJ_ y Unroute All Nets |
gy SERE— r Auto Unroute U
BB e ~ Checklntegrlty |
— T
= 1 Insert Met
|T Lock Mets
al Optimize Mets
E r S
i v Auto Optimize
I I -

O haciendo clic derecho sobre el PCB y elegir la opcion Routing como vemos en la imagen siguiente.

—
i
. —- i | B
1
En T
W
| Si
e et
'_""'""."""“""" & Cut  Ctr+X
Copy Ctrl+C W
'X Delete Del {F:JI
I I Shape oute Selected MNets
= — Arrange 3 ) - <
K\ : |7 Interactive Routing EJI
. Settings...
an L]
B Unroute Mets
Unroute All Nets 3
=
|7—--'-: JNroute Fl
Check Integrity
Insert Met ki
- |7I=ock Mets c
e | H " Fl
Optimize Mets
|T Auto Optimize
T X’ c
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Aqui tenemos diferentes opciones de disefio para seleccionar, algunas de ellas estan bloquéadas ségun ‘el
tipo de disefio en el que estemos trabajando:

e Route all nets: enrutara (convertird en pistas) automaticamente todas las conexiones de red (que se
muestra linea verde fina que no es pista).

¢ Route selected nets:(convertira en pistas) automaticamente todas las conexiones de red (que se muestra
linea verde fina que no es pista), pero utilizando solo las redes que estan actualmente seleccionadas.

e Interactive routing: cuando esté habilitado, realizara el proceso de enrutamiento automético a medida
gue los componentes se muevan en un circuito, pero solo si estan dentro del &rea de PCB.

e Settings: despliega una ventana adonde podemos elegir el tipo de pista que se generara, una faz, doble
faz, pistas gruesas, finas, etc.

e Unroute Nets: Desenruta pistas (solo para los objetos seleccionados, si no hay un objeto seleccionado
aparece desbloqueada)

¢ Unroute all nets: Desenrutar todas las redes (para todas las pistas en el circuito).

e Auto unroute: Con el inicio de Interactive routing (ruta automatico) activado, las pistas enrutadas se
eliminaran y enrutaran automaticamente a medida que se muevan los componentes.

e Check integrity: realizard una verificacion para asegurarse de que las redes no se cambien
accidentalmente.

e Insert Net: Para agregar una conexion de red (que se muestra linea verde fina que no es pista).

e Lock Nets: A medida que se mueven los componentes, a menudo es posible romper o perder conexiones.
Para evitar esto, el Circuit Wizard ofrece la posibilidad de bloquear redes en su posiciéon. En este modo,
resulta imposible perder las conexiones de red y editar para que las conexiones permanezcan intactas.

e Para habilitar o deshabilitar el bloqueo de red, elija bloquear redes del mend.

e Optimize Net: optimiza las conexiones de las redes.

e Auto Optimize: Circuit wizard también ofrece la posibilidad de optimizar las redes automaticamente cada
vez que se mueven los componentes. Elija optimizar automaticamente desde el menu para habilitar o
deshabilitar la optimizacién automatica de la red (esta opcion esta habilitada por defecto).

Ver Figura 56 del apéndice de ejercitacion de inglés.
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Opciones para imprimir o exportar
Ahora que ya tenemos nuestro circuito PCB funcionando necesitamos poder pasar del disefio a la ejecucion
de la plaqueta fisica real, para ello necesitamos seguir los siguientes pasos:

e Configurar la pagina.

e Exportar a archivo de texto por capa por capa.

e Impresion directa desde el programa.

e Exportar a archivos de uso CAD/CAM.

Configurar la pagina

Necesitamos configurar la pagina para saber donde tenemos ubicada la PCB y la orientacion de la pagina.
Primero tendremos que seleccionar el tipo de vista de la hoja de trabajo yendo al mena View y seleccionar la
opcion Page Layout Preview y ubicar la plaqueta en la hoja o realizar varias copias en la hoja para imprimir
varias paginas a la vez.

|£3 File Edit | View Project Window Help

]DE’-‘-EH:I%W"' _— y 0w [REVQAK | S| L O~ m W e B2
‘age Layout Freview

GoTo

Toolbars

&R Gallery Ctrl+F2
[l Graph Ctrl+F5

Display
Animation

¥ Style

Co-ordinates
it Grid/Snap

Loom

- BIOY | paieindodun)  slowgry  sEea] 3160 o ualnn | PHOAY [EEY |ELIJJIIINI

ﬁ
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Podemos seleccionar el PCB y copiarlo y pagarlo varias veces en la hoja.

ooy e BEAX| AL 0 m W e a2

- 310y ‘ pajendodup  ylompy  sEea] 6o wopq quenny | PHOAY [EEY |EL.I.IJDN\.

Ahora deberemos ir al menu File y ele

TN DM D Del
Fe T e

Circuit Board
Size = 88,5 (W) x 35 (H) mm

Ver Figura 57 del apéndice de ejercitacién de inglés.

ir la opcion Page setup.

File Edit View Project Window Help
O Mew... Ctrl+N
& Open... Ctrl+0
i Close

wly  sj@aaT 1607 moj{usung | PHOAR [B2Y IEUJJONI o E)

Pl

I save Ctrl+5
Save As...

&5 Print »

CAD/CAM » !’.
gﬂ Send... I_I

Properties

1 FA\LAapunte circuit wizard.owz
2 G\ MInfant Toy.owz

3 G\ ADimmer Switch.owz

4 CALABulb Circuit.owz

Exit
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Se nos abrird una ventana donde podremos elegir dos subventanas la primera es: ad & 7 0
Page size: donde podremos elegir el tipo de hoja, orientacion de la hoja, margenes de impresion, escala de
impresion.

Page Size |Appearance |

Page Size:

width: |29? mm e R
4 " Portrait

Height: 210 mm {* Landscape

Margins

Left: Il.';',? mm Right: Il.'l,? mm

Top: |121? mm Bottom: |12,? mm

rPrinter Information

Samsung ML-2160 Series on USBO01
Paper Size: 279,4mm x 215,9 mm
Paper Orientation: Landscape

Print Setup. .. | Print Scale: [100 j %

Ver Figura 58 del apéndice de ejercitacion de inglés.

Y un botén Print Setup que al accionarlo nos abrir4 otra ventana adonde elegiremos la impresora a usar.

I Bevel Gear

Connected to DC Motor;
Side View

Page Setup

Page Size | Appearance I

Page Size: .
idths — Impresora
[ Height: TR | Samsung ML-2160 Series Propiedades.... |
e -
Lf Estado: Listo i
EI! : Tipa: Samsung ML-2160 Series

Ubicacion:  USBO01

Top: Comentario:
— Papel Orientacion
rPrinter Information P
fio: Vertical
Samsung ML-2160 Series Tamafio: ILetler LI ica
Paper Size: 27,1 Origen: — — & Horizontal
Paper Orientation: Lands ngen: ISEIBCC'“” automatica LI ELLE

Print Setup...

Aceptar I Cancelar

@ omgound Gear Tra
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Appereance: donde

podremos elegir el color de cada capa generales y de circuito PCB.

|ﬁ Electromagnetic

Page Setu B— Bevel Gear
. : 1 HB Caonnected to DC Mot
Side View

Page Size Appearance |

General

Background: |:|| Graph Axis:
Text Links: -I Graph Major:

Graph Minor:

&
=]
s
3
(=
1]

Asi

[¥]

EEENTTS

—PCE Layout

Solder Side: _I Circuit Board:
Component Side: -I Silk Screen:
Both Sides: I_ Drill Holes:

==

(on oon

EEEN]
EEEENEN
EEEET]
EN "HEEEEN
EN EEEENET
EE HEENET

Colores personalizados:

Definir colores personalizados »>

Aceptar Cancelar |

b
Q Compound Gear Tri

Ver Figura 59 del apéndice de ejercitacién de inglés.

Exportar a archivo de texto por capa por capa.
Tendremos dos opciones:

e Copiar y pegar (control ¢ control v).

e Exportar como imagen.

e Imprimir para hacer PCB o informe.

Copiar y pegar (control ¢ control v)

Lo que debemos hacer es muy simple, elegir el tipo de vista que deseamos copiar en el archivo de texto,
seleccionar lo que deseemos copiar, copiarlo y pegarlo en un archivo de texto.

ELEGIMOS EL TIPO DE VISTA:

|eLLLITp ‘

<! Normal

Displays the circuit using the
normal settings.

spaa oBo]  mopdueuny  pUoAL (e
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SELECCIONAMOS LO QUE DESEEMOS COPIAR:

COPIAMOS:
Con control c o con clic derecho/Copy.

n
& Cut Ctrl+ X

Copy Cirl+C
Del

> Delete
u u Routing b
Shape »
Arrange »
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PEGAMOS EN ARCIVO DE TEXTO:
Con control v o clic derecho/ pegar, segun

el editor de texto que estemos usando.
= a4

P L . Y = —_— LA
Con control v L - S
¥ | corta
-] -0rta
Opciones . ... 1 docu
Podremos [, oOpdones de pegado:
Manejo de A Fuente.
Podremos | =T Earafo..
1= Vifietas | »
L — . Archivo Inicio Insertar Dizefo di
i= Mumeracidn | » —
_& Estilos k l _ g Gl Times Mew Rom
——— [— = =3 Copiar
. i ; i 1 Pegar -
Profesor Palag % Hipervinculo « < Copiar formato N £ B
Buscar | 4 Portapapeles M|
Sindnimos » Pegar (Ctrl+V)
_ IEEE Traducir _ Pega el contenido del Portapapeles.
. - N = =
Acciones adicionales 3 | og é P
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Exportar como imagen

Configurando las opcion.. | |*

I NPT R P R (R ——

Lo que debemos hacer es muy simple, primero elegir el tipo de vista que vamos a exportar y luego seleccionar

el objeto o PCB a exportar.

|eLLLITp ‘

<! Normal

Displays the circuit using the
normal settings.

spaa] 01607 AMO|{JUBLIND  DLIOAY [Ba
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Luego vamos al menu Projet/ Draw/Copy AS /Bitmap como se muestra en la siguiente imagen §dluego pegarlo ? i
en una hoja de texto.

dit View | Project Window Help

|| & & »FRon Oy wl[k@QAX| /0L e~

|| Pause  Shift+Fd
[ m Stop Ctrl+Fg

Simulation *

# Circuit Symbols
1l PCB Compenents
A Off-Board

. i
|7 -IE]. Test Equipment

7 # AddProbe  F5

Folder

"3 From File...  Shift+Ctrl+G

Options... Metafile
- %, o Shift+ Ctrl+L

[ ] Rectangle  Shift+Ctrl+R
) Ellipse

™ Arc

 Chord

(% Freeform

% Scribble

Imprimir para hacer PCB o informe

Ahora que ya pudimos extraer como imagen o mapa de bit el circuito pcb veremos como debemos proceder
para pegar y posicionar la PCB segun el tipo de vista en el que estemos trabajando y para que nos sirve
(describir conexiones, imprimir pistas simple faz, doble faz, mascara de componentes, etc).

Vista normal

Se puede copiar con los componentes externos o sin ellos y nos servira para ver las conexiones externas, de

los componentes y al mismo tiempo de las pistas. Se puede agrandar y achicar la imagen sin ningun efecto
secundario.

= SEaEE
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Vista Real World

Se puede copiar con los componentes externos o sin ellos y nos servira para ver las conexiones externas, de
los componentes y al mismo tiempo tener una idea de como quedara la PCB cuando la fabriguemos. Se
puede agrandar y achicar la imagen sin ningin efecto secundario.

E |
+

L

| |

o

e | 1
=l
= gl
sl

Vista Current Flow y Logic Levels
Cuando se simula se puede observar los niveles de voltaje, el flujo de corriente, estado I6gico del circuito,etc,
pero no se puede copiar el circuito cuando se simula. Estas vistas son muy buenas a la hora de analizar y
describir el funcionamiento del circuito. La Gnica opcién que tenemos si queremos copiar el circuito mientras
se esta simulando es realizar una captura de pantalla, luego recortar, modificar el tamafio y la imagen segun la
necesidad, como vemos a continuacion.

|83 File Edit View Project Window Help
D@d|@ s =alcc|, nab QX i1 e mmiei-|in

&

i |ﬁ Electromagnetic |

Bevel Gear Electronica 4to

L]
Worm Gear &
‘Gonneed o DG Motors 5
Side View 2

2Blade Propeller
Connacted to DC Motor;
plan View

3 Blade Propeller

~alop | paeindoduny oty sEAa7 21607 mopd auedny | PUOAR [eay ‘gmmw
|

Compound Gear Train
Connacted to DC Motor;
Plan View

« v | Circuit Diagram J, PCB Layout | PCB Layout 2 /| PCB Layout 3 [ PCB [4 | _>|_I

Ider Gear
oo TP |
Press F1 for help Voltage: -5 0 m— 5 Time: (84935 [ 75%  |Ready |

@ ) c M ~ @0 E S
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il

Vista Artwork

Esta es una de las vistas mas importantes para poder realizar la PCB fisica real. Una vez que copiamos la
PCB con esta imagen no debemos modificar su tamafio. Y antes de imprimirla debemos saber para qué
método la vamos a usar: método punto fibron y método transferencia térmica( planchado).

Método transferencia Térmica (Planchado)
Se debe dejar la imagen del PCB tal cual esta y pegarla en el documento de texto para luego imprimirla:

R NP,
q LJfig

Método punto fibron

Se debe pegar la imagen y luego voltearla en modo espejo.
Imagen sin espejar:

s VPPN
q LJIfig
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Espejando la imagen:

Sk Girar 907 a la derecha

Manual de CircuitWizard 1.5 4% Girar 90° a I izquierda _I__
‘;‘d 393em L Lk iﬂ Mas opciones de giro..

2&;;; P =729 :.r.";u_v_'

legir el tipo de vista que deseamos copiar en el archivo de tex

= Voltear verticalmente

Ak Voltear horizontalmente

Imagen espejada que debemos imprimir:

PP
dEdb1 p

Vista Unpopulate
Nos muestra la PCB sin componentes y podemos ver la imagen real de la pcb con las pistas y la mascara de

componentes al mismo tiempo.

?h_!l—n—n—a—;}

- > - =
Bl o 5 o .

28228

S e T e T e e

L O

Otras vistas para elegir
Para ver otras vistas debemos elegir la opcion More como vemos en la imagen siguiente:

pa3eIn

Components + Current Flow

« alopy

Components + Logic Levels
Compeonents + Arbwork

Solder Side (Bottom) Artwork
Component Side (Top) Artwork
Silk Screen (Outling) Artwork
Beoard Prototype

PCB Designer Classic

Save Style... f{—
¥ Delete Style...

Press e
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Vista Components + Current flow
Nos muestra la vista Current Flow y le agrega la visualizacién de los componentes fisicos.

Vista Components + Logic Levels

Nos muestra la vista Current Flow y la vista Logic Levels.

P -

Vista Components + Artwork

Nos muestra la vista Current Flow y la vista Artwork.

-l
o dle
= adla
oL i
ol
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Vista Solder side (bottom) Artwork
Nos muestra la vista las pistas de la plagueta “solo del lado de abajo” si es simple fazy doble faz.

Si es simple faz:

L
%
= [0

Se pega directamente para método transferencia térmica.

O se pega y se espeja para método punto fibron.
— [
qEdb1 p
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Si es doble faz:

Se observa que en la vista normal tenemos en rojo la pista del lado de abajo de la PCB, de color verde la
pista del lado de arriba de la PCB y de color azul los Pads de los componentes, puentes o puntos que
atraviesan ambas capas. Y solo se pasaran para imprimir en la capa de abajo las pistas de abajo (rojo) y los
pads de los componentes que pasen a la capa de abajo (azul).

SRR

¥

-

Se pega directamente para método transferencia térmica.

]“—b_n_a_m{,
q LJIfig

O se pega y se espeja para método punto fibron.
o g-a-o—ﬂ—ﬂ—ﬂ!_o [
qEdb1 p

0 «

[+]+ JFN
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Vista Component side (top) Artwork

Nos muestra la vista las pistas de la plagueta “solo del lado de arriba” si es simple faz y doble faz.
Si es simple faz:

Solo se veran los pads que estén del lado de arriba de la plaqueta.

GO o

1+

Profesor Palacios José Emanuel Pagina 114



Manual de Circuit Wizard 1.5 |

Si es doble faz:

Se observa que en la vista normal tenemos en rojo la pista del lado de abajo de la PCB, de color verde la
pista del lado de arriba de la PCB y de color azul los Pads de los componentes, puentes o puntos que
atraviesan ambas capas. Y solo se pasaran para imprimir en la capa de abajo las pistas de abajo (rojo) y los
pads de los componentes que pasen a la capa de abajo (azul).

SRR

¥

-

Se pega directamente para método punto fibron.

° Vam
5
'y

O
<
O se pega y se espeja para método transferencia térmica.

D o0
d
T
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Vista Silk Screen (outline) Artwork

Nos muestra la vista de la mascara de componentes del lado de arriba del PCB.
Se pega y se espeja para método transferencia térmica.

O se pega y directamente para método punto fibrén.

TB2

Vista Board Prototype

Nos muestra la vista de la PCB con o sin componentes externos en donde podemos ver los componentes
externos, los componentes de la PCB en modo real y la plaqueta en modo translucido.

= L3
- +
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5I*l*l*l*l
i

wewew g

Vista PCB Designer Classic

Nos muestra la vista de la PCB con un disefio Clasico donde tendremos el fondo de pantalla en negro (lo que
descansara la vista al disefiar) la pista de debajo de la PCB (rojo), la pista del lado de arriba de la PCB (azul) y
el enmascarado de los componentes de la PCB (amarillo).

Impresion directa desde el programa
Para ello deberemaos ir al menu File/Print y elegir de entre las opciones para imprimir la pagina.

3 G ADImmer Switch.owz L |
4 CALABulb Circuit.owz

Exit

£ Circuit Wizard -
£} File Edit View Project Window Help
0| D) New. i |, E QX
= Open... Ctrl+0
.
% ' Close
3
2 & save Ctrl+5
E‘ Save As -
;'é Page Setup... 1 1
QP [ Coredeion. Culp
) CAD/CAM 2 .
§ Solder Side (Bottom) Artwork
S'_ gﬁ Send... Component Side (Top) Artwork
= Properties Silk Screen (Qutline) Artwork
2
- 1 FE\.M\apunte circuit wizard.cwz Mirror PCB Artwork
= 2 ChuAInfant Toy.owz Invert PCB Artwork
2
o
:
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Area de impresion ala o0
Vemos a continuacion el area de impresién que imprimira.
!

|£3 File Edit View Project Window Help

D& e@oc ) e hOAX| AL e~ mmaa a6

< auopy ‘ perendoduny powany spaa oo MO|JIUBLINY  PUOAA [EBY  |ELLIION {

Ahora deberemos elegir que vamos a imprimir y al seleccionar cualquiera de las opciones nos aparecera la
ventana de propiedades de impresién como vemos a continuacion:

— Impresora
[+l o] [ Samsung ML-2160 Series Propiedades. .. |
£ Estado: Listo
i Tipo: Samsung ML-2160 Series
[

Ubicacion: USBOO1
Comentario: [ Imprimir a un archivo

—Intervalo de impresion ———— ~Copias

" Todo Nimero de copias: |1 3:
¥ Paginas de: |2 a: |2 [ [ [
1 1 2 2 3 3| T Intercalar

" Seleccidn

Ayuda Aceptar I Cancelar |

Ver Figura 60 del apéndice de ejercitacion de inglés.
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De acuerdo a la opcién que elijamos tendremos las siguientes impresiones: At & o 0

Current desing

Imprime el disefio seleccionado actual, en este caso esta seleccionado la vista Normal.
DBE & tEdlo o) o[ OAX @1 e~ mmad-|i

+ Blofy | peieindodup ylomgy  sEaaoiBo mojgJueuny  plogs (eay |ELUJONI

Solder side (bottom) Artwork
Imprime la hoja de la vista las pistas de la plaqueta “solo del lado de abajo” si es simple faz y doble faz.
Como vemos a continuacion:
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Component side (top) Artwork a P & &

Nos imprime la hoja de la vista las pistas de la plaqueta “solo del lado de arriba” si es simple fazy doble
faz.

Silk Screen (outline) Artwork
Nos imprime la hoja de la vista de la mascara de componentes del lado de arriba del PCB.
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Mirror PCB Artwork
Nos imprime la hoja de la vista de la las pistas en modo espejo.

w—e—n—h&—"l’,

gahdbd P

Invert PCB Artwork
Nos imprime la hoja de la vista del PCB invertida

Exportar a archivos de uso CAD/CAM.

Tendremos que ir a el menu FileICAD CAM y elegir en que formato exportar el disefio. Notas que solo con
estas opciones podremos obtener las mascaras antisoldantes.

]Q File Edit View Project Window Help

2 ChAdnfant Toy.owz a E ; E E 5 -
3 GG ADimmer Switch.owz B

4 L ABulb Circuit.owz

| OO New. Ctl+N |, |||_-]|K€“?Q><|fﬁ
——|[= Open... Ctrl+0

DZ i Clase

3

g & save Ctrl+5

? Save As...

E'E, Page Setup...

& | & Print 3

0 Export DiEF...

= Export NC Drill...
3 =l Send...

4 g=) Sen . Export Gerber...
= Properties

= o Copy CAM Data
— 1 B\ Aapunte circuit wizard .owz :

-3

2

o

Exit
[

oAy
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Export Gerber: a7 =

El archivo es un formato de impresion utilizado en la produccién de circuitos impresos y fue creado por Gerber
Systems Corporation. Que en el decenio de 1970 se convirtié en el mayor fabricante de impresoras utilizadas
en este trabajo. El formato se formaliz6 en 1980 por la Electronic Industries Association, que de manera
similar a RS-232, recibié una descripcion técnica de RS-274-D.

Es un formato disefiado para el control de las impresoras de transparencias (photolite). Estas impresoras
(también conocido como fotoplotter) fueron de hecho las maquinas de control numérico que se mueven en el
plan. Habia una intensa fuente de luz y un volante de varias posiciones que variaba la forma del haz de luz.
En cada posicion de la rueda existen formas de aberturas cuadradas, elipticas, circulares, etc., Y varios
tamafios para cada una de las formas. La luz tiene la forma se condensa en photolite a través de lentes.

El archivo en cuestién esta en texto plano con el listado de movimientos de la fuente de luz abierta o cerrada
(cédigos G) y utilizando una de las formas / aberturas (cddigos D) disponible, entre muchos otros comandos.

En 1991, el formato se amplificadoré para incluir los codigos de "apertura” que permite a un expediente con la
descripcién de Gerber en un circuito completo e independiente, sin necesidad de archivos adicionales con
informacion acerca de la forma y el tamafio de cada apertura, una lista de los agujeros, tolerancias, etc.

Para extraerlo en este formato seleccionaremos la opcion Export Gerber y se nos abrira la siguiente ventana:

File Mame: apuntes\apunte drouit wizard.inf] Save As... |

rExport
= R5-274D (standard) f* R5-274X (extended)
Export the following drouit layers: Aqlll .
Layer | File -~ seleccionaremos
Circuit Board F:\ESCLELA'ESCLELA RE. adonde guardarlo
Solder Side F:\ESCUELA\ESCUELA RE.
Component Side F:\ESCUELAESCUELA RE.
[] solder Side Mask W
£ ,
Aqui
¥ Place each exported layer in a separate output file seleccionarsele la
[+ Indude aperture table within output file capa que

[+ Fill pad drill holes Solder mask: IEI.25 mm

deseamos exportar

Coordinates
Lnits: IZ = Decimal: |3 = [~ Metric (mm)
Format: IND Zero Supression ;I (v Absolute

Sample:  UUDDD " Incremental

0K I Help
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Si hacemos clic en ok nos generara los archivos gerber de las capas que seleccionamos por séparddo@®omo 7

vemos en la siguiente imagen:

[ | coen |

- clones de los agujeros agrupac
+ G-codigos que definen las

o |

Archivo Inicio

T

& Descargas

| Documentos

g Escritorio

=| Imédgenes

o Musica

B Videos
a Disco local (C)
 Disco local (D)
—a DATOS(F)

€l Red

23 elementos
m ae

worn tnl mrmmars A mmdarls mernmse Adebas mmenes AassrimeiAn Faemnede

Export NC DRILL:

Compartir

.« 3ro B Dibujo y disefio.. » apuntes

Wista

Buscar en apuntes

. Archivos gerber
Mombre Fecha de modifica, generados
Ela

apunte circuit wizard.drl

~

circuit wiza

09,/04,/2018 02:22 ...,
09/04/2018 02:22 ...  Archivo GB1

Tipo: Archive GB1

Tamafic: 1,65 KB

Fecha de modificacion: 09/04/2018 02:22 p.m.
o, o H e o = [l [n

__| apunte circuit wizard.gb0

| || apunte circuit wizard.gb1

|| apunte circuit wizard.gb2

apunte circuit wizard.gh3

unte circuit wizard

circy

ffcuitos de gjemplo Documento
CIRCUTIWIZARD TRANSFERIR CIRCUITO ... Documento
[ e St VR n .
v o< >

Ver Figura 61 del apéndice de ejercitaciéon de inglés.

El archivo es un formato de archivo que es requerido por los fabricantes para controlar las maquinas CNC que

perforan las tarjetas de circuito

impreso. Usualmente es un archivo en formato texto que contiene la

informacion de los diametros de las herramientas a usar asi como las coordenadas de las perforaciones, etc.
Es el formato que usariamos por ejemplo para hacer el PCB con la CNC del “pofre Garcia”.

Para extraerlo en este formato seleccionaremos la opcién Export NC DRILL y se nos abrira la siguiente
ventana, donde podremos seleccionar Solder side (pistas de debajo de la PCB) y Component side (pistas

del lado de arriba de la PCB).

File Mame: apuntes\apunte drcuit wizard.dr Save As... |

rExport
Export the following drcuit layers:

Layer |
Solder Side
Component Side

Coordinates
Units: |2 jl Decimal: |3 ill [~ Metric {mm})

Format: INo Zero Supression LI = Absolute
Sample:  UUDDD " Incremental

oK I Help
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Si hacemos clic en ok nos generara los archivos NC DRIL de las capas que seleccionamos por8eparade ~ @
como vemos en la siguiente imagen:

niEN-|

Archivo Inicio

Vista

Compartir

T

1. <« 3ro B Dibujo y disefio.. » apuntes Buscar en apuntes

-~
*  Nombre Fecha de modifica... Tipo Archivos
& Este equipo
= b autp £ apunte circuit wizard 09/04/201801:19 ...  Archivo { formato
escargas
F’ 9 Zpunte circuit wizard.drl pe/od20120254 .. Archivel NC DRILL
| Documentos i B ") ]
Excritori |(l‘ apunte circuit wizard ) MO 20TE US54 p.m. nformaci
scritorio .
= » W] Srewitwizard ver Circuitesde gjemplo 22/02/2018 06:20 ...  Docume
=/ Imagenes CIRCUTIWIZARD TRANSFERIR CIRCUITO ... 25/10/2017 10:42 2... Documents

o Msica
Bl Videos
E Disco local (C:)

EETP_802_Apunte 2_tecria dibujo y disefi..  28/03/201702:40 ..  Decumento
EETP_G02_Apunte 3_proteus 101072017 09:34 a... Documento
EETP_602_Apunte 3_teoria dibujo y disefi..  04/04,

"1 EETP_§02_Apunte 3_teoria dibujo y disefi...  06/04/201705:38 ..  Decumento.

Rl rrre enn e -

117 11:05 a... Documento

—a Disco local (D)
=a DATOS (F)

19 elementos

Ver Figura 62 del apéndice de ejercitaciéon de inglés.
Export DXF:
DXF significa "drawing exchange format", o bien dibujo de intercambio de formato segun su traduccion. Este
tipo de archivo es nativo de la aplicacion CAD en el programa Autodesk AutoCAD. Ademas, estos archivos
son representaciones de datos etiguetadas de datos acumulados en los archivos de dibujo de AutoCAD.
Para extraerlo en este formato seleccionaremos la opcion Export DXF y se nos abrira la siguiente ventana,
donde podremos seleccionar Solder side (pistas de debajo de la PCB) y Component side (pistas del lado de
arriba de la PCB).

=L |spun tes \apunte drouit wizard . dxf] Save As..,

. Capa que
 Export vamos a
. Export the following circuit layers: extraer
- Layer | /I/
H Circuit Board /
Solder Side

Component Side
Both Sides
Silk Screen

Unidades de
medida Inches
(pulgadas) o
Milimeters
(milimetros)

IInches (im)

Ok
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Si hacemos clic en ok nos generara los archivos DXF de las capas que seleccionamos por sepédkadd como ~ @
vemos en la siguiente imagen:

Archivo Compartir Wista

10 < 3ro B Dibujo y disefio.. » apuntes v & Buscar en apuntes

-~

GJ MNombre Fecha de modifica... Tipo

M| Ecte equipo
I Esteequip €3 apunte circuit wizard 00/04/2018 0119 ... Archivo CW3

|| apunte circuit wizard 09/04/201803:10 ...  Archivo DXF
circuit wizard ver Circuitos de g Tipo: Archive DXF

CIRCUTIWIZARD TRAMSFERIR ¢ Tamario: 152 KB _
| EETP_602_Apunte 2_teoria dibu Fecha de modificacion: 09/04,/2018 03:10 p.m.
EETP_802_Apunte 3_proteus 107102017 02:54 a... Documento
EETP_602_Apunte 3_teoria dibujo y disefi..  04/04/2017 11:05 a... Documento
"L EETP_602_Apunte 3_teoria dibujo y disefi..  0B/04/201705:38...  Documento.
EETP_602_Circuit_Wizard_manual 09/04/2018 03:10...  Documento

WA rrre mam - . . Ar 44 AT A ma ~

& Descargas

| Documentos

i Escritorio

=/ Imagenes

W Musica

& Videos

a Disco local (C:)

—a Disco local (D)
=a DATOS (F)

18 elementos

Mechanisms
Ver Figura 63 del apéndice de ejercitacion de inglés.
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Opciones de configuracion del documento
Podremos configurar nuestro trabajo de tal manera de poderle agregar datos como: descripcion, formato,

proteccion contra copia, etc.

Yendo al menu File/lProperties.

|

File Edit View Project Window Help

|0

|

) Mew... Ctrl+M
@ Open... Ctrl+Q
i Close

I save

Save As...

Ctrl+5

Page Setup...

&h Print »
CAD/CAM 3

gﬁ Send...

1 B\ \apunte circuit wizard.cwz
2 ChuAInfant Toy.owz

3 ChLADimmer Switch.owz

4 ChGABulb Circuit.owsz

Exit

oMy sj@AaT 31607 MO|4IUBLND  PUOAY [BEY  |RLLOp

Donde se nos abrira la sigui

Ir il wl[ Qx| A

L!j
R
—3 LILES;

ente ventana:

| summary | Statistics I Control I

Q apunte crcuit wizard.owz

Type: Circuit Wizard Document

F:\ESCUELA\ESCUELA
21,68KB (22,197 byte

RESPALDO‘a MATERIAS DICT,
=)

Default. cwt

[~ Automatically update settings when opened

Update Settings Mow

o]
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Que tendra cuatro subventanas: General, Sumary, Statistcs, Control.

General

Nos muestra los datos generales de donde esta guardado el proyecto, tipo de proyecto, tamafo, tipo de

extension del archivo (.cwt).

3

apunte circuit wizard.owz

Type:
Location:

Size:

Circuit Wizard Document
F:\ESCUELA\ESCUELA RESPALDOYa MATERIAS DICT,
21,68KB (22,197 bytes)

Default.cwt

[~ Automatically update settings when opened

Update Settings Mow

Ver Figura 64 del apéndice de ejercitaciéon de inglés.
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Summary

Podemos ingresar datos complementarios como:

e Title: titulo del proyecto.

e  Subject: tema del proyecto.

e Author: autor del proyecto.

e Company: compafiia para la que se disefié.

e Category: una categoria del proyecto.

e Keywords: podemos anotar la clave contra modificaciones del proyecto.

e Comments: aqui podremos agregar algiin comentario que nos parezca oportuno.
e Hyperlink base: insertar hyperlink.

General Summary ISiaﬁst'cs I Contrcll

Title:

Subject:

|
|
Author: I
|

Company:

Category:

Keywords:

Comments:

Hyperlink
base: I

Ver Figura 65 del apéndice de ejercitacion de inglés.
Statics

Nos muestra los datos generales de donde esta guardado, fecha de creacién, de modificacion, etc.

General | Summary Statistics |Contro||

Created:
Modified:
Accessed:
Printed:

24julio 2017 17:53:00
09 abril 2018 17:57:00
08 abril 2018 13:02:00
08 abril 2018 20:53:00

Last Saved By:

Revision number:

alumno
24

Ver Figura 66 del apéndice de ejercitacion de inglés.
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Control
Nos muestra los datos generales de control del proyecto.

General I Summary I Statistics Control |

[ Lock this document to prevent any changes

Set Password... I Clear Password. .,

Access restrictions:

'}@‘ General
Allow this document to be printed
Allow this document to be output via CADJCAM
Allow the library to be modified
Allow access to the Project | Options window
Allow profile settings to be customized

p Simulation

Allow component faults to be set and changed

il PCB Layout

Restore Default I

Cancel |

Ver Figura 67 del apéndice de ejercitacion de inglés.

Las opciones que nos da son:

e Un casillero para usar la proteccion del documento.

e Un botén Set Password: para colocarle clave de proteccion al proyecto.

e Un botén Clear Password: para borrar la clave.

e Una ventana adonde nos muestras varios parametros de protecciéon que podemos bloquear o no al
ponerle clave al proyecto.

e Y un boton Restore Default: para restaurar las protecciones por defecto.
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Manejo de capas o Layers
Podremos tener en nuestra plagueta varias capas Como vemos en la siguiente imagen:

3 File Editl View Project Window Help

jl:i’“r ez g |y ] ]l kT Q

Ctrl+V
Del

Select All Ctrl+ A

| Symbol k| Graphic Foreground
Arrange (3

Real Components

Solder Side

Compeonent Side
| v Both Sides
Silk Screen

Para trabajar en cada una de ellas debemos seleccionarlas siguiendo la ruta que se ve en la imagen anterior y
se nos tildara la capa en la que estamos trabajando, ademas podremaos ver en la barra de estado que nos
informa en que capa estamos trabajando como vemos en la imagen siguiente:

by
|« v T Circuit Diagram }, PCB Layout /| PCB Layout & [ Bill of Materials / | | _>]J =]
il Press F1 for help Graphic Background )i 233, 2065 mm [E05smm [Q 79% [Ready

Las capas en las que podemos trabajar son:

e Graphic Background: gréfico en la cara inferior (lado de las pistas).

e Graphic Foreground: grafico en primer plano (lado de los componentes).

e Real Components: grafico de componentes reales.

e Solder Side: capa de COBRE del lado de la soldadura.

e Component Side: capa de COBRE del lado de los componentes (es la que usaremos para las pistas de
cobre de ese lado).

e Both Side: es una capa que esta en ambos lados (la usamos capa hacer conexiones entre la capa de
soldadura y la capa de componentes al usar doble faz).

e Silk Screen: es la mascara de componentes que nos indica que componente tengo que soldar y como es
su disposicion en la PCB.

Notas que para obtener la méscara antisoldante de ambos lados deberemos usa la opcién de exportarla
CAD/CAM ya que no podemos visualizarla con este programa.

Ver Figura 68 del apéndice de ejercitacion de inglés.
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Ahora que ya pudimos elegir en que Layer (capa) trabajar, el Circuit Wizard nos permife@ agregarle lo *
siguiente:

e Draw: dibujar formas, lineas, cuadros, circulos, imagenes, etc.

e Autor: menu de autor que nos da la posibilidad de crear nuevos componentes, agregar cuadros de
textos, tablas de datos, etc.

Draw dibujar formas e insertar imagenes

Para insertar imagenes, formas y demas deberemos ir al menu Project/Draw como se ve en la siguiente
imagen:

View i-Project Window Help

[allkOQ x|/l

Simulation »

#F Circuit Symbols »

| 111 PCB Components »
A Off-Board 3

|Q Test Equipment  »

# Add Probe F3 h

Folder 3
e
Author 3 )
e Copy As 3
lilins “, Line Shift+Ctrl+L
[ ] Rectangle  Shift+Ctrl+R
O Ellipse
™ Arc
™ Chord
{5 Freeform
% Scribble

Ver Figura 69 del apéndice de ejercitacion de inglés.

Se nos desplegara el menu en donde nos daré la opcién de:

e From File: inserta una imagen desde una carpeta de la computadora.

e Copy As: nos permite copiar un elemento o plaqueta seleccionada y extraerla como mapa de bit o
metafile (solo se habilita cuando se selecciona algun objeto).

e Line: agrega una linea.

e Rectangle: nos permite agregar un rectangulo.

e Elipse: nos permite agregar una elipse.

e Arc: nos permite agregar un arco.

e Chord: nos permite agregar una superficie compuesta de figuras geométricas.

e FreeForm: nos deja dibujar una superficie forma libre.

e Scribble: nos deja dibujar con el cursor como lapiz.
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Insertar imagen

Si elegimos esta opcion se nos abrirda una ventana en donde deberemos buscar la imagen a agregar.

Buscaren: [ [ escudo_eetp602 ] e 5 Efv [5124512) &I
L &= &

logo_dept_electr...  logo EETP 602 -  loge marca agua 2 logo marca agua 3
Mediano

logo marca agua 4 logo marca agua 3 logo marca agua | logo_escuela_512x
512_transparente | v

cem o= 1M

Nombre IIogo_ascuela_512xS1Z_tmnsparente Abrir I
Tipo: INI images ;I Cancelar |

Ver Figura 70 del apéndice de ejercitacion de inglés.

Y ahi vemos como se inserto la imagen en la hoja.

Podremos mover y achicar la imagen
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Si hacemos clic derecho sobre esta se nos abrira la siguiente ventana: a s L

F.E.T.P.
| |
N 602
H Cut  Ctrl+X
Copy Ctrl+C
fNpee Dol
= e
Restore Size
£Z Layer 3
Arrange 3

Author *

Properties

Donde tenemos las opciones clasicas y ademas de poder elegir:
Layer: en que capa insertarla donde solo tendremos tres opciones

L.E.T.F,_ﬂ
3 Cut Ctrl+X

N® 02 Copy Ctrl+C
> Delete Del

para elegir

Getting Starte

Welcome to Circui

Get up and running
the topics below, L

BALARMWARTH to navigate arounc

H!E I!!f.n" Restore Size -

e e — fﬂ_cu.‘ﬁ
gj | v (Graphic Background

Arrange
Author

Graphic Foreground L

ER

Properties

Silk Screen

Ji
Graphic Background: gréfico en la cara inferior (lado de las pistas).
Graphic Foreground: grafico en primer plano (lado de los componentes).
Silk Screen: es la mascara de componentes que nos indica que componente tengo que soldar y como es su
disposicién en la PCB.
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También podemos ir a la opcion Arrange: Fara_fijar la imagen.
—CH ||

e ) _t'_'"" d ey
] et up and runni
! Lut St the topics below.
& Copy Ctrl+C to navigate arou
Wi5 ¥ Delete  Del .
b S Guil
Restore Size | Start
R aeat
£2 Layer » o
= »an
@ Lock CtrK Gk
Author ez : e |
_ | b+ Pull onto Grid Ctrl+T
Properties | '-I_% Bring to Front F& ybt
| : e
| qﬁ Send to Back  Shift+F6 .l

Con las siguienes opciones:

Lock: bloquea la imagen o componente adonde se encuentra.

Pull onto Grid: tira la imagen hacia la rejilla.

Bring to front: Traer al frente.

Send to back: envia al fondo.

Rotate lef: girar a la izquierda.

Rotate right: girar a la derecha.

Mirror: espejar.

Group: si tenemos varios objetos seleccionados, los agrupa para que se comporten como un solo objeto.
Ungroup: si tenemos varios objetos agrupados , los desagrupa.

Insertar lineas, cuadrados, rectangulos, etc.

Si elegimos esta opcién se nos modificara el cursor para que podamos dibujar la linea, rectangulo o cualquier
figura que podamos dibujar.
Dibujar linea

Insertamos la linea definida por dos puntos a la cual podremos agregarle mas puntos de conexién y asi crear
una figura mas compleja.
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| | [ datode

| & Cut Ctrl+X
opy Ctrl+C
| ™ Delete Del

(&
C

=

=3 | £ Layer

Arrange 2

Author »
|E5' Properties
Dibujar un rectangulo

Insertamos de manera analoga a la linea y podremos definir la longitud de sus lados y asi también si sus
esquinas son rectas o redondeadas.

t Ctr+X '(_'ﬁ'
| ]

Cu
B2 Copy Ctr+C

| & Delete Del
L 1 : Edit handle. Drag to edit this
= : ¥ object.
Layer »
Edit handle. Drag to edit this g ; g
obi Arrange »

Author 3

Properties Nr——

De manera analoga se utilizan las otras opciones de dibujo.

X Gt

Formato de linea de dibujo
Si hacemos clic derecho sobre la linea del dibujo podremos elegir en que capa (Layer) la ubicaremos, las
propiedades de fijacion (Arrange) y las propiedades (properties) de la linea, también haciendo doble clic.

{ o

2 Cut Ctrl+X
[l 183 Copy Ctrl+C
X Delete Del

v Round Corners

-

= Layer
lk = 4 Arrange 3

Author 3

; Properties

Propiedades de la linea: podremos elegir el color, el estilo, el trazo, etc.
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Line colour:

™ Line style:

Fill colour:

Fill pattern:

Ver Figura 71 del apéndice de ejercitaciéon de inglés.
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Author insertar tablas, simbolos, textos
Para insertar tablas, textos y demas deberemos ir al menu Project/author como se ve en la siguiente imagen:

View j.Project Window Help

=2 }Run. : FQ I ._;:[%@QX';@=

Simulation 3

| s1l PCB Components »
A Off-Board 3
£ Test Equipment ¢

A Add Probe F5

Folder 3 u - -\.
Draw b -
Options... |[E] TextBox Shift+ Ctrl+ T
o !
% Spelling... F7
Align or Distribute 3

|, Hyperlink... Shift+Ctri+E /g
| eta Anchor Shift+ Ctrl+ A
|77% Frame Shift+Ctrl+F

|’ Graph Frame
: Report Frame

Se nos desplegara el menu en donde nos dara la opcion de:

e  Autor mode: inicia el modo autor del circuit wizard.

e Table: nos permite insertar una tabla, en un cuadro de texto.

e Symbol: permite seleccionar y agregar simbolos desde una lista, en un cuadro de texto.
e Spelling: activa el corrector ortogréfico.

e Aling or Distribute: alinea o distribuye los elementos de la pagina.

e Anchor: nos permite anclar la vista en un determinado punto.

e Frame: nos permite agregar un marco.

e Graph Frame: nos permite agregar un marco de grafico.

e Report Frame: nos permite agregar un marco de reporte.

Insertar cuadro de texto
Al elegir esta opcion podremos insertar un cuadro de texto para tener anotaciones del proyecto en la hoja que

estamos utilizando.

sprat o]

"Pbdemos
agregarle un
texto

waiopy | pejendodup pomny
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Si hacemos clic derecho tendremos se nos desplegara el menu de herramientas basica para el cuadro de
texto.

[ | - e
Podemos
agregarle un
texto
éif: Cut Crl+ 3
| By Copy Crl+i
# Delete Del
Exit Edit Text
g |_-E}"Er »
Arrange »
g Author 3 A Font...
Properties ] Table...
2 Symbol...
% Speliing.. i

‘Layout 4 PCE Layout 8 / Bill of Materials
-rich documents @, Hyperlink..  Shift-Ctri+E

ST

Donde tendremos las opciones de apa (layer), fijacion (arrange), autor donde podremos elegir el tipo de

letra, insertar una tabla, insertar un simbolo, y el corrector ortogréfico pero solo en INGLES.
Ver Figura 72 y 73 del apéndice de ejercitacion de inglés.

Insertar Tabla en un cuadro de texto

Al elegir esta opcion podremos insertar una tabla en un cuadro de texto para tener anotaciones del proyecto
en la hoja que estamos utilizando. Tenemos que hacer clic derecho sobre el cuadro de texto como vemos en

la siguiente imagen.

| ] ] ]
Podemos
agreg 3 .;.:: Ctrl+
texto [Bz copy ctisC
. Delete Del
™ Ewit Edit Text
g Layer »
Arrange 3
A Font..
Z properties | T
£ Symbol...
":7 Spelling... =
%r Hyperlink...  Shift+Ctrl+E

[ J———— [T
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En la siguiente ventana elegiremos la cantidad de filas y colunmas de la tabla a s
!» [+ o]

Mumber of columns: IE

ill OK I
Mumber of rows: |2 ﬂ Cancel |

Help |

e un

Vemos aqui la tabla insertada a la que le podemos ingresar os datos que queramos.

u
Podemos
agregarle un
texto

=

Ver Figura 74 del apéndice de ejercitacion de inglés.

Insertar Simbolos en un cuadro de texto

Al elegir esta opcién podremos insertar un simbolo en un cuadro de texto para tener anotaciones del proyecto
en la hoja que estamos utilizando. Tenemos que hacer clic derecho sobre el cuadro de texto como vemos en
la siguiente imagen.

& Cut  Ctrl+X
Copy Ctrl+C
¥ Delete Del | A Font.

Exit Edit Text ] Table...

Symbol...
5 Loyer iismeol

¥ Spelling... F7
& Hyperlink...  Shift+Ctrl+E

-
Properties I Both Sides

Arrange 3

. PCE Layout 8 Z

Se nos abrira la siguiente ventana desde donde podremos elegir el simbolo a insertar.

B -

"E (T (Tel&|z |{ () * |+, |- |/ |0/12/3|4|5|6|7|8
X(AE|€2 T H|I |8 KAMNOIIePZ|T Y QZE
118 |p|ynr|ox|hjnjvie|z|6|p|0|T |v | w|alk

O|o|o|o|o|ojo|o|o|o|o|o|o|jo|jo|o|o|o|o|o|jo|o
O £ @f & e|vaceT sl |27 2xxd» |+
R 3R pee@nvoolelcclelels| vV ®e ™
sl le@™z e T L Ll N

= 0 e
iR SR T =

-

Inzert I Close

Ver Figura 75 del apéndice de ejercitacion de inglés.
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Manejo de etiquetas de componentes

S| bien automaticamente el Circuit Wizard nos inserta automaticamente el nombre de componente el valor,
etc. Podemos modificar y editar esos datos a fin de obtener un disefio mas limpio.

Si hacemos clic derecho sobre un componente se nos desplegara una ventana y si elegimos la opcion
Symbol se desplegara la siguiente ventana:

O
R2 [R3 [ ka |:|R5 I:L;s
& Cut Ctrl+X 1K |:|
Copy Chrl+C K
> Delete Del w

Pads p T o
Routing 3 G
Symbol 3 Explode

I
Arrange 3

Properties Add Fault...

v MNumber 'R

Podemos '~ FEEEEN

Lock Labels
agregarie a won.

tEKtO Bestore Labels
I e

En donde podremos elegir:

e Number “R1”: tildamos si querremos que se visualice el nUmero de componente.
e Value “10”: si los tildamos se visualizara el valor del componente.

e Lock Labels: bloquea las etiguetas en el lugar.

e A Font: despliega la ventana para editar el tipo de fuente.

e Restore Labels: restaura las etiquetas a la configuracion inicial.

Luego de gue hayamos definido que etiqueta visualizar y la fuente de la misma, lo que podremos hacer es
desplazar la etiqueta de manera que quede visualmente mas prolijo. Para ello veremos la plaqueta en la vista
Real World o Unpopulated como vemos a continuacion.

jo: FE RS
e Nl ()

Ahora con la vista que mejor nos convenga, seleccionaremos la etiqueta que queramos desplazar y la
desplazaremos al lugar que deseemos.

Profesor Palacios José Emanuel Pagina 140



Manual de Circuit Wizard 1.5

4 Cut Ctri+X
Copy Ctrl+C

ﬂ Delete Del
A Font..

Symbol »
Arrange 3

E5 Properties
E& Prope

Como podemos observar en las imagenes anteriores, el acabado de la PCB es mas prolijo si trabajamos con
las etiquetas que si dejaramos las etiquetas como las inserta automaticamente el programa. Y si queremos
podriamos insertar un texto (Como vimos al insertar cuadro de texto) en esta PCB para poder agregarle
informacion extra al PCB.

File Edit View | Project Window Help

M| & 4R =

1| Pause  Shift+F3
|—. Stop Ctrl+F9

Simulation 3

e[k Qax|/7m e

## Circuit Symbols
il PCB Components
A Off-Board

£ Test Equipment

/' AddProbe  F5

Folder

Author

Align or Distribute

I Hyperlink...  Shift+Ctri+E
3 Anchor Shift+ Ctrl+ A
% Frame Shift+ Ctrl+F
ff Graph Frame

&1 Report Frame
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Aqui modificando el texto:

Podemos . . .
Aqui insertandolo en la capa delante de los componentes:

$ Cut  Ctrl+X
Copy Ctrl+C
¥ Delete Del

Edit Text

Arrange
Author 3

Circuit Diagram

Properties Real Components

Solder Side
Component Side
Both Sides

POdemOS Silk Screen

Aqui la vista Unpopulated:

D D2 D3

Aqui la vista de las mascara de componentes como quedaria:
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TB2

< .ptaca de.prueba
_|_
7 - R:I:I R2|:|R3|:| R4|:| RSI:.| R6|:|
¢ ¢
OO

D1 D2 D3 D4 D5 D6

< Silk Screen (Outline) = .

Compenents + Current Flof
Artwork

Components + Logic Level

i.a.low_‘ pejeindodup) jomgry  spaa Bol Mol ueuny  pl

Previews the silk screen
component outlines,

Components + Artwork
Solder Side (Bottom) Artw
Component Side (Top) Artwi (0]
-
Board Prototype

PCB Designer Classic

Save Style...
¥ Delete Style...

PCB Layout 8 A Bill of Materials f _L<_j

Insertar texto a la plaqueta lado cobre

Podemos insertar a la PCB en el lado de cobre un texto usando el icono iue vemos a continuacion:

|7 @~ m W 4aid]-

RENC]

da Copper Label

Insert a copper label,

Si hacemos clic sobre este icono tendremos la opcion de agregar un texto al PCB y se nos abrira la siguiente
ventana como vemos a continuacion:

Caption: I

Layer: Il Both Sides

Graphic Background
Graphic Foreground
Real Components
B solder side

[ Component Side

I silk Screen

En la opcion Caption escribiremos el texto que deseamos agregarle al PCB. En Layer elegimos la capa
adonde los insertaremos.
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Caption: aca prueha

Layer: | Il Solder Side -] Cancel

alaca de prueba

L * L ™
1 |_| R2|_||::q|_| I:Ml_l DR

De
Notar que si la insertamos en el lado de abajo (o lado de soldadura) la escritura estara en espejo.
Ver Figura 76 del apéndice de ejercitaciéon de inglés.

PCB doble paz

Elegiremos y montaremos los componentes como en una plagueta PCB simple faz.

2

L
|

4

EEEE

D1 D2 D2 D4 DE

R1
TB1

g@ oo

En la imagen anterior tenemos un circuito simple faz y le dejamos un led y una resistencia sin conectar asi
podremos tratar de conectar ese led con una pista en doble faz. Para ello seleccionaremos la herramienta
para crear una pista que conecte el led al negativo de la bateria con la resistencia R6 conectada a la
resistencia R5, como veremos a continuacion.
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Ahora vemos que la pista esta en el lado de la soldadura (color rojo), ahora debemos seled@ionar |a pista, @
hacer clic derecho y elegir la opcion propiedades o hacer doble clic sobre la pista a modificar, ahora debemos
elegir la capa Component Side como vemos en la siguientes imagenes:

182
Add Node
3(, Cut Ctrl+X Width: |1,02 mm Gap: |1,2? mm lLI
R1 R2 R3 R4 RS By Copy Ctrl+C
H X Delete  Ddl Layer: I Solder Side __'d |
Routlng - Solder Side
- =4 :ﬂ)‘Ef 4 Component Side
el ¢ I Goth Sides
CErET "
[1rd |

Ahora vemos la PCB con las pistas ya configuradas.

3
E T — %
an B | I—J

N e A e 0 0

Ahora que si simulamos la PCB el led que agregamos no se ilumina porque no circula corriente a través de él.

s | L1
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Esto es porque los pads de la resistencia, el led y la bateria estan del lado de la soldadura (soléler’sidé color
rojo) y las pistas estan del lado de los componentes (component side color verde) y necesitamos algo que
conecte ambas capas. Para ello seleccionaremos los pads y aremos clic derecho sobre estos y los
configuraremos para que este en ambas capas (both side color azul) de esta manera ya estaran ambas
capas conectadas como vemaos en la siguiente imagen:

IRound

|2,03mm Height: |2,03 mm

I- Solder Side

I solder Side
[ Component Side

Ahora si simulamos el PCB ya funciona correctamente.

ol L
d | o[
@

PP - T W -V
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Ejercitacion para Ingles Técnico

Ya vimos como armar los esquemas circuitales, y como probar si funcionan, entonces ahora que sabemos que
el proyecto anda perfectamente, podemos crear la placa de circuito impreso, simularlo, etc. Ahora nos
avocaremos a analizar los comentarios y ayuda que nos brinda el programa tanto cuando lo estamos
utilizamos como si utilizamos la opcion Help de la barra de menu, que como es de esperar, esta escrito en
Inglés, a continuacion veremos los textos que debemos comprender y traducir:

Ingresar al manual integrado que trae Circuit Wizard

Para acceder al manual debemos ir a la barra de menu a la oici()n heIiICircuit Wizard Help F1.
roject Window | Help
|| A 4

_ [ Circuit Wizard Help  F1
[ :
E Assistant Ctrl+F1

Web Home Page
Sample Circuits...

System Info...

% About Circuit Wizard...

Figura 1
Introducing Circuit Wizard

Circuit Wizard, our flagship product, is a revolutionary new system that combines circuit design, PCB
design, simulation and CAD/CAM manufacture in one package.

By integrating the entire design process,
[EhDe 5 e Brotect ot Circuit Wizard provides you with all the tools
DS 8[& L oo,y om kRS necessary to produce an electronics project
- " from start to finish—even including on-screen
§ testing of the PCB prior to construction!
= ot oty . . . + . .
§ - Lds Lo L. =
B ; #
i .,l T T" T B} Bl £ Vew Prolc Windew belp
= ™ k! pe 2] DEHE & oo, jolkiTQA% A7
g ] ﬁ E] -
i ES e i g
2 I . . - -
15 -
| el e eP e
5 T i
i ' 1
. st =) = {
E 1 o ® 2]
= _F R g
- 16 ;
i PP S e
* ¥
1 ! L F

Getting started + | Heln

The best way to start with Circuit Wizard is to explore some of & Circuit Wizard Help F1
the sample files provided with the software. There are many i

files available showing each stage of the circuit design @ Assistant Chrl+F1

process, from circuit diagram through to finished PCB layout. Weeb Home Pags

Open an sample file by choosing Sample Circuits... from the
Help menu. Select a file from the window that appears. To

Sample Circuits. ..

simulate a circuit, click on the Run button from the top toolbar. 4 Systern Info...
Try also clicking on the left-hand styles toolbar to investigate BEGIstEs
how the different circuits work. o

Profesor Palacios José Emanuel Pagina 147



Manual de Circuit Wizard 1.5 |

Figura 2

Exploring the work area

The main elements of Circuit Wizard are described below.

W Uil whizand - [Light soowe] ol =]
MEnU ———tle e gen Beiea wede peo TR
bar OEW & rle o, ¢ w6 0Q Albniane Toolbars
|
£
i " ”
| |
n Gallery
i
Styles ;
i &) R e j
i D
E :9 " l",b-!_'i_'{ ]
Design #
sheet !
S.'ZJRTI.)K‘.’\-‘:W'V)
Design
tabs o
o]
; .i 14 LEIELITEEIE £ BIXE AEEEFILILES Al o =
: 5 s S S S T ——
a LI : ! : . ; ! : : : v | — Graph
L T e ]
T ]
Status bar ———siriisne e (11001 ) et Porgond (004 esen @O0n G 100 [Raedy

Menu bar—The menu bar is used to access the range of tools and features in Circuit Wizard. Many of
the menu options can be accessed by clicking on toolbar buttons or by pressing keyboard shortcuts.

Toolbars—Toolbars provide quick ways to perform tasks in Circuit Wizard. Most toolbar buttons
correspond to a menu command. You can find out what each button does by resting your pointer over
the button: a hint appears displaying the button name.

Styles—Styles change the display of the current design, allowing yvou to investigate the circuit
diagram or PCB layout in more detail.

Design sheet—The design sheet is where objects are placed and edited. The scroll bars allow you to
move around the design. A range of panning and viewing options are also available.

Design tabs—Desiagn tabs allow you to switch between different aspects of the current design, such
as the circuit diagram and PCB layout.

Gallery—The Gallery provides quick access to components. You can drag objects from the Gallery onto
your design. The Gallery can sometimes be hidden.

Assistant (not showrn)—The Assistant provides help on using the software and access to a range of
tutorials, videos and sample circuits. The Assistant can sometimes be hidden.

Graph—The graph displays the output from any probes in the circuit. You can also choose to include
graphs directly on the design sheet so that they are included when the project is printed.

Status bar—A small bar that describes the currently selected command or button.
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Figura 3

Creating new documents

To create a new document either click on the New button or choose New from the File menu.

MNew Project
Choose one of the templates below to
use as a basis for your new project,
Create a new project based on: Cancel
B El t
Elementary Circuit

Help

)

il

83 Fle Edt Wiew Project

Dz H &

CULION

Description
@ Create a blank new electronics project.

A window will appear listing the types of document that can be created. It is possible for these choices
to be customized, however by default the following two will be available:

Electronics Project is the normal, most commonly required, document type and creates a new blank
document ready for both a circuit diagram and PCB lavout.

Elementary Circuit creates a new blank document suitable for elementary circuit investigation. This
document type replaces circuit diagram and PCB layout with a simple glementary desian page. Note
that you will not be able to draw circuit diagram or PCB layouts with this type of document.

Both document types also include a Bill of Materials page which will list all of the components in the
circuit along with their cost (when entered).

& See Working with templates for information on how you can customize the available choices in the
new document window by creating your own document templates or changing the existing ones.
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Adding components

You can add components to a circuit by using the Gallery. The
Gallery is a visual library that allows you to drag components or

virtual instruments into your circuit designs. $
If the Gallery is not already open, you should click on the Gallery

button (or press Ctrl+F2) to open the Gallery window.

Gallery @ All components and virtual instruments within the

Gallery are grouped according to their function.
Iﬁ Gallery -

'1F Circuit Symbols -

To display a different group, select the group from
the drop-down list box.

D Conneckors

= e Calery _____"|

(2 Dua-In-Line (DILY

|22 Terminal Elocks Ia Power Supplies j

(2] Sockets -
(2 Input Components Power Supplies

(2] Switches -

D Sensars B

1] Passive Companer’ e
= P B Battery

Move the mouse over the symbal

you want to use. Press and hold -
down the left mouse button. J—“‘ - el
With the left mouse button still held ‘-&]

down, move the mouse to drag the
object onto the circuit. i

Finally, release the mouse button
when the circuit symbol is in the
required position.

Once dropped in position, the symbol will appear highlighted.

You can change the style of highlighting by choosing Options
from the Project menu and clicking on the General tab.

As components are used, they are automatically numbered. Dragging on a second battery (following
on from the first shown above) would become 'B2', a third battery would become 'B3' and so on.

Labels next to the component show the current component value and number (where applicable).

- Moving the mouse over a component pin will show the name of the
pin along with the pin's number.

MNote that the pin number will match the number of the pin on the
associated PCB package. With integrated circuits (ICs), for
example, the numbers will relate specifically to pin numbers on a
555 Timer dual-in-line (DIL) package.

{Circuit Symbol)

Pin = 3 of 8 Output

To see the physical PCB pin numbers on the circuit diagram choose
Show Pin Numbers from the View | Display menu.
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Figura 6

Arranging objects

You can arrange or transform an object by first selecting the object and then choosing an option from
the Edit | Arrange menu. Note that the options available will vary depending on the type of object.

Lock prevents the selected objects from
being moved, edited or deleted.

Pull onto Grid forces the selected object
to be aligned to the current grid.

Bring to Front and Send to Back arrange
the selected object in front of or behind
other objects on the same layer.

Rotate Left, Rotate Right and Mirror
transform the selected object.

Group and Ungroup allow you to combine
objects together.

L& Symbol),.
":/Q Spelling. .. F7

2 |Z align Left
& align Centre
S| align Right

W, Hyperlink...  Shift+Chl+E

wda anchor Shift+Chrl+4

71 Frame shift+Crrl+F 00T Align Top
i Graph Frame At Align Middle
Report Frame ot Align Battam

Align to Page Centre

ofle Distribute Harizontally
“g' Distribute Yertically

- | Edit| Wiew Projeck  MWindow Help

4 %3 UndoInsert  Chrl+2 T »
0¥ Redo Cut Chrl+y
” Chrl+
g Layer 3 |
Symbol 3
2 Lack Chrl+
Properties |:: Pull onto Grid Chrl+T
ﬂ Bring ko Fronk F&

Wiring components together
Components must be wired together to form a
circuit.

To add a wire, first move the mouse over a
component pin (a) or existing wire (d). Over a pin,
a pop-up hint will appear detailing both the
component and pin.

Pin cursor [}S Wire cursor
i

Press and hold down the left mouse button.

With the mouse button still held down, move the
mouse to place a wire. You can add a bend to the
wire by releasing the mouse button over an empty
part of the circuit (b).

Moving back over the wire will allow you to retrace
vour steps and correct any mistakes.

To complete the wire, release the mouse button
over another component pin (c) or wire (d).

L

@ ]

BY SendtoBack  Shift+F&

A% Rokake Left Chrl+L
2k Rokate Right Chrl+R
Ak [itear GErlHa
TP Group Chrl+G
E] ngroum Gl LT

Further options for arranging objects are
available by choosing Author from the
Project menu and opening the Align or
Distribute menu.

Y
{Circuit Symbol)
PFin= 1 of 2: Positive

(c)
b =
3 it
(a) .
El T

Releasing the wire over another wire will automatically add a junction
at the connecting point.

Junction cursar

Q In more complex circuits, terminals can help to simplify the circuit diagram by reducing the number

of wires that are required.
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Editing components

Double-clicking on a component with the left mouse button allows you to change that component.

A window will appear showing the
available properties.

, I I — = l__l, Note that the particular properties
tumber: F ! = available will vary depending on the
Caption: l— p— | type of component selected.

Walue: |9 :II I :II W _ e |

Model: IIdeaI - l

Number is a unigue number that identifies the component. See component numbering for details.

Caption allows you to add a simple text description to a component. By adding captions, you can make
circuit diagrams easier to understand. You could, for example, label switches in your circuit according to
their function ('on/off switch', 'reset’ and so on). Captions will also be transferred onto a printed circuit
board when it is converted, making the PCB easier to understand, too.

Value shows the component value. The meaning of a component's value varies depending on the
component used. For a resistor, the value represents its resistance and is specified in ochms.

Numeric value fields consist of both a value and a multiplier. The component value is calculated by
multiplying the value by the multiplier. Enter a suitable value in the value box and click on the up/down
control to the right of the multiplier box to select a multiplier.

Value Multiplier, where:
M= 1,000,000 m=x0.001
Yalue: 1 j K j K=x 1,000 1 =% 0.000001

=x1 n=x0.000000001
p=:x0.000000000001

Model allows you to determine, for components that support it, which specific real-world component
model this symbaol relates to. See Selecting component models for more details.

For switches or components with a control, you can operate the component using the keyboard.

In the Properties window, a Key option becomes
available. A key can then be assigned to that
component. Choose a key from the list.

When assigned, pressing the key will activate the
switch or control the sensor.

For switches, pressing the key will depress the switch.
Holding down the Shift key whilst pressing the key will
keep the switch held down.

For sensors, pressing the key will increase the control's
value. Holding down the Shift key whilst pressing the
key will decrease the control's value.

The function generator and word generator virtual instruments provide additional properties over and
above the ones listed here.
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Simulating circuit diagrams
Simulation is the process by which Circuit Wizard determines what is happening in your circuit.

You can start and stop the simulation by using the

simulation control buttons. ]
p Click on the Run button {or press F9) to begin ;
simulating your circuit. 2 ote e,
)| Clicking on the Pause button (or pressing .% LZL J—E‘} L(,r
Shift+F2) will halt the simulation temporarily. i } T T T
i s s hee o)
m Click on the Stop button (or press Ctrl+F3) to g .li m:}l] "?ﬁ S
stop the simulation. % | 5, ! | B
i ¥ 0 el sl
Help g T T 1 i t
o - . s ] ar
l_) I m h N E s P o
. i - o o 2]
= _F RO
= }
3 [N T | Rt
Simulation control | i

MNote: You can only create and edit circuits when in
Stop mode. During circuit simulation, all editing
options will be disabled.

buttons "#,, '45 "%g $ -
!

DSt
Hz Lol % As your circuit simulates, animation is used to show your circuit
B b , working—voltage levels, current flow, charge and logic levels
il — can all be shown on screen.
P
f _' Use the style toolbar to investigate your circuit.
9
s For more precise results, you can make use of a wide range of
o ov virtual instruments, such as multimeters and oscilloscopes, to
wad o—L{pE Eol P ——— :
generate and measure signals
Ic1
40265
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Viewing dircuit animation

When simulating, Circuit Wizard uses animation to illustrate what is happening in your circuits. Styles
combines together the animations shown here into a range of predefined circuit views.

Qutput components will act like their real
world counterparts. For example, bulbs will I:Ij]]
light, motors will turn and buzzers will sound. o

Holding the mouse over a component, wire or fo—— [—}

pin will also give an instantaneous display of I«\g R1

the readings at that point. The readings will L

vary depending on the particular object.

When applicable, the cursor will also show the Wire

direction of current flow. woltage = 5.00% {volts)

Current = 5.00m#A (amps)

A range of further animation options is available by choosing Animation from the View menu:

Capacitor Charge will show the amount of i3 351 Eszch + and - sign shown on the

electrical charge on each capacitor. pepacita” represencs an exre 1000C
i et (coulombs) of charge.

10K,
1 B +vols

Colour Voltage displays each wire in a colour
representing the voltage at that point. ay

The colour shown will vary between red (for Dwolts
positive voltages) through green (for 0 volts)
to blue (for negative voltages). i

-vols

You can determine which voltages are used by o1
choosing Options from the Project menu and
clicking on the Simulation tab. See here. L

Current Flow will illustrate the flow of current B e— | !

I
around a circuit by animating dots. Click here ! |
to see how to change the current animation. . 1o

Current Arrows displays a simple arrow on .
each wire to show the direction of flow. A

larger arrow and thicker wire will be used

when there is a large current.

+volts

Voltage Level gives an indication of the sy o—t— +—=—T1 1 o O i

voltage level pin by the display of a simple bar l;ﬂ gié
at each component pin. The colour and size of

the bar represents the voltage. Dwolts

Voltage Indicator provides an alternative Beo—— F——1 1 o 0 i - valts
voltage display whereby a fixed-size square '11‘ S‘é
indicates the voltage by its colour.

o

Logic Levels displays the logic state at each
component pin. A '1" will be shown when the
signal is high, '0" when the signal is low and 'x'
when the logic level is undefined.

lol=
]

= === =]~
(=1 (= 0= =R = =1 )
—

OZ M W mw G o
-
_ o

Note that the digital logic model used for each pin will match
the type of component, so for example, 2 pin on & CMOS IC

would use CMOS logic levels, whilst 2 pin on a TTL IC would
use TTL logic levels (analogue components use the Ideal logic
model}. It is possible, therefors, for the same voltage level to 4
be interpreted differently by different types of components. =1
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Introducing documents

All circuits and projects within Circuit Wizard are referred to as documents.

Documents consists of one of more pages with each page containing a part of your design. For
example a document might contain one page for a circuit diagram and another for a PCB layout.

% Documents in Circuit Wizard are stored as files.
“"’ These files have the extension .cwz' and commands
24| Eile| Edt View Project Window b for managing them can be found in the File menu.
[ %&w... Cr+h
-
[= Open... o
= & = Open and close
lose
% -_— documents @ My Documents
= L
e Save Chrl+s i i i i
i E ; . i Save the current File Edit ‘“iew Favorites Toaols He
o ave As... -
E —_— document @ Back - -\mj e ? | /‘_ ) Search
o Page Setup...
% & Print » Address I_} C:\My Documents
CADJCAM 3
@ Send... Q
Properkies L
Circuit, cwz
Il mpzses it E
o mip sl it .
< A _ . Quickly open a
3 prEvipus s recently viewed
4 prEripuEHiE, _ document
Exit
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Figura 11

Working with circuit styles

Styles is a powerful feature of Circuit Wizard that allows you to look at your circuit in different ways.

The Styles toolbar appears on the left-hand side of the main Circuit Wizard

| O = B window. Click on a style button to view the circuit in that style.
=

g Normal Current Flow
2 D3

=

z Hz JLo— ] —

& ee ] ,

o —rR 4 —

— & - —

; i

& s -
] B I

i 10— oy o—e

g Wdd o——DE EO—

= IC1

=

= H0ZEE

S

-

g Voltage Levels

i

— D

2

& Hz Lo a1 —

" b~ -]

— CE o= = ,

L —r d— — .

o e '

= Pl ]

g [, [l
= el
- 2l I

= wH oy o—e

= wdd o—L—DE EoHL

=)
H02EE

The following styles will be available when working with a circuit diagram (each style allows you to look
at a different aspect of a simulating circuit):

MNormal shows the circuit without any voltage or current animation. Voltage Levels allows you to focus
on the varying voltage levels within a circuit (with current flow being represented by directional
arrows). In the Current Flow style, the flow of current is graphically animated using dots moving
around the circuit. Logic Levels helps with the understanding of digital circuits by showing the logic
state at each component pin, colour-coding the wires accordingly. Standard (not shown) is similar to
MNormal except that it displays the circuit in black and white, making it more suitable for printing.

See Editing stvles to learn how to modify these styles or create new styles of your own.

Voltage colours

For the Current Flow and Logic Levels styles, colour is used to represent the different voltages. High
voltages are shown in red whilst low voltages are shown in green. The precise colours used for each
voltage can be seen in the status bar:

[ | 1] )

o +10 Time: 2

Yolkage:  -10

As you move the cursor over parts of the circuit, the voltage at that point will be highlighted along this
voltage bar.

¢ You can change the range of the voltage bar by choosing Options from the Project menu and
clicking on the Simulation tab.
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Changing how circuits simulate

More control over a circuit's simulation is available by choosing Simulation from the Project menu.

iew | project Window Help gsll-]encé z}?egltgte option if you want to disable all

=) » Bun F2
[1| Bauser  SfifthEs
| mEton chlire

Explosions controls the simulation of maximum
component ratings.

Faults enables or disables the simulation of
Muke ChHH component faults.

To simulate mechanical switch bounce, enable

LF Circut Symbols ' Explloaene the Bounce option. When enabled, all switches

AL PGB GemponEnts F Faulks will suffer from contact bounce when the
# o pnard y Bounce contacts change position.
Slave Mation Slow Motion allows you to run the circuit at one
|T Back EMF fifth speed.

Back EMF determines whether or not reverse

Add P8 Ground voltages normally produced by electromagnetic
'S Power Supply... components are simulated.
Simulation i . : -
options Timing Contral... All digital components use a hidden digital power

supply. Choosing Power Supply allows yvou to
change the supply voltage.

Choose Timing Control for control over the
speed and accuracy of the simulation.

Q To accurately simulate a rapidly chanaing circuit (such as an oscillator running at 10Hz or more),
you may need to slow down the circuit in order to simulate more time points. Click here for details.

Figura 12 A

Simulating faulty components

Circuit Wizard allows you to simulate faulty components. Adding faults provides an excellent way for
students to learn how particular components work and to gain valuable experience of fault-finding
techniques. Open-circuit (dry-joint), short-circuit and leakage faults can all be added to specific
component pins.

To add a fault to a component, click the right mouse button over the component and choose Add Fault
from the Symbol menu that appears. A window will appear allowing you to select a fault.

Component Faults x|
Specify fault settings
Faults can be added to one or more component
pins. Select the type of component Fault below:
—Fault
& cut Crl £ Mone
Copy  Chrl+C = &p
* Delete Del ¢ Short
Explode = Leakage: IIDD ﬂ I ﬂ 0
Arrange 4
_ Convert As... Select which pin{s) the Fault applies to:
Properties 1(LED 1} -
b 2 {Ground)
|T Murber 'TC1' [ 3 (Power)
v Model 'LM3914' []4 (R Low)
|— e [ 5 (Signal)
Lock Labels ;! E EEEI?«'??»\ LI
A Fort... (o] I Cancel | Help |
Restore Labels

Select the type of fault and to which component pin(s) the fault applies. Short-circuit faults require at
least two pins to be selected, whilst leakage faults require the selection of two, and only, two pins.
Additionally, leakage faults allow you to specify the leakage resistance.

Choosing Faults from the Project | Simulation menu allows you to turn the simulation of faults on or
off for the entire circuit. Disabling faults will allow the circuit to simulate correctly.

To prevent students from editing or removing component faults, you can your restrict the access
rights of the document and then protect it with a password. Click here for more details.
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Using the digital power supply
All digital circuit diagram symbaols in Circuit Wizard take their power from a hidden digital power supply.
A separate hidden power supply is available for both TTL and CMOS

digital components. The CMOS supply can vary between 3 and 15
valts whilst the TTL supply is fixed at 5 volts. . .

This approach is recommended,
particularly if the circuit is to be
made into a PCE layout as all of

Sl }" WF sonee !
v DE the terminals will be connected
2 o to the appropriate supply rail.
Wa= vad 4026 Wez

You can change the power supply by choosing Power Supply from the Project | Simulation menu.

TR

MNets are used to connect the power supply to the components. The e B 1
CMOS power supply has the positive terminal connected to VDD and
the negative to VS5, For TTL, the power supply has the positive
terminal connected to VCC and the negative terminal to GND.
Wes Gind
D31 . .
Adding terminals connected to
: e any of these named nets
< ' allows you to access the
d l hidden supply.
¥ — &
q
2
0
o

m

Wiew | Projeck Window  Help

= | Run Fa M
[1| Eause  SfifithREa Power Supply =]
M ¥ automatically include hidden digital power supply

Mute £ Power supply voltage: S jl wvalts cancel |
1F Circuit Symbaols 3 Explosions

Help |
=Y PR Comoonents P |

Eaults

Bounce
Sl Mokion

ool ol | PR Graun

Specify power
supply settings

Timing Control,,

In the window that appears you can enter the required power supply voltage (for CMOS only).

wdd The Automatically include hidden digital power supply option enables or disables the
creation of a hidden digital power supply.

You should disable this option if you wish to place an explicit digital power supply on your
circuit. To do this, you would have to connect VDD and V5SS terminals (for CMOS) or VCC
and GND terminals (for TTL) to a power source (typically a battery).

One important benefit of using an explicit power supply is that it allows the power supply
itself to be dynamically simulated. For example, by selecting a realistic model such as

ay i 25mA for the battery, you can check that the current requirements of your entire circuit
can be met. Also, by placing a switch in series with a VDD or VCC terminal and the battery,
you could simulate turning power on and off to your digital components.
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Figura 13
Simulating maximum ratings

In the real world, components have limits as to what they can withstand. These limits are referred to
as maximum ratings. Circuit Wizard can simulate the maximum ratings of its components and, when a
rating is exceeded, the component will be destroyed.

v ay
To enable component destruction, choose Explosions from the
Project | Simulation menu.

Moving the mouse over a destroyed St |'| Swit

component will give a detailed description
of the cause of the explosion.

mi] o
LED B

{Circuit Symbal) l

0%

This component has been destroved,

Forward current of 79.47ma4
exceeded maximum rating of 30mAa.

To restore a destroyed component, click on the stop button. All destroyed components will be
instantly repaired. You can then click on the run button to restart the simulation.

You can destroy a component at any time by clicking the right mouse button over the component
and choosing Explode from the Symbol menu.

) ) » m

The maximum ratings in Circuit Wizard are based on the manufacturer's data book values. Refer to
the manufacturer's information for maximum rating and component limits.

MNote that the simulation of maximum ratings will only be as accurate as the simulation results on
which they are based. Click here for help with improving simulation accuracy.
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Controlling simulation time

The speed at which a circuit simulates is determined by simulation time.

Normally, simulation time is set to correspond to real time, whereby one second of simulation time
takes one second to simulate. By slowing down simulation time, however, you can investigate circuits
that normally operate too fast to be seen. Slowing down the simulation will also allow Circuit Wizard to
generate more accurate results by simulating more time points.

As a circuit simulates, the current simulation time is Time: [2.674 N
shown in the status bar. s

You can control the speed at which your circuit simulates by choosing Timing Control from the Project
| Simulation menu. A window will then appear.

i | Project ‘Window Help

» Bun F2
Il Bause:  Sfift4EE
|—. Shop (b ]S Timing Control %]

Simulation Mute Crrl+ Time Base! |1 j IS ﬂ OK I

T} Circuit Symbols Explosions ¥ Show simulation time base warnings (Eareel] |

»
11| PEE Gomponents F Faults P =
Mode: Relp |
/ Off-Eoard 2 EBounce et @ gpeed " Acouracy
3

Q Test Equipment I

Slow Motion Iterations: 25 j per skep
| v BackEMF

Ldd PEB Ground

H, Power Supply...
Timing Contral,.,

Specify timing settings

The Time Base setting controls simulation time. It defines how much simulation time takes place in one
second. For real time operation, set the time base to 1 second. Setting the time base to 500mS will
mean that the circuit simulates at half the speed, so it would take two seconds to simulate one second
of your circuit. The Time Base control uses a standard value editor:

Value
Walue: 1 =

Show simulation time base warnings provides an automatic check for certain cases where the
simulation time base is not sufficient to simulate the current circuit.

Multiplier, where:
M=:x1000000 m=x0001
K= 1,000 p =% 0.000001
=x1 n=2x 0000000001
p==x0.000000000001

I*_I-_I

The Mode and Tterations settings control the level of simulation accuracy. By adjusting these settings
you can often obtain improved results. Click here for more information.

Q To accurately simulate a rapidly changing circuit (such as an |T 1s
oscillator running at 10Hz or more), you may need to slow
down the circuit in order to simulate more time points. 500 ms
200 mg

Q You can quickly change the time base by clicking the right

; A 100
mouse button over the time panel in the status bar. Select the me
required simulation speed from the presets available (from 1 B
second to 1 micro-second).

MNote that updating the time base will also update the 2ps
horizontal (time) axis for any araph or graph frame. 1z

Time: | [Stopp
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Introducing virtual instruments

Circuit Wizard offers a wide range of virtual instruments that operate just like their real-life
counterparts. The following instruments are available:

Measuring instruments Probes
Analogue multimeter
Digital multimeter
Wattmeter
Oscilloscope
Logic analyzer

Input instruments Function generator
Word generator

HFG1
08v 1 0.5Hz

Rz
0k
ay
s
'

Lc\ oy
input o . o cutput
1 .

Ri IC1a
R TLOE4
1K

g

Graph of H5C1

HECT g
Chi  Ch2 =
- - =
o :C
input o §
output
-9 T T T 1
o 2 4 6 g

Time [s]

Figura 15

Using an osdilloscope

An oscilloscope records voltage levels over a period of time. You can add an oscilloscope by using the
Gallery (it can be found in the Test Equipment group).

The oscilloscope has two channels, channel 1 HECT

(Ch.1) and channel 2 (Ch.2). w

Each channel has a positive and a negative S s

terminal. Add wires to these terminals. T
50K

MNormally, the positive side is wired to the

signal being measured and the negative side o

to 0 volts. The voltage reading is calculated as

the potential difference between the positive
and negative terminals.

Once the oscilloscope instrument has been added, you then need to add a graph frame to display the
output from the oscilloscope.

Click the right mouse button over the oscilloscope and

choose Add Graph from the pop-up menu that appears.
Press and hold down the left mouse button. With the ™ & cut Chrl+%
mouse button still held down, move the mouse to B
determine the size of the graph. Release the mouse Sy EHIE
button to place the graph. ¥ Delete  Del
u Gramh of KSC1 -
12 Symbol 3
Arrange 3
= a B
g 5 Properties
l.g ]
= 3
0+ T T T 1
0 2 4 [ ]
Time [=]
] ] ]

For more information on using the graph, see Working with graph frames.
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Figura 16
Working with graph frames

A graph frame allows you to place a graph directly onto the page and thereby include it in your
electronics project. In addition to displaying the output from probes, graph frames can also show the
output from any oscilloscopes or logic analyzers in your circuit.

You can add a graph frame by first choosing Graph Frame from the Project | Author menu and then
drawing a box on the page where you want the graph to appear.

Double-clicking with the left mouse button on a graph will allow you to adjust its properties. The
properties available will vary depending on with which virtual instrument the graph is being used.

Properties available when Properties available when
used with an oscilloscope used with a logic analyzer

Graph Properties x|

Graph Properties Caption: [araph of KLAL : |
Caption: IGraph of ®5C1 k OK Colaurs: ch IU_ !I Cancel |
Colours: h.1: !I Ch.2: !I Cance = = Help |

ﬁ Tirme: |2 = I— ==
Maxirnum: I _I I__I VAN Graph Properties 3
MMlimimum ID j Caption: | OK I

Timne: |2 ﬁ I_jl F

Maimum: Ilz—ﬂ l_ﬂ ¥ Lﬂﬂl
Migimurn: Ig—j ﬂ;lpl

Properties available Tme: 2 = =l °®

when used with probes

Caption specifies the graph title. Colours determines the colour of the signal traces (2 for the
oscilloscope and 16 for the logic analyzer). Maximum and Minimum (for the probes and
oscilloscope graphs only) specify the upper and lower limits on the vertical voltage axis. Time
controls the horizontal axis and determines the time between each division.

& Changing the horizontal (time) axis for a graph does not change the speed at which the
circuit simulates. To accurately simulate a fast (10Hz or above) waveform you may need to

Caption specifies the graph title. Colours determines the colour of the signal traces (2 for the
oscilloscope and 16 for the logic analyzer). Maximum and Minimum (for the probes and
oscilloscope graphs only) specify the upper and lower limits on the vertical voltage axis. Time
controls the horizontal axis and determines the time between each division.

g’ Changing the horizontal (time) axis for a graph does not change the speed at which the
circuit simulates. To accurately simulate a fast (10Hz or above) waveform you may need to
slow down the circuit in order to simulate more time points.

Clicking the right mouse button over the u Graph.of XS u
graph and opening the Graph submenu 12
will show a pop-up menu of commands:
. . . ]
Activate enables or disables this graph = & cut Chrl+x
window..When disabled, the results in the o 5 Copy  Chl+C
graph will be fixed. .E % Delete Del n
Fit to Data adjusts the axes to so that the 3 =
current contents of the graph are clearly '7 Activate
visible. a arrange S e
) ] = "% © 1, FittoData
Choose Clear Results to wipe the graph Baiis @' Clear Results
clean. L] = - =
Auto Pause
Choose Auto Pause if you want the graph
to stop recording when full. FAL@ Sl
Auto Scroll will automatically scroll the Probes
graph to the left when full. sLA1
At the bottom of the menu you can FXSCI

determine from which instrument the
results for this graph will come.
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Figura 17
Using a digital multimeter

A digital multimeter can measure voltage, current and resistance within your circuit. You can add a
digital multimeter by using the Gallery (it can be found in the Test Equipment group).

An analogue multimeter is also available. Click here for more information.

The digital multimeter has both a positive and a fallial
negative terminal. Add wires to these terminals. 0y
To change the way in which the meter works, Tl
click the right mouse button over the multimeter
and select an option from the Instrument menu. YR o
653
oy
- Voltage, Current and Ohm determine whether the
= L% cut Chrl+ meter acts as a voltmeter, as an ammeter or as a
Copy  Chrl+C resistance meter.
¥ Delete Del When measuring current, a positive reading

indicates that current is flowing from the positive to
the negative terminal.

|T Woltage
»

Symbol E Current

When measuring resistance, a 1mA current goes
from the positive to the negative terminals.

Arrange 3 Ohm

AC and DC control the measuring mode. For AC
signals, the meter will record the RMS
(root-mean-square) voltage or current.

AC

v e

Properties

Figura 18

Using an analogue multimeter

An analogue multimeter can measure voltage and current within your circuit, You can add an analogue
multimeter by using the Gallery (it can be found in the Test Equipment group).

A digital multimeter is also available. Click here for more information.

The analogue multimeter has both a positive and a hilil

negative terminal. Add wires to these terminals. 10

When measuring current, the needle will move when A
current flows from the positive to the negative terminal.

¥R
To change the way in which the meter works, click the right 0% o

mouse button over the multimeter and select an option
from the Mode menu.

oy

K o
I: ¥ cue chrlx

Voltage and Current determine

Copy  ChHC whether the meter acts as a voltmeter
¥ Delete Dl or as an ammeter.

|7V i Ohm (resistance measurement) is only
Lokage available for digital multimeters.
Symbal . b Current

AC and DC control the measuring
mode. For AC signals, the meter will
record the RMS (root-mean-square)
voltage or current.

Arrange » @

Properties

At the bottom of the menu you can

Lmi specify the upper limit (full-scale
deflection) of the meter's needle
(between 1mV and 10V in voltage mode
100y and 1mA and 10A in current mode).

Meter properties
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Figura 19
Using a wattmeter
A wattmeter measures power. You can add a wattmeter by using the Gallery (it can be found in the
Test Equipment group).
The wattmeter has two sets of terminals, V (for a1
voltage) and I (for current). These should be
connected to the load being measured. Connect the B
voltage terminals in parallel with the load and the LU
current terminals in series with the load.
Power is calculated as the product of the potential
difference (voltage) and the current flowing and is
measured in watts (W).
&Y v
EL1
Figura 20

Adding probes to circuits

Probes provide a simple way of recording voltage waveforms in your circuits. You can drop up to four
probes in a circuit and watch the output in a graph window.

Click on the Add Probe button to place a new probe.

b | @ O Move the mouse to position the probe. You should drop the probe either
G i on a wire or on a component pin. The probe will record the voltage level
at that point in the circuit (with respect to the crcuit's ground).

R4
i []
7 4
&
The graph window (shown below) will open 1+ .
automatically when a new probe is added. B \’mﬂf 1
o 15K
Each probe is given a different colour. This
colour is also used to identify the signal in the
graph window.
See Using the graph window for more details. mDC; —
o ——

‘4 » ' Circuit Diagram i PCBLayout £ Bill of Materiz

st
t 12 4
= 9
L)
g0
g 3 4
o T T T T
o 2 4 [ g
Press F1 for help Tirne: | 1
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Figura 21
Using a logic analyzer H

A logic analyzer records digital logic levels over a period of time. You can add a logic analyzer by using
the Gallery (it can be found in the Test Equipment group).

HLAY

The logic analyzer has sixteen channels, which are He rLoe—| =
named 0 to F. Attach wires as required.

A graph will show a trace that goes high or low
depending on the logic level of the input.

L s Tun B G D

Note that for the logic analyzer, if the input voltage
goes above 2.5 volts it is treated as a high signal,
otherwise it is treated as a low signal. Input voltages
are referenced to a hidden 0 volt ground signal.

11
4017E

MO0 0w N s e D

Once the logic analyzer instrument has been added, you then need to add a araph frame to display
the output from the logic analyzer.

Click the right mouse button over the logic analyzer and choose

Add Graph from the pop-up menu that appears.
Press and hold down the left mouse button. With the mouse
button still held down, move the mouse to determine the size of
the graph. Release the mouse button to place the graph. 4 ot iy
Copy  Chl+C
] [ ] ]
Graph of XLA1 > Delete Del
Ch.ao ﬂ
Ch J
Ch2 = Symbal 3
m Chi - Atrange »
Chad Propetties
Cha
I T T T 1
Jal 2 4 B g
Time [=]
] [ ] ]

The graph always shows the channels in order (0 to F) regardless of which connections have been
made to the logic analyzer. To see more or less channels, resize the graph frame as reguired.

For more information on using the graph, see Working with araph frames.
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Figura 22

Using a function generator

A function generator produces voltage waveforms. You can add a function generator by using the
Gallery (it can be found in the Test Equipment group).

The function generator has two terminals, positive and 56’;%
negative. These should be connected to your circuit. :

A potential difference (voltage) will be produced between the e

positive and negative terminals.

For logic waveforms use the word generator.

Function Generator Properties E +
Murnber: IXFG Il ﬂ I VI
Caption: I Cancel

Double-clicking on the function

Help generator component allows you to
I =L | VAV, | ‘ﬂ{“"ﬂ | change the style of waveform

produced.
Yolkage: |5 :ll I j 4 A window will then appear.
Frequency: |1 j I j Hz In addition to the normal component

number and caption properties, you
Offset: ID—:|I l—j iy can customize the signal generated.
Phase: ID ﬂ degrees
Dy el ISD j = ] Signal waveform

properties

Figura 23

The wave can be either a sine wave, square wave, triangle wave or just random noise.

NI XA RA e
VYV S

_ H H H H H FSquarewave mmw e

Voltage determines the amplitude of the waveform. For sine waves the amplitude is measured from
the mid-level offset setting to its peak, with the peak-to-peak level being twice the amplitude.

Frequency controls the number of waves per second produced by the signal generator. To accurately
simulate a fast (10Hz or above) waveform you will need to slow down the simulation.

Offset controls the voltage level about which the signal is generated.

Phase determines the angular wave offset and is available for sine, square and triangular waves. A
cosine wave, for example, can be produced by using a sine wave that is 90 degrees out of phase.

Duty Cycle is available for square and triangle waves and controls the ratio of on-time to off-time. &
triangle wave with a duty cycle of 99%, for example, would produce a saw-tooth wave.

Sguare wave Triangle wave
(with a 25% (with a 99%
duty cycle) duty cycle)
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Figura 24

Using a word generator

A word generator produces digital logic patterns. You can add a word generator by using the Gallery (it
can be found in the Test Equipment group).

The word generator cycles through a series of digital data WG
patterns to produce logic output signals. Sixteen terminals =i
named 0 to F provide the output signals for bits 0 to 15 of the E‘: 1
pattern data. i
i Rz
For analogue signal waveforms use the function generator. il . 530 []
ol 35
il m
Word Generator Propetrties 3 ; [ 02 SZ
- gl Er— h %
hlumber: |><WG 1 j = oK I b - B x
vl Fl—

Caption: I Cancel | — =
= Hel o
:|| ;Dl Double-clicking on the word
generator component allows you
Data; I Ein | to change the digital output

pattern produced.

From: IDDD Ta: IDDF

# | He:x | Einat | o

000 0000 O000000000000000 A window will then appear.

001 0000 ©000000000000000

002 0000 0000000000000000 — In addition to the normal

003 0000 0000000000000000 component number and caption
004 0000 0000000000000000 properties, you can customize the
005 0000 0000000000000000 pattern data.

00§ 0000 0000000000000000 = — |

nnz nnnn [alnlninininininin(nnlnnlnluln =

= = Digital signal
Frequency: Il :II I :II Hz properties
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Figura 25

Figura 26

Data value (in hexadecimal)

. Pattern
The window shows each of number Data value
the data patterns stored in [ TeE Ty | = (in binary)
the word generator.
o000
Each value is shown in both 001 001 2000000000000001
hexadecimal and binary. 002 - nonz AANNNNON00000 0

To define how many data patterns are stored, change the To field which is in hexadecmal. As the
pattern numbers start at zero, this should total one less than the number of patterns required.

Data holds the value of the currently selected data pattern. Clicking on a data pattern will load that
value into the data field. Edit the data value to change the selected pattern. To switch between
binary and hexadecimal values, click on the Bin or Hex button to its right.

Frequency controls the rate at which data patterns are output. Once all data patterns have been
used the sequence will restart with the first.

- Clicking on the Edit button will show a menu containing further
I Edit ~ % commands for editing the pattern data.
Insert

Dot Insert and Delete add or remove lines from the pattern data.
==

Clear Buffer will reset the data by setting all patterns to zero.
¥ Clear Buffer

[ Open... Open and Save As allow you to read in or store pattern data files.

b save ss.. Complement inverts each bit in the pattern data (whereby 0 becomes 1
Eorl et and 1 becomes 0).
Count Lip Count Up and Count Down fill the pattern data with increasing or
Count Down decreasing numerical values.

Introducing PCB layouts

Circuit Wizard provides access to a wide range
of tools for drawing PCB layouts. These are: B Bl £ vew Prowct window e
D@ & e, palbHAxl 60

Component—A physical component such as a
resistor or a capacitor. A component normally
has legs that connect it to a circuit board.

s

Track—A section of copper that electrically
connects different parts of a circuit together.

Pad—A small piece of copper that normally
surrounds a component leg and is used to
electrically connect the leg with solder.

Flving Wire—An insulated conductor that can
connect both on and off-board parts together.

Board—A piece of printed circuit board onto
which tracks and pads can be etched.

D AL PRRIOOON  WSMINY | puom Ee

Label—Provides a means of identifying a board
once it has been manufactured and can be
either made of copper or be placed on the
non-conducting silk screen layer.

|
|i % Circuit Diagram }\PEBLaynut;{ ill of Materials § | 4 :

£ 0din

Click on the PCB Layout tab to start designing PCB layouts. You can create a PCB layout by either
converting from an existing circuit diagram or by manually drawing the PCB layout by hand.

Once the PCB layout has been drawn or converted, you can then wire up any off-board components
and then simulate the PCB layout on-screen to check that your design works.
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Figura 27
Converting to a PCB layout

Circuit Wizard can convert your circuit diagrams into printed circuit board (PCB) layouts.

First open or create the circuit that you want to be converted.

Next click on the Convert To PCB Layout button or choose Convert # [ﬂ £
to PCB Layout from the Project | Circuit Symbols menu. -

Q If part of your design is selected, yvou will be asked if you wish to convert just the selected part.
Breaking up a design into smaller parts can help when converting more complex circuits.

The Convert to Printed Circuit Board window will appear.

Convert to Printed Circuit Board

Circuit Wizard enables you to convert wour circuit
designs automatically inko printed circuit board (PCE)
layouts ready for manufacture.

This wizard leads vou through the conversion process,
allowing wou to choose exactly how your design will be
converted. At the end of this process, Circuit Wizard wil
generate yvour printed circuit board layout,

Click Mext to continue.

= Bach I Mext = I Cancel Help

This conversion window will lead you through various choices and options that control how your circuit
is converted. Click on the Next button to beain.
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Figura 28
Step 1 Choosing a conversion profile

The first page allows you to choose how your circuit should be converted.

Convert to Printed Circuit Board x|

Choose how you wish ko convert your design into a PCE
layout and then click Mext to continue.,

£ Single-Sided; Thick Tracks
4 Single-Sided; Normal Tracks

Singl ed; Thin Tr

£ Double-Sided; Thin Tracks
£ Placement Only; Mo Routing

£ Rats Mest; Mo Placement or Routing

onment:

Creates and routes moderately complex boards
with normal pads, thin tracks and flying wires,

[~ Allow me ko custamize the PCE layouk corver sion

< Back I Mext = I Cancel Help

The window provides a list of common conversion settings. These settings are known as profiles and
make it easy to select between different ways of converting your circuit diagram. You should select one
of the settings and then click on the Next button.

If none of the settings match your precise requirements you should choose the closest setting and
then enable the Allow me to customize the PCB layout conversion option. When enabled, this option
will allow you full control over all of the available options, otherwise those options will be hidden.
Customizing the conversion profiles

The conversion profiles listed in the window can be customized by choosing Options from the Project
menu, selecting the Settings tab and choosing the Circuit Diagram » Convert to PCB category.

See Editing profile settings for more information.

Figura 29
Step 2 Spedifying a board size and shape

With the style specified, you can then determine the size and shape of the printed circuit board.

Convert to Printed Circuit Board x|

The size and shape of the printed circuit board to be
generated can be specified below,

Shape: lm
I L wish to specify a size for my printed circuit board

Width: W

Heights IW

Sige: I_ J—

| i . . |

Smaller Larger

Click Next to continue,

< Back. I Mext = I Cancel Help

You can choose between Rectangular and Circular shapes for the printed circuit board by selecting
from the Shape drop-down list. The Size slider controls how small or large the board will be.

Normally, Circuit Wizard will automatically calculate an optimum board size. To specify your own board
size, enable the I wish to specify a size for my printed circuit board option and enter a suitable
width and height.

Click Next to proceed to the next step. The particular next step will depend on whether or not you
chose to customize the PCB layout conversion in the previous page. If customization was selected, you
will be presented with additional options, otherwise you will be taken straight to the end of the PCB
layout conversion process.

Q In the Width and Height fields, you can type in a different unit of measurement to the one given.
For example, you could type in '65 mm', '4 in' or even '3500 mil' (where a mil is one thousandth of
an inch). The available units are mm, cm, m, in, pt and mil.

To change the unit of measurement used throughout the entire application, choose Options from
the Project menu and select a different Measurement unit from the General tab.
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Figura 30
Step 3  Choosing component conversion

Next, you can choose which components are added to the printed circuit board.

Convert to Printed Circuit Board x|

The Following components were Found in your circuit:

Component | o] | Package | -
0°C Thermistor R3 Thermistor (Bead;...
10YF Eleckralyti,., C Electrolvtic Capac...
15% Potentiom... YR1  Potentiometer {0.... —
150¥K Resistor R1 Resistor (0.4 in, 1...
2.2k Resiskar R2 Resistar (0.4 in, 1...
75% Potenkiom... YRZ  Potentiometer (D.I.;lﬂ
3

4]

—

Double-click on a component name to change the
way in which it will be be converted,

Click. Mext to continue,

< Back I Mext = I Cancel | Help |

Each component found in your circuit will be listed. ID identifies the number of the component.
Package indicates the physical shape of the converted PCB component (known as a package).

To prevent a component from being converted C Y ®

at all, click on the check mark icon to the left of SRl I

the compaonent’s name. A tick indicates that the Package:

component will be converted. |Potentiometer (0.4, 10,2 ) ﬂ
Preview

Double-clicking with the left mouse button on a
listed component allows you to change the way
in which the component is converted. Resistors,
for example, are available in different sizes
according to their power and current limits.

Size = 7.62 (W) x 11,43 (H) mm

Select the required conversion from the window
that appears and then click on the OK button.

this component is converted inta a PCB.

Specify package to be used ———— e I Cancel Help

@ The package specified above will be used when

Click Next to proceed to the next step.

& Toidentify the various components on your circuit, click on an item in the list. The component to
which it refers will then be highlighted on your circuit as a point of reference.

Q You can specify how a component is converted prior to the conversion process itself by clicking the
right mouse button over the component and choosing Convert As from the Symbol menu.
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Figura 31
Step4  Customizing PCB component pads

Now you can adjust the size and shape of the PCB component pads.

Convert to Printed Circuit Board

The size of the component pads can be customized by
editing the settings below,

W Use customized PCE component pads

€ Small
€ Standard
€ Large

[ =g

Click Mexk to conbinue,

< Back I Next = I Cancel | Help |

To adjust the pad settings enable the Use customized PCB component pads option. With the option
enabled you can edit the pad settings by selecting a setting and then clicking on the Edit button.

The chosen pad settings will also replace the existing PCB component pad settings for any new
components that are added to the board.

Once you have chosen the required pad settings, click on the Next to proceed to the next step.

Figura 31 A

Step 5  Adding digital power to the PCB layout
In this step, you can add power connections to any digital components within your circuit.

Convert to Printed Circuit Board x|

¥ My circuit contains a hidden digital power supply.

For the dircuit to work correctly, these hidden
connections need ko be joined ko a real power supply.

Conneck the hidden power supply as follows:

Power: IEI j on IPinl:PUsitwe j

Ground: IEI j on IPin 2! Megative j

@ To include an explicit digital supply on your circuit,
add terminals connected to nets named ¥CC and
GND {for TTL) or YDD and W55 (For CMOS),

Click Next bo conkinue,

< Back I Mext = I Cancel Help

If you are not using digital components, you can skip this step.

Power supply connections for digital components are not shown on the circuit diagram. For the printed
circuit board to work correctly, however, these components need to be connected to a real power
supply in your circuit. Normally, this would involve connecting them to a battery.

Connecting a power supply requires adding two connections, one for power and one for ground.

In the Power and Ground drop-down list boxes you can specify which power source should supply
power to your digital components. For each component, you can also specify exactly which pin is used.
If you do not have a suitable source component such as a battery to connect to, you can select the
(Auto) option which will automatically add the necessary pads to the printed circuit board.

Click Next to proceed to the next step.

As you select power or ground components, the component to which it refers will be highlighted
automatically on your circuit, allowing you to see precisely which component is selected.

More information on using digital power

Digital components in Circuit Wizard normally take their power from an implicit or hidden power supply.

wdd You can specify an explicit power supply for digital components on your circuit by adding
terminals connected to nets named either VCC and GND (for TTL digital components) or VDD
and VS5 (for CMOS digital components). If you want to use both TTL and CMOS components
together and the CMOS compenents are not using a 5 volt supply, you will need to add an
Sl explicit power supply so that the two supplies can be kept separate.

You should also turn off the My circuit contains a hidden digital power supply option.

o In the example shown on the left, VDD and V5SS terminals have been connected (via switch

[T —— SW1) to a battery. Power to the digital components (both on the circuit diagram and on the
finished printed circuit board) would be taken from battery B1. The switch has been added in
the example so that an on/off switch can be wired to the finished board.
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Figura 32

Step 6  Choosing component placement
Next, you can determine how components are placed on the printed circuit board.

Convert to Printed Circuit Board

The components can be automatically placed on the
printed circuit board,
¥ Automatically place components on the board
[¥ Animate cormponent placemnent
[¥ Allow components to be robated
v Automatically fit placement ko board
¥ Take inko accounk symbol positions

G G SR B i SR asnE allawed
Between componentsin e field belaw,

[ S aEnE |2.54 il

Click Mext to continue.

< Back I Mext > I Cancel I Help |

Component placement is the process by which the position of each component is calculated. The
positions are designed to help the automatic routing process that normally follows.

Selecting the Automatically place components on the board option will enable automatic component
placement. If you wish to place the components yourself you should disable this aption.

Choosing Animate component placement will graphically illustrate the placement process.

The Allow components to be rotated option should normally be enabled. It gives the component
placement process the choice of rotating components for a better fit.

When the Automatically fit placement to board option is enabled, any free space around the placed
components will be used, where possible, to increase the spacing between components.

Take into account symbol positions will, when enabled, attempt to position the PCBE components in
the same order as on the original circuit diagram.

Minimum spacing determines how much space is placed between components. This option is only
available when the board size has been set manually (a fixed spacing is required to allow the size of
the board to be calculated automatically).

Click Next to proceed to the next step.

% In the Minimum spacing field, you can type in a different unit of measurement to the one given.
For example, you could type in 'S mm’, '0.3 in’ or even '400 mil' (where a mil is one thousandth of
an inch). The available units are mm, cm, m, in, pt and mil.

To change the unit of measurement used throughout the entire application, choose Options from
the Project menu and select a different Measurement unit from the General tab.
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Figura 33

Step 7  Automatically routing the PCB

When components are placed automatically, you can also enable automatic routing.

Convert to Printed Circuit Board %]

The circuit connections can be routed automatically,

It is during the automatic routing process that Circuit
‘wizard will work out & suitable path for each connection
and then convert these into copper kracks and wires,
¥ Automatically route connections in your circuit

v &llows bracks to be placed diagonally

v Allow wire links ko be added when necessary

[~ allow routing on both sides of the board

Grid: ID.DSD" grid with 0.020" tracks j

Click Mext ta continue.

< Back I Mext = I Cancel Help

Automatic routing is the process by which the path, or route, of each connection within your circuit is
calculated. Each connection will be replaced by a copper track or wire.

Select the Automatically route connections in your circuit option to enable automatic routing.

Disabling the Allow tracks to be placed diagonally option will force Circuit Wizard to place tracks
either horizontally or vertically.

Allow wire links to be added when necessary allows Circuit Wizard to add flying wires whenever a
suitable track route cannot be found (single-sided boards only).

To generate a double-sided board, enable the Allow routing on both sides of the board option.
Single-sided boards are only really suitable for simple circuits. Double-sided boards should always be
used as soon as the circuit becomes more complex, such as is the case when the circuit contains more
than about three or four integrated circuits.

Grid controls the spacing between tracks. Having thicker tracks necessitates a larger grid.

Click Next to proceed to the next step.

& Automatic routing can be cancelled by holding down the Esc key during the process.

Understanding the automatic routing process

When a circuit is converted, net connections are used to represent each connection in your circuit.
These nets are then converted into tracks during the automatic routing process.

An unrouted circuit shewing A routed circuit showing copper tracks
net connections
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Figura 34
Step 8  Adding solid copper areas =

In this step, areas of solid copper can be added to reduce your manufacturing costs.

Convert to Printed Circuit Board

Areas of solid copper can be added automatically to the
printed circuit board.

Adding copper areas helps reduce the cost of production
by minimizing the amount of etching that is required.

v automatically add copper area(s) ko the board
‘fou can specify the isolation gap in the field below,

This is the distance between a copper area and the
electrical parts in wour circuit,

Track isolation gap: |1 .02 mm

Fad gapis defined by thieiselected pad sethings,

Click Mext bo continue,

< Back I Mext = I Cancel Help

To add copper areas, enable the Automatically
add copper area(s) to the board option.

In the Isolation gap field you can then specify
the spacing, known as an isolation gap, between
a copper area and any pads or tracks in your
circuit. The isolation gap should always be more
than zero, and is typically about 1 mm or 0.04 in.

Click Next to proceed to the next, and final, step.

Understanding copper areas

Copper areas help reduce your manufacturing
costs by minimizing the amount of etching that is
reguired.

See Adding copper areas for more information.
A circuit shown with a copper area

g’ In the Isolation gap field, you can type in a different unit of measurement to the one given. For
example, you could type in "1 mm’, '0.032 in' or even 25 mil' (where a mil is one thousandth of an
inch). The available units are mm, cm, m, in, pt and mil.

To change the unit of measurement used throughout the entire application, choose Options from
the Project menu and select a different Measurement unit from the General tab.
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Figura 35

Step 9  Converting the drcuit

Finally, Circuit Wizard has all of the information it neads to convert your circuit.

Convert to Printed Circuit Board x|

Circuit Wizard is ready to generate your circuit, This
process may take a few moments to complete,

Click Convert: ko continue,

< Back I Convert I Cancel Help

Clicking on the Convert button will then convert your circuit according to the options specified. If you
wish to review your chosen options, you can click on the Back button.

Click here to go back to the main PCB conversion page.

Figura 36

Adding PCB components

You can add components to a circuit by using the Gallery. The
Gallery is a visual library that allows you to drag components or

wvirtual instruments into your circuit designs. $
If the Gallery is not already open, you should dick on the Gallery i

button {or press Ctrl+F2) to open the Gallery window.

_ All PCB components and virtual instruments within
the Gallery are grouped according to their function.
Iﬁ Gallery j . .
To display a different group, select the group from
=11 PCE Components ot the drop-down list box.

D Connectors

|1 Single-In-Line {SIL) [ =]

[ Dual-In-Line (DIL) -

[ Terminal Blocks Ia Poser Supplies ﬂ

(L] Sockets -
121 Input Compaonents Power Supplies

(L] Switches -

(L] sensors +
":l Passive Compons: " - Tetminal Block

(2 pin; 0.2 in, 5 mm; +1-)
/ -

Move the mouse over the symbaol
you want to use. Press and hold
down the left mouse button. A Battery with Holder
" 1.5%,

With the left mouse button still held (.59

down, move the mouse to drag the
object onto the circuit. -

Finally, release the mouse button
when the circuit symbol is in the
required position.

Once dropped in position, the symbol will appear highlighted.

© You can change the style of highlighting by choosing Options
[+] from the Project menu and clicking on the General tab.

As components are used, they are automatically numbered. Dragging on a second battery (following
on from the first shown above) would become 'B2', a third battery would become 'B3' and so on.

Labels next to the component show the current component value and number (where applicable).

Moving the mouse over a component pin will show the pin's
number along with name of the pin (where applicable).

Choosing Show Pin Numbers from the View | Display menu will
show the pin numbers directly on top of each component pad once
the zoom level is sufficiently high (usually at around 400%).

Terminal Block
({PCE Component)

PFin = 1 of 2! Positive
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Figura 37
Adding a drcuit board

The board tool allows you to model a printed circuit board.

Adding a circuit board

To add a circuit board, either choose Circuit 3 P n
Board from the Project | PCB Components menu 9 Hm o 5 i
or click on the Circuit Board button.

Click with the left mouse button where one corner
of the board is to be placed. with the mouse
button still held down, move the mouse to
determine the size of the board.

Releasing the mouse button will then create a
rectangular circuit board:

Added circuit board Circuit board shown in
the Resl World style

Figura 38

Editing and reshaping circuit boards

Resize an existing circuit board by dragging the handles that appear when the board is selected.
u n 3 To change the board shape, click the right mouse button
over the circuit board and choose from the Shape menu
& Cut G that appears.

B
Camy ik You can select between rectangular (the default shape),

X Delete Dol circular and polygonal dircuit boards.
Routing » The menu also allows you to remove all or (for
- ‘
Fﬁectangle rectangular boards only) part of the outline.
Arrange 4 Polygon
Circle
Aol [odE

| | |T Left
| v Right
|v 1op
|7 Eoktom

Gntine
—
With polygonal boards, you can add nodes by holding down
the Ctrl key and dragging with the left mouse button from
the edge of the circuit board {once over the edge, the cursor
will change shape to become a square). = a

Holding down the Ctrl key whilst clicking on an existing node
will delete that node.
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Figura 39

Drawing tracks

Tracks provide the electrical connections between components on a printed circuit board. Normally,
tracks are created during the automatic routing process.

Adding and editing tracks

To add a track manually, either choose Track

from the Project | PCB Components menu or # @ L|® |
click on the Track button. :

Click with the left mouse button where the track
is to start and then move to each point in the
track pressing the left mouse button at each
point. To finish, click with the right mouse button. A1

=
=3
[m—]

You will then be ready to start another track,
alternatively you can click the right mouse button r
again to return to selection mode.

g
Rl D
*® To reshape an existing track, first click on the track to select it. Next, move
€ over one of the highlighted nodes and drag it to a new position.
e} .\ Add a new node to a track by holding down the Ctrl key whilst clicking with
@_ the left mouse button on a track segment. Similarly, you can delete a node
by holding down the Ctrl key whilst clicking on an existing node.

Changing track properties

Double-clicking on a track with the left mouse button will allow you to change various properties for the
track, such as its width and layer. A window will then appear.

Track Properties The Width measurement represents the
B ] thickness of the track.
i |D.D4 in Gap: ID'DS n ILI Gap controls the spacing around the track

when a copper area is present.
Layer: I-Solder Side: - Cancel | P

Layer determines on which side of a printed

Help | circuit board the track resides.

Select the required properties and then click on the OK button.

Q You can set the properties for more than one track by selecting several tracks at once before
editing the properties of one of those tracks.

Q In the Width and Gap fields, you can type in a different unit of measurement to the one given. For
example, you could type in '2 mm', '0.1 in’ or even '50 mil' (where a mil is one thousandth of an
inch). The available units are mm, cm, m, in, pt and mil.

To change the unit of measurement used throughout the entire application, choose Options from
the Project menu and select a different Measurement unit from the General tab.
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Figura 39 A

Adding solid copper areas

When a printed circuit board is eventually manufactured, any space on the PCB layout not containing
tracks, pads or labels, will be etched away from the copper-clad board.

Each time this happens more of the etching solution is used up. To try and conserve this etching
solution and reduce the cost of production, you can add areas of solid copper to limit the amount of
etching that is required.

Adding copper areas

& o | -
To add a copper area, either choose Copper - :[g. S - e
Area from the Project | PCB Components

menu or click on the Insert Copper Area
button.

Click with the left mouse button where one
corner of the copper area is to be placed. With
the mouse button still held down, move the
mouse to determine the size of the copper.

=3
—.

Releasing the mouse button will then create a
rectangular copper area.

Isolation gap

A spacing, known as an isolation gap, is @_’
placed around each track and pad within the
bounds of the copper area.

h

This isolation gap can either be specified when
converting a circuit diagram or when setting
properties for individual tracks and pads.

To electrically connect an object to a copper
area, for example when grounding a copper
area, you can add a track or pad with a zero
isolation gap.

Two tracks with zero

isolation gap used to
ground & copper area.

Editing and reshaping copper areas
Resize an existing copper area by dragging the handles that appear when the copper is selected.
To change the copper shape, click the right mouse

button over the copper area and choose from the
# ot Chrl+i Shape menu that appears.

Copy  CwheC You can select between rectangular (the default
¥ Delete el shape), crcular and polygonal copper areas.

Rectangle
g Layer 3 |T Polygon

Arrange 3 Circle

Add ade

With polygonal copper, you can add nodes by holding down
the Ctrl key and dragging with the left mouse button from the
edge of the copper area (once over the edge, the cursor will
change shape to become a square).

Holding down the Ctrl key whilst clicking on an existing node
will delete that node.
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Figura 40

Working with styles
Styles is a powerful feature of Circuit Wizard that allows vou to look at your circuit in different ways.

The Styles toolbar appears on the left-hand side of the main Circuit Wizard window.
= Click on a style button to view the circuit in that style.

=
W

|

Real World

Unpopulated

Classic

= a4aly | page|ndodun  omlly 53437 10007 MO\ JURLND PLOA, B R uUop H

Further styles 3 % a
are available by E s
clicking on the

More button. w w O

Each style allows you to look at the circuit using different display options.

Mormal displays the circuit using the standard settings. Current Flow and Voltage Levels (not shown)
animate the board during simulation, see Viewing circuit animation for more information on these. Real
World shows the circuit as it would appear when professionally manufactured. Artwork previews the
copper artwork. Unpopulated shows how a manufactured board would look prior to soldering.

The More button provides access to additional styles like Board Prototype which shows how a board
would look when made as a one-off prototype, Component Side Artwork for previewing the artwork
on the top-side of a double-sided board and Silk Screen Artwork for previewing the component
outlines (which are known as the silk screen). PCB Designer Classic displays the circuit in @ manner
reminiscent of traditional PCB designing software (in this style the layers are semi-transparent).

See Editing stvles to learn how to modify these styles or create new styles of yvour own.
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ing off-board components

Circuit Wizard allows you to turn a completed PCB layout into a fully working circuit by connecting up all
of the required off-board components directly on the screen. This process is just the same as when
you come to build the PCB for real, with wires connecting off-board components to the circuit.

A full range of off-board components are available from the Off-Board Components group within the
Gallery. These include batteries, switches, sensors and outputs.

i

Connecting off-board components
works in much the same way as
wiring within circuit diagrams.

To connect an off-board component
to a circuit, drag with the left mouse
button from the end of one of the
component's legs. With the mouse
still held down, move the mouse to
start placing a connecting wire.
Release the mouse button when the
wire is in the required position.

Q Initially wires will be coloured blue, except when they are connected directly to either a positive or
a negative component pin, in which case the wire will be coloured either red {(when positive) or
black (when negative). You can change the colour of a wire by clicking the right mouse button over
the wire and selecting Colour from the popup menu that appears.

The circuit below shows the use of off-board components,
with a range of different colour LEDs and a 9 volt battery ﬂ
connected to the circuit. It also shows how flying wires can i
be used to break circuits into two or more different PCBs.

Figura 42
Simulating PCB layouts

Circuit Wizard allows you use simulation to test that your PCB layout works prior to manufacture. Just
as with the real world, you should ensure that all of the necessary off-board components and power
supplies have been wired to the PCB layout beforehand.

You can start and stop the simulation by using the
simulation control buttons. |E) e g3 Yew Poec Wndw e

DER@Ersel, nalsOax im

p Click on the Run button (or press F9) to begin
simulating your circuit.

)1 Clicking on the Pause button (or pressing
Shift+F3) will halt the simulation tempaorarily.

@ Click on the Stop button (or press Ctrl+F3) to
stop the simulation.

ow - Help

B D

o

Simulation control
buttons

Note: As with circuit diagram simulation, you can only create and edit PCB layouts when in Stop mode.
During PCB simulation, afl editing options will be disabled.

As your PCB layout simulates, you
can interact with your circuit and
take a variety of readings.

You can also make use of a wide
range of virtual instruments, such
as multimeters and oscilloscopes,
to generate and measure signals
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Figura 43

Interacting with PCB layouts

You can interact with a simulating PCB layout by controlling any switches or sensors in your circuit.

Switches Switches can be operated by clicking on them with the left mouse button. Holding
down the Shift key as well will keep push switches pressed down.
°.° et Switches can simulate mechanical contact
Pt bounce by enabling the Bounce option in
the Project | Simulation menu.
Sensors Sensors are components that can produce a range of values. They are operated

using pop-up controls that appear once you click on the component.

Move the mouse aver a sensor and click the

{r_r? o left mouse button. A pop-pup control will
by appear allowing you to adjust the sensor's
v value.
100K
Potentiometer You can either use the mouse in the central

part of the control ar enter a specific value
in the edit box at the bottom.

Lo i Note that the control will vary depending on
3 the type of sensor. Thermistors, for
e example, will show a thermometer instead
i 100 of the rotary dial shown here.
2500 j a4, You can reposition the pop-up control by

dragaging the control's caption.

For both switches and sensors, you can choose to control the component via the keyboard. To do this,
first stop the simulation and then double-click on the component to edit its properties.

In the Properties window, a Key option becomes
available. A key can then be assigned to that

t. Ch key f the list. 1
componen oose a key from the lis Key: = =
When assigned, pressing the key will activate the Mone N
switch or control the sensor.

" . B e
For switches, pressing the key will depress the c
switch. Holding down the Shift key whilst pressing o
the key will keep the switch held down. E
. . F

For sensors, pressing the key will increase the G -

control's value. Holding down the Shift key whilst
pressing the key will decrease the control's value.

Figura 44

Viewing dircuit animation

When simulating a PCB layout, animation can be used to illustrate the circuit's behaviour. To animate a
circuit choose either Current Flow or Logic Levels from the left-hand Style toolbar.

Current Flow

-
®
s

The Current Flow style animates
electrical current in the circuit by
showing animated dots. These dots will
move faster or slower according to the
intensity of the electrical current.

The Logic Levels style is primarily
designed for digital circuits and helps
you to visualize the differing signal
levels within the circuit.

For both of these styles, colour is used to represent the different voltages.
High voltages are shown in red whilst low voltages are shown in green. The
precise colours used for each voltage can be seen in the status bar:

141 | =]
Yoltage: -10 m o m +10 Time: 2

~ | Peaqemdodun oMy 5848720607 MOo|dIUBUnT  PUOM BSY  EuLol l|

As you move the cursor over parts of the circuit, the voltage at that point will
be highlighted along this voltage bar.

Q You can change the range of the voltage bar by choosing Options from the
Project menu and clicking on the Simulation tab.

Profesor Palacios José Emanuel Pagina 182



Manual de Circuit Wizard 1.5
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Changing how dircuits simulate

More control over a circuit's simulation is available by choosing Simulation from the Project menu.

iz | Project| Window Help

% » Run F9

| [l Fause  ShifitHES
|—. Stop Gyl

Mute Chrl4+1

SRE ! it Syt r Explosions
sl PCE Components  » Faults
@ Off-Board » Bounce
Slow Motion
|T Back EMF

Add PCE Ground

a Eower SUpplit.

Simulation Timing Contral...

options

Select the Mute option if you want to disable all
sound effects.

Explosions controls the simulation of maximum
component ratings.

Faults enables or disables the simulation of
component faults.

To simulate mechanical switch bounce, enable
the Bounce option. When enabled, all switches
will suffer from contact bounce when the
contacts change position.

Slow Motion allows you to run the circuit at one
fifth speed.

Back EMF determines whether or not reverse
voltages normally produced by electromagnetic
components are simulated.

Add PCB Ground allows you to specify the zero

volt ground point on a PCB layout.

Choose Timing Control for control over the
speed and accuracy of the simulation.

Q To accurately simulate a rapidly changing circuit (such as an oscillator running at 10Hz or more),
you may need to slow down the circuit in order to simulate more time points. Click here for details.

Figura 46
Simulating maximum ratings

In the real world, components have limits as to what they can withstand. These limits are referred to
as maximum ratings. Circuit Wizard can simulate the maximum ratings of its components and, when a
rating is exceeded, the component will be destroyed.

To enable component destruction, choose Explosions from the

Project | Simulation menu. i i
|
Moving the mouse over a destroyed ‘*
L} component will give a detailed description
5 of the cause of the explosion. | |
Green LED % i

({PCE Component)
This component has been destroyved,

Forward current of 1,484 exceeded
maximum rating of 30ma.

To restore a destroyed component, click on the stop button. All destroyed components will be
» instantly repaired. You can then click on the run button to restart the simulation.

You can destroy a component at any time by clicking the right mouse button over the component
and choosing Explode from the Symbol menu.

@«

The maximum ratings in Circuit Wizard are based on the manufacturer's data book values. Refer to
the manufacturer's information for maximum rating and component limits.

Note that the simulation of maximum ratings will only be as accurate as the simulation results on
which they are based. Click here for help with improving simulation accuracy.
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Understanding PCB ground
All circuits must be grounded, or earthed, before they can be accurately simulated. Grounding provides
a zero-volt reference point for all voltages within a circuit.
: ; By default, Circuit wizard will attempt to ground
= Wi Hel Ak 2 - -
4 SRR 100 e the circuit automatically. The ground point will
» Run Fa typically be defined as the negative side of any
Il Bausel  Shiftrrg power source such as a battery.
’_l SEp (EEHEES To change how a circuit is grounded, simply add an
e —— explicit ground of your own by choosing Add PCB
IMuke: Crl+M Ground from the Project | Simulation menu.
HE Circuit symbels. F Explosions Once placed you should join the top part of the
_ _ ground symbaol (either directly or via a flyving wire)
A1 PCE Components ¥ Eaults to the point on the PCB layout that you wish to
@ off-Board ¥ Bounce specify as being at 0 volts.
SR Teck Equipment g Slowe Motion
| v BackEMF
L PCB ground symbol
a Eaner SUppl.. g -
Timing Contral... -
Figura 48

Using an osdilloscope

An oscilloscope records voltage levels over a period of time. You can add an oscilloscope by using the
Gallery (it can be found in the Test Equipment group).

Once placed, you can then connect the instrument to your circuit
by using the instrument's terminal sockets.

To do this, drag with the left mouse button from one of the
instrument's terminal sockets. As you move the mouse, an
instrument probe will appear. You can then drop the tip of the
probe onto the part of the circuit you wish to measure.

An instrument's probe can be reposition by either dragging the tip
(to change the point of contact), dragging the probe body (to
rotate the probe) or dragging the wire (to add a bend).

You can restore all of the instrument's settings to their defaults at any time by right clicking on the
instrument and choosing Reset Instrument from the popup menu that appears.

Typically the GND terminal socket connects to the OV point in your circuit whilst either CH A (X) or CHB
(Y) (or both) terminal sockets connect in parallel to the parts of the circuit you wish to measure.

Click here for more information on using the oscilloscope's controls.

This application shows
an oscilloscope used to
measure the charge and
discharge curves of a
capacitor.

4
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Figura 49

Using an osdilloscope

An oscilloscope instrument has the following controls:

POWER
DISP

XY

TRG

POSs
LEV

+/-

CHA/CHB/EXT
(Trigger Mode)

CHA/CHB/DUAL
(Vertical Mode)

V/DIV

AC /GND /DC

CHA (X) (Mode)

POS
CHA

v/DIV

AC/GND/DC

CHB (Y) (Mode)

POS
CHB

GNMND

TIME/DIV

EXT TRIG

Turns the instrument on and off.

Shows or hides display of the V/DIV and TIME/DIV settings on
the output.

When pressed switches to using CH A as the ¥ axis and CH B as
the Y axis. TIME/DIV is ignored in this mode.

When pressed enables the trigger functions which allow you to
synchronize the trace display with an input waveform.

Determines the horizontal position of the output trace.

Determines the trigger level position where 0 represents the
minimum trigger voltage, 1 the maximum trigger voltage and 0.5
the (default) midpoint between the two.

Controls the trigger slope. When pressed, it triggers on the
falling edge of the trigger input as opposed to the rising edge.

Determines which input is used as the trigger signal. When EXT
is selected, the EXT TRIG terminal is used for the trigger signal.

Determines which output traces are shown, either just CH A&, just
CH B or both traces together.

Controls the number of volts per vertical division of the display
for the CH A input.

Determines the signal coupling for CH A. DC passes the signal
untouched; AC uses a filter to pass only AC signals; GND entirely
switches off the input.

Vertical adjustment for the CH A trace.

CH A input terminal. Becomes X co-ordinate when in X¥ mode.

Controls the number of volts per vertical division of the display
for the CH B input.

Determines the signal coupling for CH B. DC passes the signal
untouched; AC uses a filter to pass only AC signals; GND entirely
switches off the input.

Vertical adjustment for the CH B trace.

CH B input terminal. Becomes ¥ co-ordinate when in XY mode.

Commeon ground terminal.

Provides the trace sweep setting, controlling the number of
haorizontal divisions traced during the set period of time.

External trigger input used when the trigger mode is set to EXT.
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Using a digital multimeter

A digital multimeter can measure voltage, current and resistance within your circuit. You can add a
digital multimeter by using the Gallery (it can be found in the Test Equipment group).

Once placed, you can then connect the instrument to your
circuit by using the instrument's terminal sockets.

To do this, drag with the left mouse button from one of the
instrument's terminal sockets. As you move the mouse, an
instrument probe will appear. You can then drop the tip of the
probe onto the part of the circuit you wish to measure.

An instrument's probe can be repositioned by either dragging the tip (to change the point of contact),
dragaging the probe body (to rotate the probe) or dragaging the wire (to add a bend).

You can restore all of the instrument's settings to their defaults at any time by right clicking on the
instrument and choosing Reset Instrument from the popup menu that appears.

How you connect the multimeter depends on what part of the circuit you want to measure. Below you
can see how a multimeter has been used to measure the current in a circuit. In this application, the
instrument's probes are connected in series with the output current.

Click here for more information on using the multimeter's controls.
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Figura 51

Using a DC power supply

A DC (direct current) power supply provides electrical power to a circuit. You can add a DC power
supply by using the Gallery (it can be found in the Test Equipment group).

Once placed, you can then connect the instrument to your circuit by

byap 17 i Hita using the instrument's terminal sockets.

POVVER + - To do this, drag with the left mouse button from one of the

[ e instrument's terminal sockets. As you move the mouse, an instrument

® ol . probe will appear. You can then drop the tip of the probe onto the
part of the circuit vou wish to measure.
An instrument's probe can be reposition by either dragging the tip (to
change the point of contact), dragging the probe body (to rotate the
probe) or dragging the wire (to add a bend).

.F

You can restore all of the instrument's settings to their defaults at any time by right clicking on the
instrument and choosing Reset Instrument from the popup menu that appears.

Typically the - (black, negative) terminal socket connects to the OV point in your circuit whilst the +
(red, positive) terminal socket connects to the +V point in your circuit, as shown below.

Click here for more information on using the DC power supply's controls.

Using a DC power supply

A DC power supply instrument has the following controls:

POWER Turns the instrument on and off.
+ Positive supply terminal. Connect to the +V part of your circuit.

- Negative supply terminal. Connect to the -V or OV part of your
circuit.

5V / 12V / VAR Determines the voltage supplied, from 3 to 30 volts. Use the
slider to select between 5 volts, 12 volts or the variable volt
setting (VAR). With VAR selected you can adjust the voltage by
using the dial control.

VOLTS / AMPS Determines what is shown in the display, either the voltage
(VOLTS) or current (AMPS) levels as produced by the power
supply. When in current mode, the display will show how much
current is being used by the circuit.

HI/LO When AMPS display mode is selected the HI/LO button allows
you to choose how many decimal places are shown (three when
up, two when pressed down).
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Adding probes to PCB layouts

Probes provide a simple way of recording voltage waveforms in yvour PCB layout simulations. You can
drop up to four probes onto a PCB layout and watch the output in a graph window.

Click on the Add Probe button to place a new probe.

Bl | Iﬂ o Move the mouse to position the probe. You should drop the probe either
i : on a track or on a component pad. The probe will record the voltage level
at that point in the circuit (with respect to the PCB layout's ground).

| . .
| 4 ¥ | Circut Diagram ), PCB Layout /T Bill of Materic' The graph window (shown left) will open
automatically when a new probe is
= 17 - added.
g Each probe is given a different colour.
This colour is also used to identify the

signal in the graph window.

/\/ See Using the graph window for more

details.

“oltage []
(] (=1}

=

Press F1 for help Tirme: |T
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Using a function generator

A function generator produces voltage waveforms. You can add a function generator by using the
Gallery (it can be found in the Test Equipment group).

Once placed, you can then connect the instrument to your circuit by

o using the instrument's terminal sockets.

POWER  OUT  GHD To do this, drag with the left mouse button from one of the

[ o instrument's terminal sockets. As you move the mouse, an instrument
*® 0N ' probe will appear. You can then drop the tip of the probe onto the

part of the circuit yvou wish to measure.

An instrument's probe can be reposition by either dragaing the tip (to
[ change the point of contact), dragging the probe body (to rotate the
/ probe) or dragging the wire (to add a bend).

+
You can restore all of the instrument's settings to their defaults at any time by night clicking on the
instrument and choosing Reset Instrument from the popup menu that appears.

Typically the GND terminal socket connects to the 0V point in your circuit whilst the QUT terminal socket
connects to the point in your circuit in which you wish to introduce the waveform voltage.

Click here for more information on using the function generator's controls.

In the application shown here,
e e e a function generator is used to
T turn a motor backwards and

om ADd D S TL cmos forwards.

POWWER auT  GND  FREQ AMPL OFFS DUTY  LEVEL — LOGK:
® on Ve W@

~ v— .:: e R
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Using a function generator

A function generator instrument has the following controls:

POWER
ouT
GND

FREQ

1M/ 100k / 10k /
ik/100/10/1
-20dB

AD]

AMPL

OFFS

DUTY

Waveform

(Sine, Triangle, Square)

CMOS

LEVEL

LOGIC

Turns the instrument on and off.
Output terminal.
Ground terminal.

Determines the output frequency (in conjunction with the
multiplier, below).

Frequency multiplier selection. The output frequency is
calculating by multiplying this setting with FREQ.

When selected, reduces the output voltage by 20dB.

Enables adjustment of the waveform using the OFFS and DUTY
controls. When AD] is not pressed, the OFF and DUTY buttons
are ignored and a normal waveform is produced.

Controls the amplitude of the waveform output at the OUT
terminal.

When ADJ pressed determines the offset of the waveform
relative to the GND terminal.

When AD] pressed determines the duty cycle of the output
waveform.

Determines the initial shape of the waveform, prior to any
adjustment via the DUTY control.

Determines the output of the LOGIC terminal. When pressed,
LOGIC will provide a CMOS output, otherwise it will be a TTL
output (fixed at 5 volts). Under CMOS mode, the voltage output
is determined by the LEVEL dial.

Determines the voltage level output for the LOGIC terminal when
in CMOS mode.

Provides a TTL or CMOS-level output (depending on the CMOS
and LEVEL settings).
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Figura 54

Working with breadboards

Circuit Wizard allows you to design and simulate circuits using on-screen solderless breadboards.

To draw a breadboard circuit, first you must

select the type of breadboard you wish to use.
These are available from the Breadboard Ia Breadboard Madules j &
Modules part of the PCB components Gallery. el amnin--1eimnr g _I r
. . Pratatyping Board +
A range of different sizes of breadboard are roletyping Bos %
available. Each has a different number and =
arrangement of pin holes.
300 pin Breadboard ﬁ
Pratobyping Board g
og goood Ogoodg [m[m] T
OO0 OOooo Oooog og =
00 00000 Oooog oOg —
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Adding components

To add components to a breadboard you can simply drag PCB components
onto the breadboard. As you drag a component over the breadboard, the
pins will be highlighted (as shown) when they fit into a hole. Only when all of
a component's pins fit into holes can the component be placed.

Components that cannot be placed directly on a breadboard can be
connected by placing them to one side of the breadboard and then using
flving wires to connect up the component's pins to the appropriate pins on
the breadboard.
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Using electromechanical parts

Circuit Wizard allows you to connect up
electromechanical devices to your on-screen PCB
simulation. Motors, solenoids can be attached as
well as wheels, propellers and various types of
gear assembly.

In addition, simulated motors can be tailored to
match the behaviour of real-world motors. You can
specify the voltage rating, maximum RPM and even
add a gearbox.

To add a electromechanical device to your

simulation, vou should choose from the

Electromechanical group within the Off-Board

Components part of the Gallery.
For motors, double-clicking on the motor whilst
the circuit is not simulating will allow you to

— change the motor's properties and the type of
mechanism that is attached.

Murrber; | | j oK, I Model determines the voltage rating of the
motor.

Capkian: . . .

= I Lcell Speed is the maximum number of revolutions
per minute (RPM) that the motor is capable of.

Model:  [3vDC =l Llpl .

= Gearbox determines whether or not a

ek 10000 = gearbox is included, and if it is what the gear

= ratio is. A raj:io of 1:1 means there is no

Eoarilima |1 = gearbox whilst a ratio of, for example, 42:1

= = means that the output drive from the gearbox
will be 1 revolution for every 42 revolutions of

Mechanism: [Idler Gear =] the mator. A gearbox will be shown connected

to the motor whenever the ratio 1s not 1:1.

pury

(# of gear teeth) {gear attachment) )
Mechanism allows yvou to change what is

{drive) ik attached to the motor. For the different types
of gearing mechansism, the window will
{idler) |15 vI expand to allow you to specify the precise
nature of the chosen mechanism such as the
{output) 30 ¥ | ————3 Blade Propeller j number of teeth on each of the gears.
Mone

In addition, you can also specify whether a
further wheel or propeller mechanism is then
attached to the output of the gear.

bl
Z Blade Propeller
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Working with nets

Nets represent logical connections between
components prior to automatic routing. They can either
be added manually or placed automatically when
converting from a circuit diagram.

You can show or hide net connections by choosing
Unrouted Nets from the View | Display menu.

Working with nets

Clicking on the Automatic Routing button opens a menu

(shown opposite) that provides a range of commands
for working with nets.

Route All Nets will automatically route (convert into
tracks) either all of the net connections.

Route Selected Nets does the same but using only
those nets that are currently selected.

Interactive Routing will, when enabled, perform the
automatic routing process as components are moved
around in a circuit.

To rip up any routed tracks choose either Unroute

MNets (for just the selected objects) or Unroute All Nets

(for all tracks in the circuit).

With Auto Unroute turned on, routed tracks will be
automatically ripped up as components are moved
around.

Check Integrity will perform checking to ensure that
nets are not accidentally changed.

Editing nets

To add a net connection, choose Insert Met from the
popup menu.

As components are moved around, it is often easy to
break or lose connections. To prevent this, Circuit

Wizard offers the facility to lock nets in position. In this

mode it becomes impossible to drag or edit net
connections and so connections remain intact.

To enable or disable net locking, choose Lock Nets
from the menu.

Optimizing nets

@:
L u]
=3

Freq
0pF @ YRT oy ]
10K,
H
oz Cﬂ. 53 .ﬁ\. s I'PI Swt |2
-

Rz
220

An unrouted circuit showing net connections

g L
] I%Route All heks, .

Route Selecked Mets. ..

Interactive Routing
Settings. ..

Unroute Nets

Unroute Al Mets
|T Auta Unroute
|T Check Integrity

Inserk Met
|T Lock Meks

Opkimize Mets
|T Auto Optimize

When net connections are optimized, Circuit Wizard automatically calculates the shortest nets
between each connected component pin. With the shortest possible net connections, an optimized
circuit stands a much better chance of successfully auto routing than one that is not.

To optimize net connections, choose Optimize Mets from the above menu.

Circuit Wizard also offers the facility to optimize the nets automatically whenever components are
moved. Choose Auto Optimize from the menu to enable or disable automatic net optimization (this

option is enabled by default).
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Figura 58

Previewing the printed page

You can preview how the document will look when printed by choosing Page Layout Preview from the
View menu. The view will change to show a border indicating the size of the page.

The page outline allows you to precisely

f MIEEN et s e position objects on the page. For example, if
Mormal printad documents appear cropped you can
l E 4 2 use the preview mode to move objects so

that they appear within the page border.

GaTo  ° 3 Choose Normal from the View menu to

Toolbars restore the normal document view.

Choose Show Page Guides from the View menu to display page guides, anchors and object
boundaries. In this mode, object boundaries will show the size of each object.

When in Page Layout Preview mode, the printer
margin will also be shown.

This margin indicates the printable area of the page.
Anything outside this area will not be printed.

Choose Hide Page Guides from the View menu to !
return the display to normal. Printer margin

Adjusting the page layout

You can adjust the layout of a document by choosing Page Setup from the File menu.

Page Setup E

Page Size I.ﬁ.ppearance I

&ilBle Edt View Project Windc | Page Size! |Custom size =]
MNew... Chrl+n —
0 q [ 1l 'S Width: W rientation .
[ Cpen... Chl+o [ " Portrait
= Close Height: 210 T f* Landscape
:
= [ save Chri+s —Margin
o
= I Left: |12.? i Right: |12.? mim
('
o

Top: |12.? T Bokkarm: |12.? T
& Print X y

CADSCAM 3
_— r~Printer Information
6= send.. HP LaserJet 4100 PS
Properties Paper Size: 209,59 mm x 297,05 mm
Paper Orientation: Partrait
Exit
Print Setup... Print Scale: IIDD :II S

QK I Cancel | Help |

From the window that appears you can change the page size and maragins for your document.

Page Size determines the page size used. Select a size from the list.

« Choosing Same as printer will set the page size to be the same as that used for the printer.

« To select your own size, choose Custom size and then enter your own settings in the Width and
Height boxes below.

Margins specifies the borders of the page which are non-printable or should be kept clear.
Click on the Print Setup button to adjust the current printer settings.

Print Scale controls the size at which documents are printed. A scale of 50% means that the document
will print a half the normal size, whilst printing at 200% will make it twice as big.

once you have chosen your page settings, click on the OK button to close the window.
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Changing the display settings

You can customize the display of the current page by choosing Display from the View menu.

Choose Background to change the page background colour. Quality leads to a submenu that allows
you to tailor the display to your computer. Visual Effects determines whether or not special graphical
effects (such as lighting around simulating LEDs) are used.

Page Guides and Special Characters will show normally hidden object boundaries and text characters
respectively. Pin Numbers will show the physical (PCB) pin numbers on the component pins.

You can also show or hide particular parts of the printed circuit board by selecting its name fram the list
shown in the menu (these options will only be available for pages that support PCB layouts).

When the X-Ray Mode is selected, Circuit Wizard will draw copper layers in a semi-transparent way
(as used in the Classic stvle). To work properly, this option requires a black background colour.

Choosing Customize allows you to change various colour options for the current page.

Page Setup
- | Miew| Project Window  Help
Page Size  APpearance |
,E Mormal b
— & rage Lavout Preview T eneral
Background: I:II Graph Axis: -I
Go Ta 3
Toolars > Text Links: _I Graph Majar: |:|I
Graph Minor: EEEE
&R Gallery Chrl+Fz _I
ﬂ Graph ChHFS |—Circuit Diiagram
Anjmation b o , ibol Fill: |:|I Wire: -I
Syl ] [ fa
< Style ,T WaelEfiecs umenk Ling: -I Junickion: -I
Co-ordinates 4 urnent Fill:
= |T Page Guides —I
H# Grid{Snap 3 q )
Special Characters avout
Zoam b Fin Humbers er Side: _I Circuit Board: |:|I
| Battom Copper fponent Side: -I Silk. Screen: -I
[t LT (S Sides: E| il Holes: |
+ Copper Areas
) Available —r Silk. Screen
display options v Drill Holes ok | cawel | mep |
Compaonents
+ Wires & Off-Board
| v Unrouted Hets After choosing Customize, dick on the
v Test Equipment colour box for the item you wish to change
i T and then select the colour from the window
LRaY that appears. Once done, click on the OK
) button to finish.
Customize. ..
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Printing a document
= Fle Edit  Wiew Project  Win
Click on the Print button or choose Current Design o m _“J B

from the File | Print menu to print your document. D& =R ®

The Print window will then appear. Z | “S
Print 17
 Printer
" Click to adjust
. - P t A .
Mame: IEPSDN Styluz COLOR 40 J Fropertizs | printer settings
Status: Fieady Selact printer b
. elect printer to
Type: EPSON Stylus COLOR 640 use from list
Wwherer  LPT1:
Commert:
— Print range Copie:
& Al 3 pages Mumber of copies: |1 3: Select number
of copies to
" Pages [rom:|1 L0:|3 Ijl- B el print of each
giEe age
! Selection . . pag

Help | Cancel |

Select range of pages to print

From the Print window you can choose how your document prints.

Printer determines which printer is used. Select a printer from the Name list. To adjust settings for the
selected printer, click on the Properties button. Print range determines which pages in your document
are printed. Copies determinas the number of copies printed of each page.

Once you have chosen your print settings, click on the OK button to print the document.

Choosing Page Setup from the File menu allows you to adjust the lavout of your document.

If the document appears cropped when printed use the preview mode to arrange the document
so that it all fits on the page. The print scaling option allows you to reduce or enlarge the printout
so that, for example, you could print an A3-size document on to Ad-size paper.
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Exporting Gerber files

Circuit Wizard can convert your printed circuit board layouts into Gerber format for professional output.
Gerber is an industry-standard file format for transferring circuit files prior to manufacture.

To produce a Gerber file, select Export Gerber... from the File | CAD/CAM menu.

Export Gerber
at File 1. H (o o =15 le.inf
= ’E B e File Mame I \DocumentsiSample.inl Save As |
D [ Hewvi, .. Chrl+M e b Export

[ Cpen... CHlRED " RS-274D (standard) % RS-274% (extended)
= L)
% &9’ Jlose Export the Follawing circuit lavers:
= save Chrl+5 Layer | File |~
§ Save Ac O circuit Board
% Salder Side Ci\DocumentsiSample, gbo
= Page Setup... Component Side C\DocumentsiSample.gbl |
= @ Print 4 Solder Side Mask CHiDocuments|Sample. gb2
Export DXF.., B4 Component Side Mask CriDocumentsiSample.gbd ||
@ Send... Export MC Drill.. [V Place each exported layer in a separate output file
R rk n:EEerI:nEer...k ¥ Include aperture table within output File
i Copy CAM Data [V Fill pad drill hales Solder mask: IEI.DI in
il 5
= "—
~Coordinate
Uniks: |2 :II Decimal: |3 :II [ Metric {mm)
Format: INo Zero Supression j = absolute
Sample:  UUDDD " Incremental

Specify Gerber options ———— oK I cancel | Help

A window will appear that allows you to specify the format of Gerber data exported. You should consult
with your manufacturer to confirm the settings.

Gerber data comes in two variants, RS-274D (the original standard) and RS-274X (an improved
format). RS-274X is recommended and would be supported by most manufacturers.

The Layers option allows you to select which circuit layers you wish to export. Bottom Copper refers to
the solder (under) side whilst Top Copper refers to the component side. Selecting the Drill Holes layer
will enable the export of NC-Drill data in Excellon format.

With the Place each exported layer in a separate output file option enabled, Circuit Wizard will split
the data for each layer into a separate Gerber file. Include aperture table within output file will, when
enabled, place tooling information (known within Gerber as an aperture table) as part of the header
for each layer file (this is only possible when using R5-274% format). Fill pad drill holes determines
whether pads are drawn with or without the drill hole.

To generate a solder mask, enable the Solder Side Mask and/or Component Side Mask layers and within
the Solder mask field enter the amount by which pads will be enlarged to form the mask.

Coordinates allows you to define how coordinates are stored within the exported data files. Changing
the coordinate settings can affect the size and accuracy of the generated data. The Units and Decimal
fields together control the level of mathematical precision used. Metric switches between inch and
millimetre measurement systems. Format controls the suppression of redundant zeros (either none,
leading or trailing). Absolute and Incremental define the coordinate tracking mode; an incremental
mode will store a coordinate relative to the previous coordinate.

After entering a name for the Gerber files and selecting the required options, click on the OK button to
generate the Gerber files.

Understanding Gerber

Exported Gerber files, as produced by Circuit Wizard, consist of one or more files representing the
layers in your circuit, (optionally) a file contain hole drilling information and a report file.

All exported files have the same name but a different extension.

Each layer file has the extension .gb’ followed by a sequence number. The drill file has the extension
".drl' and contains NC-Drill data in Excellon format. The report file has the extension .inf' and is a text
file describing the exported data and providing tooling information for the manufacturer.

All files should be included when sending files for manufacture.
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Exporting NC-Drill files
Drill information from your circuit can be transferred to other CAD/CAM software to allow the automatic
drilling of holes on the printed circuit board.

To produce a drill file, choose Export NC-Drill... from the File | CAD/CAM menu. The drill file will be in
the industry-standard Excellon format.

_ Export NC Drill
&3 Fle| Edit Wiew Project Window  Help ;

= O e ol i . File Mame: IC.'I,Documents'l,Sample.drl Save As,., |

= Opern, .. Chrl+ B Export

E -'s Close Export the Following circuit layers;

?_, - Layer |
- & save Cirl+s Sclder Side
| c2es. Compaonent Side
§ Page Setup...
=

&b print »

Expart DEF. .. —Coordinate
@ Zend. . ill... Lnits: |2 j Deecimal: |3 j [~ Metric {mm)
: Export Gerber,,, g
Properties e Farmat: IND Zero Supression j & absolute

) Copy CAM Data
Exit 4—— | Sample: LLDDD " Incremental

(a4 I Cancel | Help

Specify drill options

A window will appear that allows you to specify the format of drill data exported. You should consult
with your manufacturer to confirm the settings.

The Layers option allows you to select which circuit layers you wish to export. Only holes that exist on
the specified layers will be exported.

Coordinates allows you to define how coordinates are stored within the exported data files. Chanaing
the coordinate settings can affect the size and accuracy of the generated data. The Units and Decimal
fields together control the level of mathematical precision used. Metric switches between inch and
millimetre measurement systems. Format controls the suppression of redundant zeros (either none,
leading or trailing). Absolute and Incremental define the coordinate tracking mode; an incremental
mode will store a coordinate relative to the previous coordinate.

Enter a name for the drill file, select the required options and then click on the OK button.

Understanding NC-Drill

The exported drill file has the extension ".drl' and contains NC-Drill data in Excellon format. A report file
with the extension ".inf is also produced and is a text file describing the exported data which also
provides tooling information for the manufacturer.,

Both files should be included when sending files for manufacture.
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Exporting DXF files

To allow case designs to be produced, Circuit Wizard enables a completed PCB layout to be exported

to third-party CAD software via the DXF file format. To export a DXF file choose Export DXF from the
File | CAD/CAM menu. DXF export is not available in the Standard version.

Chrl+M
Chrl+0

[EULIOp

n Save

Save As,..

Chrl+5

Page Setup...

&5 Print »

P, (22

@ Send. ..

Properties

Exit

File Edit Wiew Project  Window Help

o y

Export BC Drill,

Copy CAM Data

Export Gerber, .,

Specify DXF options

Expott DXF x|
Save As... |

File Mame: IC:'l,DDcuments'l,SampIe.dxF

Expork

Export the Following circuit layvers:

Laver |
O circuit Board

Solder Side

Component Side

Eath Sides

Silk Screen

Units: IInches (in} j

]

Cancel | Help

A window will appear that allows you to specify the format of the exported DXF data.

The Layers option allows you to select which circuit layers you wish to export. Units defines the scale

of the exported data, for correct scaling yvou should use the same units when importing the file.

Enter a name for the DXF file, select the required options and then click on the OK button.
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Working with templates

Templates act as starting points for projects. You can tailor the software by creating your own project
templates, each containing settings suited to a particular task or activity.

Managing templates & Templates

Templates have the file extension ".cwt' and are stored in File Edit Yiew Favorites Tools
the Templates folder which is itself located within the - — -
application's installation folder. @Back - \J - ﬂ' | /s_jSear
To create a new project template, first create a normal new - : -

document (by choosing New from the File menu), modify o Ij CeiProgram Fiesiflew Wa)g

the document as required and then save the document in
the Templates folder. When saving the file you must change Q
the Save as type box to Circuit Wizard Template (*.cwt).

Elementary.. ..

Similarly, existing templates can be modified by opening the
template in the Templates folder, making any necessary
changes and then resaving the document template.

Note that you will need to restart Circuit Wizard for any
template changes to be reflected in the File | New window.

To override a project's settings with

those currently stored in the template,

choose Properties from the File menu, "

select the General tab and then click on

the Update Settings Now button. Template: Default.cwt

Enabling Automatically update settings I™ Automatically update settings when opened
when opened will do this automatically =

each time the document is opened. Update Settgs Mow

\?) Do you want ko update the setkings in this document with those currently stared in kemplate ‘Default, cwt'?

Cancel |
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Adjusting document properties
To add your name and a title to a project, choose Properties from the File menu and then cdlick an the
Summary tab.
Untitled Propetties
General Summary | statistics | Control |
;f-;\ File Edit ‘Wew Project Windoy itz I
[ 0 Hew... Chrl+N »~  Subject: |
= Iiﬂ Qpen,.. Chrl4+0 futhar: I
& B9 dose
3 s
Company:
= n Save Chrl+35 I
E':—.- Save s
2 Cateqgor
‘3. Page Setup... =RiE I
@ Prink 3 Keywaords: I
CADJCAM 3
_— Cormments:
@ Send...
p b 3 Hyperllnk
Exit base: I
OF I Cancel Help
In the window that appears you can enter your name in the Author box and a title for your document
in the Title box. You can also complete any or all of the other fields to document your project. Once
done, click on the OK button to close the window.
The Title and Keywords fields are used when the document forms part of an electronic book.
Hyperlink base allows you to specify the first part of the file name for any non-relative hyvperlinks that
do not already include an explicit path reference (such as starting with a drive specifier like "C:\).
Figura 66
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Locking access to documents

Circuit Wizard allows vou to restrict access to your documents and to parts of the software. To do this
choose Properties from the File menu and click on the Control tab.

Untitled Propetties x|

General | SUmMALY | Statiskics  Conkral |
& I_ Edit Wiew Project  WWindoy [ Lock this document to prevent any changes
[ [ mew... Crl+H K Set Password., | talear Passtmrdl
= Open... ctl+o
22 B Close
E = Access restrickions:
i n Save Chrl+5 -}@ General -
3_: Save As... Alloww this document to be printed
E Allove this document Eo be output via CADMCAM
5 Page Setup. .. Allaws the library to be modified
@ Print 4 Allowe access ta the Project | Options window
CADSCAM 3 Allovs profile settings to be customized
T » Simulation
@ Send. .. Alloww component Faults to be set and changed
1l PCB Layout j
Exit Restare Defaulk |
QK | Cancel I Help |

To prevent any changes being made to yvour document select the Lock this document to prevent any
changes option.

Click on the Set Password button to apply a password to your document. When set, a password will
prevent users from changing any of these control options until Clear Password is selected.

Access restrictions allows you to control particular aspects of the software. Click on a check box next
to an option to enable or disable that feature.

To restrict access to particular components in the Gallery, you can choose Options from the Project
menu and click on the Gallery tab. See Controlling access to the Gallery for more information.
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Figura 69

Working with layers

Objects within Circuit Wizard exist on layers. Layers can be visualised as a "slice” through the page
where each layer is stacked one on top of another.

,3_:\ Filz | Edit| Wiew Project  Window  Help
[ (= *<? UndoPaste  Crrld2Z

[ |89 GanibHeda Gl
g
= & cut Chrhx
o .
i Copy Chrl+C
o B Paste Chrb+
DE b Delete Del
i Select &l Ctrl+a
;_E Clear Selection
= %
Symbal 2
Arrange

Properties

» |7 iGraphic Foreground
3

Graphic Background

iEircliE Eragra

Real Components

Drawing shapes

Solder Side
Component Side
Both Sides
Silk Screen

Many objects within Circuit Wizard, such
as text, pictures and shapes, can be
moved to a different layer.

To change the layer on which an object
resides, first select the object and then
choose the new layer from the Edit |
Layer menu.

Circuit Wizard provides a range of drawing tools for drawing lines and shapes onto designs.

To draw a shape, select Draw from Project menu and choose the type of shape from the menu that
appears. You can add lines, rectangles, polygons and other shapes to your document.

Once drawn, you can format the shape to change its colour, style or fill.

= | Broject Window  Help

5 » Bun

F9

Il BEause  Shift+rd

’; S

# fAddProbe

Eolder

Author

Options. ..

(CRHNEE

FS

Y] Erom File..,  Shift+Ctrl+G

ey i

. Line Shift+Cerl-+L
[ Rectangls . Shift+Ctr+R
O Ellipse %

(% Freeform
e’% Scribble

Q To draw a square or circle, hold down the shift key whilst drawing the shape.

Q To draw a rounded rectangle, first draw a normal rectangle by choosing Rectangle from the
Project | Draw menu. Once drawn, click the right mouse button over the rectanale and choose
Round Corners from the menu that appears. You can adjust the amount of corner rounding by
moving the additional handle that appears.
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Adding a picture from a file

Most pictures are stored as files, usually with an extension such as .BMP' or ".JPG',

To add a picture from a file, choose From File from the Project | Draw menu. The picture will then be
displayed (with handles to show that it is selected).

Laak in: I@ My Docurnents j L] cF B [144E5) &I

|

File matne: IVan.bmp Open I
Files o tupe: IAII images j Cancel |

B

Select picture from list of picture files Preview of selected picture

To change an existing picture, double-click on the object with the left mouse button. The Insert Picture
window will appear allowing you to select a different picture file.

%y Normally inserted pictures are embedded within the document file. To insert a picture linked to an
external picture file, select Insert Linked Picture from the Author toolbar. This is particularly
useful when authoring electronic books as it allows the same picture to be used many times.

Creating picture copies

Choosing Copy As from the Project | Draw menu allows you to insert a duplicate of the currently
selected objects into the document as either a bitmap or metafile picture copy when you next select
Paste from the Edit menu. See also Using embedded frames.

Bitmaps are low-resolution but better for on-screen work, whilst metafiles are higher resolution
(vector) pictures that usually look better when printed.

Figura 71
Formatting shapes

The colour, style and fill of drawing shapes can be changed.

To change a shape, either double-click on the shape with the left mouse button or click the right mouse
button over the shape and choose Properties from the pop-up menu that appears.

Shape Properties X|

Line colour:

& ocut x|
! Line skyle: ipp ——m— = Cancel |
Copy  (Chrl+C

x Delete Del

Fill colour:
Round Corners

£ Layer
Arrange
Authar

I j'
Fill pattern: I Mone hd I
I jv

Father ealour;

Select the required shape properties from the window that appears and then click on the OK button.
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Adding a text box

You can add text to your documents. To add a text box choose Text Box from the Project | Author
menu. The cursor will change shape:

+  Text Box cursor

Press and hold down the left mouse
button.

with the mouse button still held
down, move the mouse to
determine the size of the text box
to be added.

Releasing the mouse button will L L |

then create an empty text box. You Vehicle reversing project

can now type text into this box. Flashing cursor
indicating text

A flashing cursor, the insertion point, insertion point

shows where text will be entered ]
when you type.

See Selecting and editing text.

Once you have created a text box, you can use the text formatting toolbar to change the style of the
text. You can also add tables and symbols and check the spelling of your text.

Q If you are not editing the text in a text box, you can move the entire text box it by dragging
anywhere inside the text box with the right mouse button.
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Formatting text

The Formatting toolbar allows yvou to change the style of font used for text. To show the Formatting
toolbar choose Formatting from the View | Toolbars menu.

Formatting x|

[ia I =0, =B s
L

| I |

Text font Size Style Alignment Bullet

Number

Select text using the mouse and then use the Formatting toolbar to change the style of that text.

VEHICLE RE VERS‘:"NG PROJECT ; Title centred
| have been asked by a local parcel
courier company to design a system that ——— Paragraph justified
sounds a buzzer when one of their vans between the left and
is reversing. right margins
[ ] [ ]

The system must be able to:

1. Sense when the vehicle is reversing

2. Sound in intermittent alarm List numbered
3. Be controlled by the driver
] ] ]

To preview the fonts in the Formatting toolbar font list, choose Options from the Project menu,
select the General tab and enable the Preview fonts in font list option.

Profesor Palacios José Emanuel Pagina 206



Manual de Circuit Wizard 1.5 |

Figura 74
Inserting tables
You can add a table to a text box by choosing Table from the Project | Author menu.
=w | Projeck ‘Window Help
» Run F9 b [% ST
[I| Batse ShiffthEd [ e
| matop Ghrfees
E—— Insert Table
Mumber of columns: |2 :Il QK I
#  Add Probe FS
_— Mumber of rows: |2—j Cancel |
Ealder »
Draw » Help |
B ashor e
Options. .. Text Box Shift+Ckrl+T
0
2 symbal... 1
% speling... F7
Align or Distribute 3
From the window that appears you can specify how many rows and columns the table is to have. Enter
a suitable size and then click on the OK button to add the table.
u u u Once added, you can edit the table just as
Survey results you would normal text. Use the cursor keys
to move between cells in a table.
Name Resuft
John 52% See Selecting and editing text.
Sally 657%
Emma 60%
u Ralph 1% u
Lisa 74%
Figura 75

Inserting text symbols

To add a special symbol or character to a text box, choose Symbol from the Project | Author menu.

Symbol
Font: ISymboI j
[Broject w0 9B 35E5 () =+ - 1 0123456789 ;<=7
~ 242 B XAESTHI S EAMNOIODBOGPRET Y REYZ[ -] L
b Bun AR A ! i h voonf e A A R
Il Eause St L 2 & 2
|_l_§t_?l3 N R A O N T I A I
T Rp @8 @Enussecces s T I+ - aw sl =1
glp@em™ DL L e

# #idd Probe Insert I Close | Help |
Folder
Diraw 4 |
ﬁ Authar Mode Chrl+0

A window will appear allowing

ontians. .. =] et B ShiFE+CH4T you to select which symbol you
PAETE E ;EEI o I ' want to insert.
aple. ..
E Select the required symbol and

= - then click on the Insert button.
J’ Speling. .. ] F7

The symbol will then be inserted
Align or Distribute 3 at the flashing insertion point in
the current text box. Click Close
when finished.
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Figura 76

Labelling drcuits

Copper labels allow you to place text on a printed circuit board. Copper labels will help yvou to identify a
printed circuit board once it has been manufacturad.

It differs from a normal text box in that the label is treated as a graphic object, allowing it to be
rotated and reversed (any copper labels placed on the solder side layer are automatically reversed).

: - : To add a copper label click on the
: i Hel
©* BEEERS, cirel oh Copper Label button or choose
» Run F9 [y & Copper Label from the Project | PCB

1| Eztise:  ShifibHrE Components menu.

’_. Stop (] HFG

Simulation 3

(EifeUit Syt 3
L& st Skl Select copper label text

E omponents Aukomatic Rouking 3
# off-Board » i Quality Check. ..
Test Equipment 4
'Q_L L. Track
# AddProbe  F5 € pad
Fald 5 o~ Elying ‘Wire Caption: I : QK I
older
5 5 B Circuit Board I J |
oraw Layer: B solder Side - Canicel |
Copper Area =
Author 3 W Cop
M Help |
Optians. .,

Breadboard Madules
Pawer Supplies 3

Mext, click with the left mouse button where the label is to be
placed. A window will appear allowing you to type text for the label
and specify the layer on which it will reside.

After clicking on the OK button, a label will be added to your circuit.
Double-click on an existing label to change the text or layer.

By default, a copper label will appear on the Solder Side (bottom :

copper) layer and automatically reversed. It can also be placed on

the Component Side, Both Sides or on the Silk Screen layer. foejord 1evh
If the copper label is placed within the bounds of a copper area, an isolation gap will be added
automatically around the label. The size of the isolation gap will be fixed.

g’ You can change the style of a copper label by clicking with the right mouse button over the copper
label and choosing the Font option.
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